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1 Conformance Statement Overview

The ARTIS one is a “syngo®-based Imaging Modality. It supports Storage and Transfer of images utilizing the DICOM “Storage
Service Class”, the display of data and retrieval of images from DICOM Archives utilizing the DICOM “Query/Retrieve Service
Class”. Workflow Management is supported by querying worklists from RIS and returning information about the procedure
performed. Furthermore, the import from and export to DICOM CD/DVD media is supported. Printing of viewing results is pro-
vided with Print Management Services.

The ARTIS one conforms to the DICOM Standard and supports the network services as described in Table 1: Network Services
and the media services as described in Table 2 - Media Services.

Table 1: Network Services

User of Service Provider of Service
SOP Classes SOP Class UID (scu) (SCP)
Verification
Verification 1.2.840.10008.1.1 Yes Yes

Transfer (Image SOP Class)

CT Image Storage 1.2.840.10008.5.1.4.1.1.2 Yes Yes
MR Image Storage 1.2.840.10008.5.1.4.1.1.4 Yes Yes
X-Ray Angiographicimage | 4 5 540 10008.5.1.4.1.1.12.1 Yes Yes
Storage

secondary Capture Image |4 5 g4 10008.5.1.4.1.1.7 Yes Yes
Storage

Segmentation Storage 1.2.840.10008.5.1.4.1.1.66.4 Yes Yes

Transfer (Non-Image SOP Class)

Surface Segmentation 1.2.840.10008.5.1.4.1.1.66.5 Yes Yes
X-Ray Radiation Dose SR 1.2.840.10008.5.1.4.1.1.88.67 Yes Yes
Storage

Comprehensive SR (priv. 1.2.840.10008.5.1.4.1.1.88.33 Yes Yes

“Quant Report” Templ.)

Transfer (Private SOP Class)

—_

Syngo Non-Image Storage .3.12.2.1107.5.9.1 Yes Yes

Storage Commitment

Storage Commitment Push
Model

—_

.2.840.10008.1.20.1 Yes No

Worklist Management

Modality Worklist Infor-
mation Model - FIND

—_

.2.840.10008.5.1.4.31 Yes No

Modality Performed Proce-
dure Step

RN

.2.840.10008.3.1.2.3.3 Yes No

Query/Retrieve

Patient Root QIR Infor-

ratient oot I 1N 1.2.840.10008.5.1.4.1.2.1.1 Yes Yes
Patient Root QIR - Infor-

e R e 1.2.840.10008.5.1.4.1.2.1.2 Yes Yes
Study Root Q/R - Infor- 1.2.840.10008.5.1.4.1.2.2.1 Yes Yes

mation Model - FIND
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User of Service

Provider of Service

SOP Classes SOP Class UID (sCU) (SCP)
Study Root QIR - Infor-
mation Model - MOVE 1.2.840.10008.5.1.4.1.2.2.2 Yes Yes
Patient/Study Only QIR - In-
formation Model FIND 1.2.840.10008.5.1.4.1.2.2.3 Yes Yes
Patient/Study Only QIR - In-
formation Model MOVE 1.2.840.10008.5.1.4.1.2.3.2 Yes Yes

Print Management

Basic Grayscale PrintMan- | ; 5 ¢44 10008.5.1.1.9 Yes No
agement Meta
Presentation LUT 1.2.840.10008.5.1.1.23 Yes No

Table 2 - Media Services

Media Storage Application Profile

Write Files (FSC or FSU)

Read Files (FSR)

Compact Disk - Recordable

General Purpose on CD-R and DVD Yes (see Note1) Yes

Basic Cardiac X-Ray on CD-R Yes (See Note 2) Yes

1024 X-Ray on CD-R Yes Yes
DVD

1024 X-Ray on DVD Yes Yes

General Purpose DVD with JPEG Yes Yes

Note 1: with uncompressed setting
Note 2: with “resize” (512x512) active and only cine multi-frames included

Table 3 - Implementation Identifying Information

Name

Value

Application Context Name

1.2.840.10008.3.1.1.1

Implementation Class UID

1.3.12.2.1107.5.4

Implementation Version Name

"SIEMENS_EAS_VA10"
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3 Introduction

3.1  Revision History

Table 4 - Revision History

Product Pmd.UCt Docurpent Date
Version Version
ARTIS one VA10A 10742211-ESK-001-00 1212013
ARTIS one VAT1A 10742211-ESK-001-01 03/2022

3.2 Audience

This document is intended for hospital staff, health system integrators, software designers or implementers. It is as-
sumed that the reader has a working understanding of DICOM.

3.3 Remarks

The scope of this DICOM Conformance Statement is to facilitate integration between ARTIS one and other DICOM prod-
ucts. The Conformance Statement should be read and understood in conjunction with the DICOM Standard. DICOM by
itself does not guarantee interoperability. The Conformance Statement does, however, facilitate a first-level comparison
for interoperability between different applications supporting compatible DICOM functionality.

This Conformance Statement is not supposed to replace validation with other DICOM equipment to ensure proper ex-
change of intended information. In fact, the user should be aware of the following important issues:

e The comparison of conformance statements is the first step towards assessing interconnectivity and interoperabil-
ity between ARTIS one and other DICOM conformant equipment.

e Test procedures should be defined and executed to validate the required level of interoperability with specific com-
patible DICOM equipment, as established by the healthcare facility.

Siemens Healthineers reserves the right to modify the design and specifications contained herein without prior notice.
Please contact your local Siemens representative for the most recent product information.

3.4 Definitions, Terms and Abbreviations

Definitions, terms and abbreviations used in this document are defined within the different parts of the DICOM stand-
ard.

Additional Abbreviations and terms are as follows:

AE DICOM Application Entity

AET Application Entity Title

ASCII American Standard Code for Information Interchange
DCS DICOM Conformance Statement

DICOM Digital Imaging and Communications in Medicine
FSC File Set Creator

FSR File Set Reader

FSU File Set Updater

GSDF Grayscale Standard Display Function

10D DICOM Information Object Definition

ISO International Standard Organization

© Siemens Healthcare GmbH. 2022. All rights reserved.
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n. a. not applicable

NEMA National Electrical Manufacturers Association
(0] Optional Key Attribute

PDU DICOM Protocol Data Unit

R Required Key Attribute

SCuU DICOM Service Class User (DICOM client)

SCP DICOM Service Class Provider (DICOM Server)
SOP DICOM Service-Object Pair

SR Structured Report

TFT Thin Film Transistor (Display)

TID Template ID

U Unique Key Attribute

uib Unique Identifier

UTF-8 Unicode Transformation Format-8

VR Value Representation

3.5 References

NEMA PS3 Digital Imaging and Communications in Medicine (DICOM) Standard, available free at http://medi-
cal.nema.org/’

Integrating the Healthcare Enterprise — IHE Radiology Technical Framework - http://lwww.ihe.net

1 The DICOM Standard is under continuous maintenance, the current official version is available at http://dicom.nema.org
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4 Networking

4.1  Implementation Model

ARTIS one supports storing DICOM images to remote nodes like workstations or Archiving Systems. Using the Storage
Commitment Service, it can request safe keeping of previously stored instances from an Archiving system. Additionally,
the ARTIS one can query remote notes, retrieve and store selected instances from that node. Using the Modality Worklist
service, the ARTIS one can query a HIS/RIS for scheduled procedures. Performed procedure status and other procedure
data can be returned to the HIS/RIS using the Modality Performed Procedure Step (MPPS) Service. Furthermore, printing
of grayscale images is supported.

411 Application Data Flow

The following figures provide a functional overview of the ARTIS one Application Entities (AE). Relationships are shown
between user-invoked activities (in the circles at the left of the AEs) and the associated real-world activities provided by
DICOM service providers (in the circles at the right of the AEs)
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Figure 1: ARTIS one DICOM Data Flow diagram — Acquisition Workflow
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Figure 2: ARTIS one DICOM Data Flow diagram - Printing

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11

N-Create-RQ presentation Lyt
“N-Create-RSP

N-Create-RQ FilmBox
“N-Create-RSP

N-SET-RQ Image Box o
“N-SET-RSP

N-ACtiOﬂ-RQ Film Box g
“N-Action-RSP

N—Get—RQ Printer Status -
' N-GET-RSP

N-EVENT-REPORT-RQ
‘PrintJob Status

N-EVENT-REPORT-RSP

Print
SCP

11 of 154



4.1.2 Functional Definitions of Application Entities

4.1.2.1 Functional Definition of Verification-SCU AE

The ARTIS one DICOM Service Tool application opens an association when a "verification" of a remote application is re-
quested during a configuration session. This can be done when entering new data for remote application configuration
or to verify existing configuration data.

4.1.2.2 Functional Definition of Storage-SCU AE

The ARTIS one Storage SCU is invoked by the job control interface that is responsible for processing network archival
tasks. The job consists of data describing the composite image objects selected for storage and the destination. An asso-
ciation is negotiated with the destination application entity and the image data is transferred using the C-STORE DIMSE-
Service. Status of the transfer is reported to the job control interface.

With each successfully completed send job, the ARTIS one DICOM Application will populate the Storage Commitment
Push Model Action Information from the SOP Instances sent. Then a Storage Commit Request is triggered, if configured.
Depending on configuration, the ARTIS one DICOM application will keep the association open for responses with a con-
figurable time-out, or closes the association and expects responses on a different association that has to be establishes
by the remote Storage Commitment SCP.

The commitment status derived from the related trigger response will be indicated in the related Status Flags of the re-
lated entity. It is possible to create triggers (“auto rules”) from this event.

The Transaction UIDs of the pending commitment request are kept “open” (Job-status is “waiting”) for a configurable
time (default: Th). If the “open time” for a pending commitment request has elapsed w/o a related response from the
provider, the Transaction UID is removed and the related entities are indicated as “commit failed"”.

Open Transaction UIDs of pending commitment requests are discarded after a reboot of the system. The related entities
are indicated as “commit failed”.

4.1.2.3 Functional Definition of Storage-SCP AE

The Storage SCP component of the ARTIS one DICOM application is operating as background server process. The process
starts when the machine is powered on and waits for Storage association requests. Upon accepting an association with
a negotiated Presentation Context it starts to receive the Composite Image Objects and imports them to local database.

The Verification SCP is included in the Storage SCP.

The Storage Commitment SCP is running in background and is ready to receive requests when the system is started.
Storage Commitment will be checked and returned against the SOP Classes received and kept in the local Storage of the
ARTIS one. The response will either be sent “on same” (association not closed by requester) or “on separate” association
(requester closed association consecutive to positive request status).

4.1.2.4 Functional Definition of Query/Retrieve-SCU AE

The ARTIS one DICOM queryl/retrieve SCU requests the remote query/retrieve SCP to perform a search and match to
the keys specified in the request in order to display the results in the system’s user interface. Depending on user ac-
tion (Import) the ARTIS one query/retrieve DICOM SCU sends a C-MOVE DIMSE service to initiate a C-STORE sub-opera-
tion on the SCP to start an image transfer from remote Storage SCU (running on Query/Retrieve SCP) to the system’s
Storage SCP.

4.1.2.5 Functional Definition of Query/Retrieve-SCP AE

The ARTIS one DICOM query/retrieve SCP responds to C-FIND DIMSE services from remote SCU applications. Depending
on further remote request, a C-GET or a C-MOVE involves the system’s DICOM query/retrieve SCP application to initiate a
C-STORE association to send image objects to a remote Storage SCP.
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All components of the DICOM query/retrieve SCP application are operating as background server processes. The pro-
cesses start when the machine is powered on and then respond to queries based on the records stored in its database.

4.1.2.6 Functional Definition of Print SCU AE

The Print SCU is invoked by the user interface to setup film-sheet layout and whenever an image is ready to be printed
on film. The Print SCU will hold and maintain all data needed to compile a complete film-sheet from the data (images,
layout, configuration) received. Whenever a film-sheet is ready to print the related data is used to supply the Infor-
mation to the SOP Classes of the Print Management Service Class. A queue is maintained, in order to intermediately
store several film-sheets in case of resource problems on printer. The SCU will only supply and require the mandatory
SOP Classes of the Print Management Service Class.

4.1.2.7 Functional Definition of Worklist SCU AE

The worklist SCU (“broad query”) is invoked from the patient browser user interface or by timer to request the worklist
from a remote Information System (Modality Worklist Class SCP). The worklist SCP responses to the C-FIND query and

scheduled imaging service requests (scheduled procedure steps) and patient demographic information will be “pulled”
from the information system to the ARTIS one modality. All information retrieved will be held in the scheduling database
for usage during Patient registration procedure.

Furthermore, the patient-based Query dialog from the patient browser allows to enter specific matching criteria ("nar-
row query") for the worklist query. With the response data the Patient Registration dialog can be populated according
availability within the worklist response identifier.

4.1.2.8 Functional Definition of Modality PPS SCU AE

With registering a Patient (i.e. a Scheduled Procedure Step from Worklist), the ARTIS one DICOM application will create a
MPPS Instance and communicate it to the MPPS Manager (SCP). It is configurable to set the states of all related MPPS to
"Completed" when a patient is closed. Furthermore, a manual update can be performed with the MPPS user interface.
From the user interface it is possible to set the state of the MPPS to “Completed” or “Discontinued”. After that the DICOM
application will no longer allow updates on the related MPPS Instance.

The ARTIS one will not only allow a "1:1 -relationship" of Scheduled Procedure Steps and Performed Procedure Steps, but
also supports the "simple group-case" (grouping several SPS of the same Requested Procedure) , "complex group-case”
(grouping several SPS from different Requested Procedures) and "append case” from the respective IHE-scenarios.

The ARTIS one will support creation of “unscheduled cases” by allowing MPPS Instances to be communicated for locally
registered Patients.

4.1.3 Sequencing of Activities

4.1.3.1 Verification
Newly entered data must be saved before a “verification” of these data is possible.

4.1.3.2 Storage

Prior to sending of SOP Instances the ARTIS one Storage application is capable of invoking processing and resizing fea-
tures in order to prepare image pixel contents into convenient formats for certain multi-vendor environments.

The Storage Commitment trigger is automatically derived from the successful completion of a Send Job.
4.1.3.3 Query/Retrieve

Retrieve of images is only possible if a result from a previous “Search...” operation exists and those entities can be se-
lected for “Import”.
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The Query application will not “per se” request information on IMAGE level. The user can select a series and request im-
age level information with the “Image List” function.

4.1.3.4 Workflow

The “narrow” (interactive) Worklist Query requires that sufficient matching keys or an unique matching key arelis en-
tered before the query is issued. Only then a single response can be expected to complete the registration dialog.

An MPPS N-CREATE message is sent when a patient is registered. For procedure steps registered as "emergency" cases
the MPPS N-CREATE is withheld until it is set to completed.

MPPS N-SET messages to update the information are sent after each X-Ray event.

4.2  Application Entity Specification

4.2.1 Verification SCU AE Specification

4.2.1.1 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services” section "Verification" in the “Conformance State-
ment Overview".

4.2.1.2 Association Policies

4.2.1.2.1 General

The ARTIS one DICOM Service Tool application attempts to open an association for verification request whenever the
"verification" function is activated during network configuration of a remote DICOM application.

4.2.1.2.2 Number of Associations

The ARTIS one DICOM Service Tool application initiates one association at a time to request verification.

4.2.1.2.3 Asynchronous Nature

The ARTIS one DICOM software does not support asynchronous communication (multiple outstanding transactions over
a single association).

4.2.1.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information” in the
“Conformance Statement Overview".

4.2.1.3 Association Initiation Policy

4.2.1.3.1 Activity - “Verification”
4.2.1.3.1.1 Description and Sequencing of Activity

The Verification SCU C-ECHO request is initiated by Service and Configuration SW whenever "Verification" is requested. If
an association to a remote Application Entity is successfully established, Verification with the configured AET is re-
quested via the open association. If the C-ECHO Response from the remote Application contains a status other than
"Success" this will be indicated in the service environment and the association is closed.
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4.2.1.3.1.2 Proposed Presentation Contexts
The ARTIS one DICOM application will propose Presentation Contexts as shown in the following table:

Table 5 - Presentation Context Table "Verification"

Presentation Context Table — “Verification”

Abstract Syntax Transfer Syntax N~ Extended

Name uiD Name List UID List Negotiation

Explicit VR Little Endian | 1.2.840.10008.1.2.1
Verification 1.2.840.10008.1.1 Implicit VR Little Endian | 1.2.840.10008.1.2 SCU None
Explicit VR Big Endian 1.2.840.10008.1.2.2

4.2.1.3.1.3 SOP Specific Conformance - Verification SCU
The Application conforms to the definition of the Verification SCU in accordance to the DICOM Standard.

4.2.1.4 Association Acceptance Policy

The Verification SCP is part of the Storage SCP.

4.2.2 Storage SCU AE Specification

4.2.2.1 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services”, sections “Transfer” and “Workflow Management”.

4.2.2.2 Association Policies

4.2.2.2.1 General

The DICOM Storage application will be triggered by the transfer job queue or by an external retrieve request. An associa-
tion request is sent to the destination AE and, upon successful negotiation of a Presentation Context, the transfer is
started. Depending on configuration, processing or resizing can be applied to the images prior to being sent.

With a Send Job successfully completed, the DICOM application will generate the Storage Commitment Action Infor-
mation which references to all Instances of the processed job. The Commit Request is sent over a single opened associa-
tion. The ARTIS one will wait for Status responses of the Storage Commitment Request. If the Provider accepts the Stor-
age Commitment with Success Status, the generated Transaction UID, together with study identification data and a
timestamp, is kept. Depending on configuration, the association is closed or kept open for a configured time range. If
the association is closed immediately, the response is expected on a different association which is the default setting.
Multiple Storage Commitment Requests can be pending.

The default PDU size used will be 512 KB.

4.2.2.2.2 Number of Associations

The ARTIS one DICOM application initiates several associations at a time, one for each destination to which a transfer
request is being processed in the active job queue list.

The number of simultaneous DICOM associations can be configured via the Service-Ul. The dialog can be found in "Con-
figuration / DICOM | General".

4.2.2.2.3 Asynchronous Nature

The ARTIS one DICOM software does not support asynchronous communication (multiple outstanding transactions over
a single association).
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4.2.2.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information” in the
“Conformance Statement Overview”.

4.2.2.3 Association Initiation Policy

If a job with network destination gets active in the job list or a retrieve sub-operation is processed, the ARTIS one DICOM
application attempts to initiate a new association for

= DIMSE C-STORE to send images and with successful status and

= N-ACTION DIMSE for the Storage Commitment Push Model Service Class to request commitment.

4.2.2.3.1 Activity —“Send to ..."
4.2.2.3.1.1 Description and Sequencing of Activity

The C-STORE request is triggered by a job with network destination or the processing of an external C-MOVE retrieve
request. If the process successfully establishes an association to a remote Application Entity, it will transfer each image
one after another via the open association. Processing features and resizing of the pixel matrix can be applied as part of
the transfer. If the C-STORE Response from the remote Application contains a status other than “Success” or “Warning”,
the association is aborted.

With success status for the previous transfer, the ARTIS one Storage application sends the commit request (N-ACTION-
RQ) message and waits for acceptance of this request (N-ACTION-RSP). After receiving this, the transaction is marked as
“waiting”.

Depending on a configuration value, the association will then be closed or kept open. In the first case, there is another
configurable timeout giving the number of hours (h) and minutes (m) (by default 1Th:0m) to wait for the corresponding
commit response (N-EVENT-REPORT). In the second case, this time is the (also configurable) time-out for the association
being kept open. In both cases, if the commit response (N-EVENT-REPORT) does not arrive within the configured time-
out, the transaction will be marked as failed.

If the commit response (N-EVENT-REPORT) received has the status of “complete - failure exists”, the transaction is
marked as failed, else the transaction is marked as “completed”. In both cases, a status message is shown to the user.

4.2.2.3.1.2 Proposed Presentation Contexts

The ARTIS one DICOM application will propose Storage SCU Presentation Contexts as shown in the following table:

Table 6 - Presentation Context Table "Send to ..."

Presentation Context Table - “Send to ...”

Abstract Syntax Transfer Syntax
Ext.
Role Ne
Description Name List UID List 9
JPEG Lossy Extended 1.2.840.10008.1.2.4.51
JPEG Lossless, Process 14 1.2.840.10008.1.2.4.70
(selection value 1)
Any image SOP Class detailed in "Table 1: Net- | pgG | g5y Baseline (Pro- | 1.2.840.10008.1.2.4.50
work Services” section ,Transfer (Image SOP cess 1) SCU | None
Class)”. . . .
Explicit VR Little Endian 1.2.840.10008.1.2.1
Explicit VR Big Endian 1.2.840.10008.1.2.2
Implicit VR Little Endian 1.2.840.10008.1.2
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Presentation Context Table - “Send to ...”

Abstract Syntax Transfer Syntax
Role Ext.
Description Name List UID List S
Any non-image SOP Class detailed in “Table 1: Explicit VR Little Endian 1.2.840.10008.1.2.1
Network Services” section ,Transfer (Non-image | Explicit VR Big Endian 1.2.840.10008.1.2.2 SCU None
SOP Class)". Implicit VR Little Endian 1.2.840.10008.1.2

—_

.2.840.10008.1.2.1
.2.840.10008.1.2.2 SCuU None

Private SOP Class as detailed in Chapter “Table 1: | Explicit VR Little Endian
Network Services” section ,Transfer (Private SOP | Explicit VR Big Endian

_

Class)". Implicit VR Little Endian 1.2.840.10008.1.2

Storage Commitment SOP Class as detailed in Explicit VR Little Endian 1.2.840.10008.1.2.1

“Table 1: Network Services” section “Workflow Explicit VR Big Endian 1.2.840.10008.1.2.2 SCuU None
Management”. Implicit VR Little Endian 1.2.840.10008.1.2

4.2.2.3.1.3 SOP specific Conformance - “Send to ...”

The ARTIS one can send images in different formats. In a destination specific service level configuration, it can be config-
ured if images are sent original, resized (512x512 8 bit, 1024x1024 12 bit) and/or processed.

For association and DIMSE level time-outs, please refer to section Configuration (4.4.2 Parameters) of this document.
4223131 Optional Attributes
Please refer to the related Image Object definition tables in the Annex (section “Created SOP Instances”) for a list of all
DICOM IOD attributes of type 2 and 3, which are encoded by the ARTIS one applications.
4223132 Specialized Information Object Definitions
The DICOM images sent by ARTIS one DICOM application conform to the DICOM 10D definitions (Standard extended
IODs). But they will contain additional private elements, which have to be discarded by a DICOM system when modify-

ing the image.

The DICOM nodes are responsible for data consistency when modifying images. All unknown private attributes have to
be removed upon modification!

4223133 Data Dictionary of applied private 10D Attributes

Please refer to "Standard Extended/Specialized/Private SOP Classes" in the Annex for a list of possible private 10D attrib-
utes.

4.2.2.3.1.4 SOP specific Conformance - Request Commitment

Storage Commitment is supported for all the SOP Classes detailed in Chapter “Table 1: Network Services” section “Work-
flow Management”.

The Referenced Study Component Sequence is not supported.

Storage Media File-Set ID and UID Attributes will not be supported in the commitment request (N-ACTION primitive)
invoked by the Storage Commitment SCU.
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4.2.2.4 Association Acceptance Policy

4.2.2.4.1 Activity — Update Flag Information
4.2.2.4.1.1 Description and Sequencing of Activity

After sending a Storage Commitment Request the ARTIS one either waits on the same association or, being configured
to receive response on a separate association, closes the association and waits for an association request from the Stor-
age Commitment SCP that wants to send the results.

Any incoming Notification will be checked for validity, that is, if the related Transaction UID is still part of the Pending
Request Queue.

If the Notification is valid the related Instances are marked with the reported status. The over-all Commit Status of the
higher Information Entities in the ARTIS one database is derived from propagation of the States of all sub-ordinate Im-
age entities included in a study.

The Status Flags directly affected by Storage Commitment results and indicated in the different entities of the Patient
Browser list can be one of

= “AC” or “SC” - Successful Commitment, "A" means archived to configured Archive destination, whereas "S" means sent to
any other destination.
= “Af” of “Sf” - Commitment failed.

= “A?” or “S?” - Commitment request is sent, response is pending.

In case of failure the user has to repeat the transfer of images to the Archive destination. Another Storage Commitment
will be performed after sending is completed successfully.

4.2.2.4.1.2 Accepted Presentation Context

The ARTIS one DICOM application will accept Storage Commitment Presentation Contexts as shown in the following
table:

Table 7 - Presentation Context Table "Update Flag Information”

Presentation Context Table — “Update Flag Information”
Abstract Syntax Transfer Syntax
Ext.
Description Name List UID List Role | Neg.

Explicit VR Little Endian 1.2.840.10008.1.2.1

1.2.840.10008.1.20.1
. Explicit VR Big Endian 1.2.840.10008.1.2.2 SCP None

Storage Commitment Push Model - . .

Implicit VR Little Endian 1.2.840.10008.1.2

4.2.2.4.1.3 SOP specific Conformance

If the Commitment response (N-EVENT-REPORT) received has the status of “complete - failure exists”, the transaction is
marked as failed, else the transaction is marked as “completed”. In both cases, a message is shown to the user.

The related status flags are set for the committed images in the local database.

The ARTIS one DICOM application will not support the Storage Media File Set ID attributes.
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4.2.3 Storage SCP AE Specification

4.2.3.1 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services” Sections “Transfer” on page 1.

4.2.3.2 Association Policies

4.2.3.2.1 General

The ARTIS one DICOM application will accept any number of verification or storage SOP classes that are referred to
above. There is no limit on the number of presentation contexts accepted except for the DICOM limit. In case that the
Siemens DICOM application runs out of resources, it will reject the association request.

When "trusted host functionality" is enabled ARTIS one will only accept Associations from known hosts with a known
AET. IP address of the host and the AET must be entered in "Local Service" by a Siemens CSE.

The default PDU size used will be 512 KB.

4.2.3.2.2 Number of Associations

The Siemens ARTIS one DICOM application is able to accept multiple associations at a time. It can handle up to 10 associ-
ations in parallel.

The number of simultaneous DICOM associations can be configured via the Service-Ul. The dialog can be found in "Con-
figuration / DICOM | General".

4.2.3.2.3 Asynchronous Nature

The ARTIS one DICOM software does not support asynchronous communication (multiple outstanding transactions over
a single association).

4.2.3.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information” in the
“Conformance Statement Overview”.

4.2.3.3 Association Initiation Policy

If the result from a previously accepted Storage Commitment request is evaluated, the ARTIS one DICOM application
attempts to initiate a new association for

e  DIMSE N-EVENT-REPORT for sending commitment result from a previous request.

4.2.3.3.1 Activity - Return commitment result

When ARTIS one Storage SCP AE received a Storage Commitment request it tries to send the response back on the same
association. When the association is not open anymore it will initiate an association to send the storage commitment
response (N-EVENT-REPORT) to the SCU.

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11 19 of 154



4.2.3.3.1.1 Proposed Presentation Context

The ARTIS one DICOM application will propose Storage SCP Presentation Contexts for returning Storage Commitment
results as shown in the following table:

Table 8 - Presentation Context Table "Return Commitment Result"

Presentation Context Table — “Return Commitment Result”
Abstract Syntax Transfer Syntax
Ext.
Role N
Description Name List UID List €9.
Storage Commitment SOP Class as detailed in “Ta- | Explicit VR Little Endian 1.2.840.10008.1.2.1
ble 1: Network Services” section “Workflow Man- | Explicit VR Big Endian 1.2.840.10008.1.2.2 SCP None
agement”. Implicit VR Little Endian 1.2.840.10008.1.2

4.2.3.3.1.2 SOP Specific Conformance

Storage Media File-Set ID and UID Attributes will not be supported in the N-EVENT-REPORT primitive invoked by the Stor-
age SCP.

4.2.3.4 Association Acceptance Policy

The ARTIS one DICOM application attempts to accept a new association for

=  DIMSE C-ECHO for incoming Verification requests
. DIMSE C-STORE for external image senders request storage of instances
. DIMSE N-ACTION for external systems requesting storage commitment

= DIMSE N-EVENT-REPORT for receiving commitment result from a previous request

4.2.3.4.1 Activity - Save to local disk

4.2.3.4.1.1 Description and Sequencing of Activity

The ARTIS one DICOM application will accept an association and will receive SOP Instances according to the listed
presentation contexts on that association and will store the images to the local hard disk if the conformance check is
performed successfully.

Upon successful receiving a C-STORE-RQ, the ARTIS one DICOM receiver performs a plausibility test on the received im-
age and available system resources. If this test succeeds, it returns the Status SUCCESS, otherwise one of the following
status codes is returned and the association is aborted:

Table 9 - Status codes "Save to local disk"

Code Meaning

Refused: This error status indicates a lack of Resources (e.g. not enough disk

A700 space) on the ARTIS one modality.

Invalid Dataset: An error occurred while processing the image, which makes
A900 it impossible to proceed. The image will not be stored, and the association is
aborted.

Processing Error: An error occurred while processing the image, which makes

0110 it impossible to proceed. Association is aborted.
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Note: The image will be saved after sending the response. If during this operation an error occurs, the association will
be aborted. This implies that a C-STORE-RSP with status SUCCESS does not mean that the image was successfully stored
into the database.

4.2.3.4.1.2 Accepted Presentation Context

The ARTIS one DICOM application will accept Presentation Contexts as shown in the following table:

Table 10 - Presentation Context Table "Save to local disk"

Presentation Context Table — “Save to local disk”

Abstract Syntax Transfer Syntax
Ext.
Role Ne
Description Name List UID List g
JPEG Lossy Extended 1.2.840.10008.1.2.4.51
JPEG Lossless, Process 14 1.2.840.10008.1.2.4.70
(selection value 1)
Any image SOP Class detailed in "Table 1: Net- | pe | g5y Baseline (Pro- | 1.2.840.10008.1.2.4.50
work Services” section ,Transfer (Image SOP cess 1) SCP None
Class)”. - . .
Explicit VR Little Endian 1.2.840.10008.1.2.1
Explicit VR Big Endian 1.2.840.10008.1.2.2
Implicit VR Little Endian 1.2.840.10008.1.2
Any non-image SOP Class detailed in “Table 1: Explicit VR Little Endian 1.2.840.10008.1.2.1
Network Services” section ,Transfer (Non-image | Explicit VR Big Endian 1.2.840.10008.1.2.2 SCP None
SOP Class)”. Implicit VR Little Endian 1.2.840.10008.1.2

—_

.2.840.10008.1.2.1
.2.840.10008.1.2.2 SCP None
.2.840.10008.1.2

Private SOP Class as detailed in Chapter “Table 1: | Explicit VR Little Endian
Network Services” section ,Transfer (Private SOP | Explicit VR Big Endian

Class)". Implicit VR Little Endian

-

4.2.3.4.1.3 SOP specific Conformance

The ARTIS one application conforms to the Full Storage Service Class at Level 2.

Any Explicit VR Transfer Syntax is preferred to be used by the Storage SCU when sending Composite Image Instances to
the ARTIS one DICOM application.

If an image instance is received that is identified by a SOP Instance UID which is already used by an Instance stored in
database then the actual received image will be discarded. The existing Instance is not superseded.

The order of preference in accepting Transfer Syntaxes within Presentation Contexts or Presentation Contexts with sin-
gle Transfer Syntaxes is:

Table 11 - Order of Preference Transfer Syntax

Order [ DICOM Transfer Syntax
1 JPEG Lossy Extended

JPEG Lossless Non-hierarchical

JPEG Lossy Baseline
Explicit VR Little Endian
Explicit VR Big Endian

||l jlwWIN

Implicit VR Little Endian
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ARTIS one DICOM application will decompress the image before storing it into the database.

The following sections will differentiate the attribute contents required for Image Viewing. The ARTIS one DICOM appli-
cation supports more formats for Storage of Images than for Viewing.

The ARTIS one viewer supports only XA-Images for display. Only a number of pixel columns with a multiple of 4 is sup-
ported for display in the viewer.

Image Pixel Attribute Acceptance Criterion for Grayscale Images

The ARTIS one Viewing application accepts MONOCHROME?2 photometric interpretation pixel format and graphic over-
lay with unsigned integer and 8 or 16 bits allocated. Accepted values:

Pixel plane

=  Samples per Pixel (attribute 0028,0002) = 1

= Photometric Interpretation (attribute 0028,0004) = "MONOCHROME2"
=  Only Aspect Ratio 1:1 is supported

=  Pixel Representation (attribute 0028,0103) =0

- Bits Allocated (attribute 0028,0100) = 8, 16

- Bits Stored (attribute 0028,0101) = 8, 10, 12

= High Bit (attribute 0028,0102) =7, 9, 11

. Rows/Columns =512, 1024 and all formats internally generated.

Overlay plane “embedded”

= Overlay Type (attribute 60xx,0040) = "G"
=  Bits Allocated (attribute 60xx,0100) = 16
- Bit Position (attribute 60xx,0102) =12, 13, 14, 15

Graphic Overlay will be shifted to fill Overlay Planes from Bit 12 and consecutive.
Overlay plane “explicit”

= Qverlay Type (attribute 60xx,0040) = "G"
=  Bits Allocated (attribute 60xx,0100) = 1
=  Bit Position (attribute 60xx,0102) =0

= Overlay Data (attribute 60xx,3000) = supported

For Modality LUT, both the linear LUT (Rescale Slope/lntercept) and the Modality LUT Sequence are supported and con-
sidered when pixel data is displayed. However, there are two limitations. The Modality LUT Sequence will be ignored in
the following cases:

=  8-Bit signed pixels
= the pixel format is changed by the Modality LUT (e.g. 8bit -> 16bit)

If the Modality LUT Sequence contains multiple LUTs, then only the first one is used.

For VOI LUT, both the linear LUT (Window Center/Width) and the VOI LUT Sequence are supported (VOI LUT Sequence
with 8 or 16 bit LUT data)

But if both, a VOI LUT Sequence and a linear Modality LUT, are specified within one image, then the value for Rescale
Slope is restricted to 1.

If the VOI LUT Sequence contains multiple LUTs, then only the first one is used by default. The other VOI LUTs are se-
lectable.
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4.2.3.4.2 Activity — Evaluate Commit Request

4.2.3.4.2.1 Description and Sequencing of Activity

When receiving a Storage Commitment request the ARTIS one DICOM application will perform the necessary steps to
check the received list Instances against the local database.

4.2.3.4.2.2 Accepted Presentation Context

The ARTIS one DICOM application will accept Storage Commitment Presentation Contexts as shown in the following
table:

Table 12 - Presentation Context Table "Evaluate Commit Request"

Presentation Context Table — “Evaluate Commit Request”
Abstract Syntax Transfer Syntax Ext
Role X
Description Name List UID List N
Storage Commitment SOP Class detailed in “Table [EXPlicit VR Little Endian 1.2.840.10008.1.2.1
1: Network Services” section “Workflow Manage- | Explicit VR Big Endian 1.2.840.10008.1.2.2 SCP None
ment”. Implicit VR Little Endian 1.2.840.10008.1.2
4.2.3.4.2.3 SOP specific Conformance

The ARTIS one Storage SCP AE will return success for images that are stored in the local database and failure for images
that are not. However, the committed images can later be deleted by the user at the ARTIS one without notice!

Note: Storage Media File-Set ID and UID Attributes will not be supported in the N-EVENT-REPORT primitive invoked by
the Storage Commitment SCP.

4.2.4 Query/Retrieve SCU Specification

4.2.41 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services” section ,Query/Retrieve” in the “Conformance
Statement Overview".

4.2.4.2 Association Policies

4.2.4.2.1 General

With the "Search..." function the query data can be entered, and the DICOM query/retrieve application is initiated. An
initial query request will be sent out to one remote node that can be selected from a list of configured Query Providers.
Depending on the replies to the initial request, sub-sequent query requests are issued to gather further data for lower

information level entities. The results compiled from the response data will be displayed to the user. Upon request (Im-
port), the retrieval of selected items is initiated.

The default PDU size used will be 512 KB.

4.2.4.2.2 Number of Associations
The ARTIS one DICOM application initiates several associations at a time.
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For Query it initiates a new association to the remote node and issues the C-FIND request to retrieve all the requested
patient and study information matching the search criteria. The ARTIS one initiates in parallel a second association to
the destination node to query for all the series information for each study’s information returned on the first association.
For the Retrieve request (C-MOVE) only one association is initiated per destination.

4.2.4.2.3 Asynchronous Nature

The ARTIS one DICOM software does not support asynchronous communication (multiple outstanding transactions over
a single association).

4.2.4.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information” in the
“Conformance Statement Overview”.

4.2.4.3 Association Initiation Policy

The ARTIS one DICOM application will request associations for the following DIMSE-C operations as SCU:

Table 13 - Supported DIMSE-C Operations - Query/Retrieve SCU

Supported DIMSE operations Cancel Request supported
C-FIND yes
C-MOVE n. a.

Extended negotiation (relational query) is not supported for the above listed services.

4.2.4.3.1 Activity - Search for images (Search...)
4.2.4.3.1.1 Description and Sequencing of Activity

The associated activity is to fill out a query form with search data and pass it as query to the network application which
issues a C-FIND over a previously built association. The remote SCP will respond with related data-entries that will be
passed to a browser application. If needed, further associations are opened for querying data from sub-sequent entities.
When data transfer is finished, each association is closed.

If the C-FIND Response from the remote Application contains an error status, the association is aborted.

4.2.4.3.1.2 Proposed Presentation Contexts

The ARTIS one DICOM application will propose Presentation Contexts as shown in the following table:

Table 14 - Presentation Context Table "Search..."

Presentation Context Table - “Search...”

Abstract Syntax Transfer Syntax

Ext.

Name uiD Name List UID List Role |Neg.

Implicit VR Little Endian 1.2.840.10008.1.2
1.2.840.10008.5.1.4.1.2.1.1 Explicit VR Big Endian 1.2.840.10008.1.2.2 | SCU | None

Explicit VR Little Endian 1.2.840.10008.1.2.1

Query/Retrieve Model
Patient Root - FIND

Implicit VR Little Endian 1.2.840.10008.1.2
1.2.840.10008.5.1.4.1.2.2.1 Explicit VR Big Endian 1.2.840.10008.1.2.2 | SCU | None

Explicit VR Little Endian 1.2.840.10008.1.2.1

Query/Retrieve Model
Study Root - FIND
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Presentation Context Table - “Search...”

1.2.840.10008.1.2.1

Abstract Syntax Transfer Syntax
Ext.
Name uiD Name List UID List
Role | Neg.
Query/Retrieve Model Implicit VR Little Endian 1.2.840.10008.1.2
Patient/Study Only - 1.2.840.10008.5.1.4.1.2.3.1 Explicit VR Big Endian 1.2.840.10008.1.2.2 [ SCU | None
FIND Explicit VR Little Endian

Within the DICOM network configuration it is configurable which of the two query models (or both) are to be used by
the ARTIS one DICOM Query SCU application for each node. If both Abstract Syntaxes are configured, the Find SCU will

use the Patient Root Model only for

C-FIND requests on PATIENT level. For all other levels it will use the Study Root model.

4.2.4.3.1.3 SOP Specific Conformance

The ARTIS one DICOM Query/Retrieve SCU supports hierarchical queries with all mandatory search keys. The interactive
querying of attributes on IMAGE level is not supported by the Query SCU, hence retrieval of individual Objects is possi-
ble. The following table describes the search keys for the different query models that the SCU supports. Matching is ei-
ther wildcard, which means that the user can supply a string containing wildcards, or universal, which means that the
attribute is requested as return value.

Table 15 - C-FIND RQ Search Keys

Attribute Name Tag Type Matching User Input RetDui;r:)l\:;\/Iue

Patient Level?
Patient's Name (0010,0010) R Wildcard3 Enter value yes
Patient ID (0010,0020) U/R Wildcard3 Enter value yes
Patient’s Birth Date (0010,0030) 0 Single Value Enter value yes
Patient’s Sex (0010,0040) 0 Single Value Enter value yes
Number of Patient related Studies (0020,1200) 0 Universal (Null) -- yes#
Number of Patient related Series (0020,1202) 0 Universal (Null) - no
humber of Patient related In- (0020,1204) | O | Universal (Null - no
Study Level
Patient's Name> (0010,0010) R Wildcard3 Enter value yes
Patient ID (0010,0020) U/R Wildcard3 Enter value yes
Patient’s Birth Date> (0010,0030) 0 Single Value Enter value yes
Patient’s Sex> (0010,0040) 0 Single Value Enter value yes
Study Instance UID (0020,000D) u Single Value Enter value yes
Study ID (0020,0010) R Wildcard3 Enter value yes

2 patient Root Information Model only

3 Always a “*” is appended to the user-supplied string

4 Implicitly visualized in the Ul if no study and series search attributes have been entered

5 Study Root Information Model only
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Attribute Name Tag Type Matching User Input Ret;i;r:ﬂ\glue

Study Date (0008,0020) R Range Enter value® yes
Study Time (0008,0030) R Range Enter value yes
Accession Number (0008,0050) R Wildcard Enter value yes
Study Description (0008,1030) 0 Wildcard3 Enter value yes
Referring Physician’s Name (0008,0090) 0 Wildcard3 Enter value yes
Name of Physician Reading Study (0008,1060) 0 Wildcard3 Enter value yes
Modalities in Study (0008,0061) 0 Single Value Enter value yes
Number of Patient related Studies (0020,1200) 0 Universal (Null) -- no
Number of Patient related Series (0020,1202) 0 Universal (Null) - no
’S\'t‘;;‘ﬁesr of Patient related In- (0020,1204) | O | Universal (Null . no
Number of Study related Series (0020,1206) 0 Universal (Null) - yes’
Number of Study related Instances | (0020,1208) 0 Universal (Null) -- no
Series Level
Series Instance UID (0020,000E) u Single Value Enter value yes
Series Number (0020,0011) R Single Value Enter value yes
Modality (0008,0060) R Single Value Enter value yes
Series Date (0008,0021) 0 Universal (Null) - yes
Series Time (0008,0031) 0 Universal (Null) -- yes
Series Description (0008,103E) 0 Wildcard3 Enter value yes
Body Part Examined (0018,0015) 0 Single Value Enter value yes
Performing Physician’s Name (0008,1050) 0 Wildcard3 Enter value yes
Request Attributes Sequence (0040,0275) 0 -- - yes
>Requested Procedure ID (0040,1001) 0 Wildcard3 Enter value yes
>Scheduled Procedure Step ID (0040,0009) 0 Wildcard3 Enter value yes
E(Zt[:)rmed Procedure Step Start (0040,0244) 0 Range Enter value yes
;e;]fgrmed Procedure Step Start (0040,0245) 0 Range Enter value yes
Number of Series related Instances | (0020,1209) 0 Universal (Null) - yes
Instance Availability (0008,0056) 0 Universal (Null)

6 Date range also possible

7 Implicitly if no series search attributes have been entered
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Attribute Name Tag Type Matching User Input Ret;i;r:ﬂ\glue

Image Level

SOP Instance UID (0008,0018) u Single Value -- no
Instance Number (0020,0013) R Universal (Null) - yes
SOP Class UID (0008,0016) 0 Universal (Null) -- no
Image Comments (0020,4000) 0 Universal (Null) - yes
Number of Frames (0028,0008) 0 Universal (Null) -- yes
Content Date (0008,0023) 0 Universal (Null) - yes
Content Time (0008,0033) 0 Universal (Null) -- yes

U = Unique Key, R = Required Key, O = Optional Key, - = not supported or applicable
The ARTIS one Search application supports a

=  DIMSE C-FIND-CANCEL

if the user wishes to cancel a running Query request via the ARTIS one user interface (“Cancel” button while a
“Search...” is active).

The Find SCU interprets following status codes:

Table 16 - Status Codes "Search..."

Service Status Meaning Error Codes | Related Fields
Refused Out of Resources A700 (0000,0902)
. (0000,0901)
Identifier does not match SOP Class A900
(0000,0902)
Failed
(0000,0901)
Unable to process Cxxx
(0000,0902)
Cancel Matching terminated due to Cancel request FEOO None
Success Matching is complete - No final Identifier is supplied 0000 None
Matches are continuing - Current Match is supplied and any
Optional Keys were supported in the same manner as Re- FFOO Identifier
quired Keys
Pending
Matches are continuing - Warning that one or more Optional
Keys were not supported for existence and/or matching for FFO1 Identifier
this identifier

4.2.4.3.2 Activity - Retrieve Images (Import...)

4.2.4.3.2.1 Description and Sequencing of Activity
When selecting a data entry in the Query Ul and activating the "Import" function, a retrieval request is passed to the AR-
TIS one DICOM application which issues a C-MOVE service according to the Patient Root or Study Root query model. (The

Storage Service Class Conformance Statement describes the C-STORE service, which is generated by processing the C-
MOVE service.)

The received image data are processed as described in the storage class SCP descriptions.
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The ARTIS one DICOM application will always insert the own Storage SCP AE as “Move Destination”.

4.2.4.3.2.2 Proposed Presentation Contexts
The ARTIS one Server DICOM application will propose Presentation Contexts as shown in the following table:

Table 17 - Presentation Context Table "Import..."

Presentation Context Table - “Import...”

Abstract Syntax Transfer Syntax
Ext.
Name uiD Name List UID List Role |Neg.

Query/Retrieve Model Implicit VR Little Endian Ex- 1.2.840.10008.1.2

ery 1.2.840.10008.5.1.4.1.2.1.2 | plicit VR Big Endian Explicit | 1.2.840.10008.1.2.2 | SCU | None

Patient Root — MOVE VR Little Endian

1.2.840.10008.1.2.1
Query/Retrieve Model Implicit VR Little Endian Ex- 1.2.840.10008.1.2

Y 1.2.840.10008.5.1.4.1.2.2.2 | plicit VR Big Endian Explicit | 1.2.840.10008.1.2.2 | SCU | None
Study Root — MOVE VR Little Endian 1.2.840.10008.1.2.1
Query/Retrieve Model Implicit VR Little Endian Ex- | 1-2-840-10008.1.2

Patient/Study Only — 1.2.840.10008.5.1.4.1.2.3.2 | plicit VR Big Endian Explicit | 1.2.840.10008.1.2.2 SCU | None
MOVE VR Little Endian 1.2.840.10008.1.2.1

Note: C-MOVE Extended Negotiation will be not supported by the SCU.

4.2.4.3.2.3 SOP Specific Conformance

All required keys will be provided in the retrieve request identifier, as defined in DICOM Standard.

The Move SCU interprets following status codes:

Table 18 - C-MOVE RSP Status Codes

Service Status Meaning Error Codes | Related Fields
Out of Resources - Unable to calculate number of matches A701 (0000,0902)
(0000,1020)
. (0000,1021)
Refused Out of Resources - Unable to perform sub operations A702
(0000,1022)
(0000,1023)
Move destination unknown A801 (0000,0902)
- (0000,0901)
Identifier does not match SOP Class A900
(0000,0902)
Failed
(0000,0901)
Unable to process Cxxx
(0000,0902)
(0000,1020)
. . I (0000,1021)
Cancel Sub-operations terminated due to Cancel Indication FEQOO
(0000,1022)
(0000,1023)
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Service Status Meaning Error Codes | Related Fields

(0000,1020)
(0000,1021)
(0000,1022)
(0000,1023)

Warning Sub-operations Complete - One or more Failures of Warnings BOOO

(0000,1020)
(0000,1021)
(0000,1022)
(0000,1023)

Success Sub-operations Complete - No Failures or Warning 0000

(0000,1020)
(0000,1021)
(0000,1022)
(0000,1023)

Pending Sub-operations are continuing FFOO

4.2.4.4 Association Acceptance Policy

See next section “Query/Retrieve SCP AE Specification”.

4.2.5 Query/Retrieve SCP Specification

4.2.5.1 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services” section ,Query/Retrieve” in the “Conformance
Statement Overview".

4.2.5.2 Association Policies

4.2.5.2.1 General

When "trusted host" functionality is enabled ARTIS one will only accept Associations from known hosts with a known
AET. Hosts and AETs have to be entered in "Local Service" by a Siemens CSE.

The default PDU size used will be 512 KB.

4.2.5.2.2 Number of Associations

The Siemens ARTIS one DICOM application is able to accept multiple associations at a time. It can handle up to 10 associ-
ations in parallel.

The number of simultaneous DICOM associations can be configured via the Service-Ul. The dialog can be found in "Con-
figuration / DICOM | General".

4.2.5.2.3 Asynchronous Nature

The ARTIS one DICOM software does not support asynchronous communication (multiple outstanding transactions over
a single association).
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4.2.5.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information”.

"

4.2.5.3 Association Initiation Policy

See previous section “Query/Retrieve SCU AE Specification”.

4.2.5.4 Association Acceptance Policy

The ARTIS one DICOM application will accept associations for the following DIMSE-C operations as SCP:

C-FIND

C-GET

C-MOVE
C-FIND-CANCEL
C-GET-CANCEL
C-MOVE-CANCEL

Extended negotiation - which is relational query or retrieve - is not supported for the above listed services. The ARTIS
one DICOM application does support multiple C-FIND requests over the same association, while multiple C-MOVE or C-
GET operations are not supported over the same association.

4.2.5.4.1 Activity - Process Search Requests

4.2.5.4.1.1 Description and Sequencing of Activity

The Query SCP AE will respond to incoming query requests from a SCU with the query model Patient Root, Study Root
and Patient/Study Only. Relational retrieve operation is not supported. The content records of the local database are
used to match the incoming query keys and fill the related return keys. With a C-FIND-CANCEL request the running
query can be canceled at any time.

Multiple C-FIND requests over the same association are supported.

4.2.5.4.1.2 Accepted Presentation Contexts

The ARTIS one DICOM application will accept Presentation Contexts as shown in the following table:

Table 19 - Presentation Context Table "Process Search Requests"

Presentation Context Table - “Process Search Requests”

Abstract Syntax Transfer Syntax

Ext.

Name uiD Name List UID List
Role | Neg.

Query/Retrieve Model
Patient Root - FIND

Implicit VR Little Endian Ex- 1.2.840.10008.1.2
1.2.840.10008.5.1.4.1.2.1.1 plicit VR Big Endian 1.2.840.10008.1.2.2 | SCP | None
Explicit VR Little Endian 1.2.840.10008.1.2.1

Query/Retrieve Model
Study Root - FIND

Implicit VR Little Endian Ex- 1.2.840.10008.1.2
1.2.840.10008.5.1.4.1.2.2.1 plicit VR Big Endian 1.2.840.10008.1.2.2 | SCP | None
Explicit VR Little Endian 1.2.840.10008.1.2.1
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Query/Retrieve Model Implicit VR Little Endian Ex- 1.2.840.10008.1.2
Patient/Study Only - 1.2.840.10008.5.1.4.1.2.3.1 plicit VR Big Endian 1.2.840.10008.1.2.2 | SCP | None
FIND Explicit VR Little Endian 1.2.840.10008.1.2.1

Note: C-FIND Extended Negotiation will not be supported.

The order of preference for accepting Transfer Syntaxes is: 1. Explicit VR Little Endian, 2. Explicit VR Big Endian, 3. Im-
plicit VR Little Endian.

4.2.5.4.1.3 SOP Specific Conformance

The ARTIS one DICOM Query/Retrieve SCP supports hierarchical queries for all mandatory and optional search keys.

The syntactical component structure of the attribute (0010,0010) Patient's Name is defined as follows (see [DICOM],
Part 5, Definition of PN, Person Name):

<single byte group> =<ideographic group>=<phonetic group>

The Query/Retrieve SCP replies to queries for “Patient's Name” as follows:

1. Matching of Patient's Name attribute (0010, 0010) is done case-insensitively.

2. If a search string matches the complete value of a Patient’s Name in the database, a match will be returned.

3. [Ifasearch string matches an individual group (single byte, ideographic or phonetic) of a Patient’s Name in the data-
base, a match will be returned.

4. If a search string matches two consecutive groups of a data base object’s Patient's Name, a match will be returned.

5. Redundant group separators “=" or component separators “A” are treated as insignificant for matching.

6. Leading and trailing blanks within a component or a group of Patient’s Name are treated as insignificant for match-
ing.

Except for attribute Patient’s Name (0010,0010) any queries for text string attributes will be treated case-sensitively.
The Find SCP will not differentiate "?" and "*", thus "?abc*" will be treated as "*abc*".

If the value for the patient-level unique key "Patient ID" is not known, it will be returned with zero length. The attribute
“Image Comments” will not be included in the C-FIND-RSP, if it is not set in the DB, even if it was requested as return key
in the related C-FIND-RQ.

Usage of Storage Media File-Set ID, Retrieve AE Title with C-FIND-RSP message:

* The Storage Media File-Set ID - if available - can be returned at Study/Series/lmage Level. Only on Image Level, the
values of ONLINE, NEARLINE or OFFLINE are returned to indicate the Storage Location of the related Instance.

= The Retrieve AE Title - if available - can only be returned at Image Level (for Patient Root and Study Root models) or
Study Level (for Patient/Study Only model).

Relational Queries are not supported.

A remote DICOM AE can cancel the running query by sending a C-FIND-CANCEL. Matches are possibly continuing (more
C-FIND response with status PENDING) until the cancel operation takes effect and query matching has completed.

The supported attributes on the various query levels of the three supported information models are listed in the follow-
ing table.
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Table 20 - Query/Retrieve SCP supported attributes

Attribute Name Tag PR | SR | PSo Matching
Patient Level (PR or PSo) or Study Level (SR)
Patient's Name (0010,0010) R R R Single Value, Wildcard, Universal
Patient ID (0010,0020) u R U Single Value, Wildcard, Universal
Patient’s Birth Date (0010,0030) 0 0 (0] Single Value, Range, Universal
Patient’s Birth Time (0010,0032) 0 0 (e] Single Value, Range, Universal
Patient’s Sex (0010,0040) 0 0 0 Single Value, Wildcard, Universal
Ethnic Group (0010,2160) 0 - (¢] Single Value, Wildcard, Universal
Patient Comments (0010,4000) 0 0 (0] Wildcard, Universal
Number of Patient related Studies (0020,1200) 0 0 (¢] Universal
Number of Patient related Series (0020,1202) 0 0 0 Universal
Number of Patient related Instances (0020,1204) 0 0 (¢] Universal
Study Level
Study Instance UID (0020,000D) u U U Single Value, List of UIDs
Study ID (0020,0010) R R R Single Value, Wildcard, Universal
Study Date (0008,0020) R R R Single Value, Range, Universal
Study Time (0008,0030) R R R Single Value, Range, Universal
Accession Number (0008,0050) R R R Single Value, Wildcard, Universal
Referring Physician’s Name (0008,0090) | © 0] 0 Single Value, Wildcard, Universal
Study Description (0008,1030) 0 0 (e] Single Value, Wildcard, Universal
Admitting Diagnosis Description (0008,1080) | © 0] 0 Single Value, Wildcard, Universal
Patient's Age (0010,1010) 0 0 (e] Single Value, Wildcard, Universal
Patient’s Size (0010,1020) 0 0 (0] Single Value, Universal
Patient’s Weight (0010,1030) 0 0 (¢] Single Value, Universal
Occupation (0010,2180) 0 0 (0] Single Value, Wildcard, Universal
Additional Patient History (0010,21B0) 0 0 (¢] Wildcard, Universal
Name of Physician reading the Study | (0008,1060) | O 0] 0 Single Value, Wildcard, Universal
Modalities in Study (0008,0061) 0 0 (e] Multiple values, Universal
Number of Study Related Series (0020,1206) 0 0 0 Universal
Number of Study Related Instances (0020,1208) 0 0 (¢] Universal
Series Level
Series Instance UID (0020,000E) u U - Single Value, List of UIDs
Series Number (0020,0011) R R - Single Value, Universal
Modality (0008,0060) R R - Single Value, Wildcard, Universal
Laterality (0020,0060) 0 0 - Single Value, Wildcard, Universal
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Attribute Name Tag PR | SR | PSo Matching
Body Part Examined (0018,0015) 0 0 - Single Value, Wildcard, Universal
Patient Position (0018,5100) 0 0 - Single Value, Wildcard, Universal
Smallest Pixel Value in Series (0028,0108) 0 0 - Single Value, Universal
Largest Pixel Value in Series (0028,0109) 0 0 - Single Value, Universal
Protocol Name (0018,1030) 0 0 - Single Value, Wildcard, Universal
Series Date (0008,0021) 0 0 - Single Value, Range, Universal
Series Time (0008,0031) 0 0 - Single Value, Range, Universal
Series Description (0008,103E) 0 0 - Single Value, Wildcard, Universal
Operator's Name (0008,1070) 0 0 - Single Value, Wildcard, Universal
Performing Physician’s name (0008,1050) | O 0] - Single Value, Wildcard, Universal
Performed Procedure Step Start Date | (0040,0244) 0 0 - Universal
Performed Procedure Step Start Time | (0040,0245) 0 0 - Universal
Number of Series related Instances (0020,1209) 0 0 - Universal
Image or SR Document Level
SOP Instance UID (0008,0018) u u - Single Value, List of UIDs
Image Number (0020,0013) R R - Single Value, Universal
Content Date (0008,0023) 0 0 - Single Value, Range, Universal
Content Time (0008,0033) 0 0 - Single Value, Range, Universal
Modality (0008,0060) 0 0 - Single Value, Wildcard, Universal
Image Comments (0020,4000) 0 0 - Universal
Referenced Request Sequence (0040,A370) 0 0 - Sequence matching
>Accession Number ((0008,0050) | O 0 - Single Value, Universal
>Requested Procedure ID (0040,1000) 0 0 - Single Value, Universal
Concept Name Code Sequence (0040,A043) | O 0] - Sequence matching
>Code Value (0008,0100) 0 0 - Single Value, Wildcard, Universal
>Coding Scheme Designator (0008,0102) | © 0] - Single Value, Wildcard, Universal
>Coding Scheme Version (0008,0103) 0 0 - Single Value, Wildcard, Universal
>Code Meaning (0008,0104) 0 0 - Single Value, Wildcard, Universal
Template Identifier (0040,DB00) 0 0 - Single Value, Wildcard, Universal
Completion Flag (0040,A491) | O 0] - Single Value, Wildcard, Universal
Verification Flag (0040,A493) 0 0 - Single Value, Wildcard, Universal
Verifying Observer Sequence (0040,A073) | O 0] - Sequence matching
>Verifying Organization (0040,A027) | O 0] - Single Value, Wildcard, Universal
>Verifying Date Time (0040,A030) | O 0] - Single Value, Range, Universal
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Attribute Name Tag PR | SR | PSo Matching
>Verifying Observer Name (0040,A075) | O 0] - Single Value, Wildcard, Universal
ZVerifying Observer Identification (0040,A088) | O 0 i Sequence matching
ode Sequence
>>Code Value (0008,0100) 0 0 - Single Value, Wildcard, Universal
>>Coding Scheme Designator (0008,0102) | © 0] - Single Value, Wildcard, Universal
>>Coding Scheme Version (0008,0103) 0 0 - Single Value, Wildcard, Universal
>>Code Meaning (0008,0104) 0 0 - Single Value, Wildcard, Universal

PR = Patient Root Model, SR = Study Root Model, PSo = Patient/Study Only Model
U = Unique Key, R = Required Key, O = Optional Key, - = not supported or applicable

The "Process Search Requests” activity can return the following status codes:

Table 21 - Status Codes Process Search Request

Service Status Meaning Error Codes | Related Fields
Refused Out of Resources A700 (0000,0902)
o (0000,0901)
Identifier does not match SOP Class A900
(0000,0902)
Failed
(0000,0901)
Unable to process C0o01
(0000,0902)
Cancel Matching terminated due to Cancel request FEOO None
Success Matching is complete - No final Identifier is supplied 0000 None
Matches are continuing - Current Match is supplied and any
Optional Keys were supported in the same manner as Re- FFOO Identifier
quired Keys
Pending
Matches are continuing - Warning that one or more Optional
Keys were not supported for existence and/or matching for FFO1 Identifier
this identifier

4.2.5.4.2 Activity - Process Retrieve Requests

4.2.5.4.2.1 Description and Sequencing of Activity

The associated activity is to respond to retrieve requests initiated from a foreign SCU. Relational retrieve operation is not
supported.

Multiple C-GET or C-MOVE requests over the same association are not supported.

4.2.5.4.2.1 Accepted Presentation Contexts

The ARTIS one DICOM application will accept Presentation Contexts as shown in the following table:
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Table 22 - Presentation Context Table "Process Retrieve Requests"

Presentation Context Table - “Process Retrieve Requests”

Abstract Syntax Transfer Syntax
Ext.
Name uiD Name List UID List
Role | Neg.
IRetri Model Implicit VR Little Endian Ex- 1.2.840.10008.1.2
Query/Retrieve Model |, ; 541 10008.5.1.4.1.2.1.3 plicit VR Big Endian 1.2.840.10008.1.2.2 | SCP | None
Patient Root - GET . . .
Explicit VR Little Endian 1.2.840.10008.1.2.1
IRetri Model Implicit VR Little Endian Ex- 1.2.840.10008.1.2
Sttzrijoi'?\éeET Odel 11.2.840.10008.5.1.4.1.2.2.3 plicit VR Big Endian 1.2.840.10008.1.2.2 | SCP | None
y Explicit VR Little Endian 1.2.840.10008.1.2.1
Query/Retrieve Model Implicit VR Little Endian Ex- | 1.2.840.10008.1.2
Patient/Study Only - 1.2.840.10008.5.1.4.1.2.3.3 plicit VR Big Endian 1.2.840.10008.1.2.2 [ SCP | None
GET Explicit VR Little Endian 1.2.840.10008.1.2.1
Retrieve Model Implicit VR Little Endian Ex- | 1.2.840.10008.1.2
QuerylRetrieve Model | ; 5 g4 10008.5.1.4.1.2.1.2 plicit VR Big Endian 1.2.840.10008.1.2.2 | SCP | None
Patient Root - MOVE .. . .
Explicit VR Little Endian 1.2.840.10008.1.2.1
IRetri Model Implicit VR Little Endian Ex- 1.2.840.10008.1.2
Query/Retrieve Model |, ; 5,1 10008.5.1.4.1.2.2.2 plicit VR Big Endian 1.2.840.10008.1.2.2 | SCP | None
Study Root - MOVE - . .
Explicit VR Little Endian 1.2.840.10008.1.2.1
Query/Retrieve Model Implicit VR Little Endian Ex- 1.2.840.10008.1.2
Patient/Study Only - 1.2.840.10008.5.1.4.1.2.3.2 plicit VR Big Endian 1.2.840.10008.1.2.2 [ SCP | None
MOVE Explicit VR Little Endian 1.2.840.10008.1.2.1

Note: C-FIND Extended Negotiation will not be supported.

The order of preference for accepting Transfer Syntaxes is: 1. Explicit VR Little Endian, 2. Explicit VR Big Endian, 3. Im-

plicit VR Little Endian.

4.2.5.4.2.2 SOP Specific Conformance

Relational retrieve operation is not supported.

All unique keys must be supplied according to the selected Query/Retrieve Level. The related tables in the C-FIND SCP
section will give information about "U" marked key attributes.

The C-STORE can only be performed to AEs that are configured in the ARTIS one.

The “Process Retrieve Requests” activity can return the following status codes:

Table 23 - Status Codes "Process Retrieve Requests”

Service Status

Refused

Meaning Error Codes | Related Fields
Out of Resources - Unable to calculate number of matches A701 (0000,0902)
(0000,1020)
. (0000,1021)
Out of Resources - Unable to perform sub operations A702

(0000,1022)
(0000,1023)
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Service Status Meaning Error Codes | Related Fields

(0000,0901)
(0000,0902)

Identifier does not match SOP Class A900
Failed

(0000,0901)

Unable to process C0o01
(0000,0902)

(0000,1020)
(0000,1021)
(0000,1022)
(0000,1023)

Cancel Sub-operations terminated due to Cancel Indication FEOO

(0000,1020)
(0000,1021)
(0000,1022)
(0000,1023)

Warning Sub-operations Complete - One or more Failures of Warnings BOOO

(0000,1020)
(0000,1021)
(0000,1022)
(0000,1023)

Success Sub-operations Complete - No Failures or Warning 0000

(0000,1020)
(0000,1021)
(0000,1022)
(0000,1023)

Pending Sub-operations are continuing FFOO

4.2.6 Print SCU Specification

4.2.6.1 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services” section “Print Management” in the “Conformance
Statement Overview".

4.2.6.2 Association Policies

4.2.6.2.1 General

Whenever a film-sheet is completely set up and printed by command or automated rule, the job is prepared for pro-
cessing. As soon as the queue is ready to process the job, it is activated and worked according to the processing data.
The Print application will initiate an association to the print destination and process the printing.
The default PDU size used will be 512 KB.

4.2.6.2.2 Number of Associations

The ARTIS one DICOM application initiates one association at a time for each different print device configured.

4.2.6.2.3 Asynchronous Nature

The ARTIS one DICOM print application does not support asynchronous communication (multiple outstanding
transactions over a single association).
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4.2.6.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information” in the
“Conformance Statement Overview”.

4.2.6.3 Association Initiation Policy

Triggered by the Print job queue the Print Management SCU establishes an association by using the DICOM association
services. An N-GET request determines the printer status prior to printing. If the printer status is “normal”, the print job
is started.

After the last film is printed from queue, the Print application will leave open the association for another 60 seconds. If a
new film job is ready for printing within this time-limit, the job will be immediately processed over the still open associa-
tion. If there is no new job, the association is closed.

During the “idle-time” (no open association to printer) the Print application will issue a cyclic camera status request (us-
ing N-GET of the Printer SOP Class) every 5 minutes.

4.2.6.3.1 Activity - Print Film
4.2.6.3.1.1 Description and Sequencing of Activity

The film sheet is internally processed, converted to a Standard/1-1 page and then the page image is sent. Status is con-
trolled by awaiting any N-EVENT message through the transfer until the last image or film-sheet is sent.

If the response from the remote application contains a status other than Success or Warning the association is aborted.

4.2.6.3.1.2 Proposed Presentation Context

The ARTIS one DICOM application will propose Presentation Contexts as shown in the following table:

Table 24 - Presentation Context Table "Print Film"

Presentation Context Table - “Print Film”

Abstract Syntax Transfer Syntax

Ext.

Name uiD Name List UID List Role |Neg.

—_

.2.840.10008.1.2
.2.840.10008.1.2.1 SCU [ None
.2.840.10008.1.2.2

Basic Grayscale Print Implicit VR Little Endian
Management Meta 1.2.840.10008.5.1.1.9 Explicit VR Little Endian

SOP Class Explicit VR Big Endian

_

Implicit VR Little Endian
1.2.840.10008.5.1.1.1 Explicit VR Little Endian
Explicit VR Big Endian

—_

.2.840.10008.1.2
.2.840.10008.1.2.1 SCU [ None
.2.840.10008.1.2.2

Basic Film Session SOP
Class

_

—_

.2.840.10008.1.2
.2.840.10008.1.2.1 SCU [ None
.2.840.10008.1.2.2

Implicit VR Little Endian
1.2.840.10008.5.1.1.2 Explicit VR Little Endian
Explicit VR Big Endian

Basic Film Box SOP
Class

-

—_

.2.840.10008.1.2
.2.840.10008.1.2.1 SCU [None
.2.840.10008.1.2.2

Implicit VR Little Endian
1.2.840.10008.5.1.1.4 Explicit VR Little Endian
Explicit VR Big Endian

Basic Grayscale Image
Box SOP Class

—_

_

.2.840.10008.1.2
.2.840.10008.1.2.1 SCU | None
.2.840.10008.1.2.2

Implicit VR Little Endian
Printer SOP Class 1.2.840.10008.5.1.1.16 Explicit VR Little Endian
Explicit VR Big Endian

—_

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11 37 of 154



Presentation Context Table - “Print Film”
Abstract Syntax Transfer Syntax
Ext.
Name uiD Name List UID List
Role | Neg.
Implicit VR Little Endian 1.2.840.10008.1.2
Print Job SOP Class 1.2.840.10008.5.1.1.14 Explicit VR Little Endian 1.2.840.10008.1.2.1 SCU None
Explicit VR Big Endian 1.2.840.10008.1.2.2
) Implicit VR Little Endian 1.2.840.10008.1.2
g::se”tat'on LUTSOP {1 5 840.10008.5.1.1.23 Explicit VR Little Endian 1.2.840.10008.1.2.1 [SCU |None
Explicit VR Big Endian 1.2.840.10008.1.2.2

4.2.6.3.1.3 SOP Specific Conformance

The ARTIS one DICOM print management SCU conforms to the DICOM Basic Grayscale Print Management Meta SOP
Class.

The application uses a setting platform to define the properties of the connected DICOM SCP, e.g.:

= maximum number of print jobs in the queue

= maximum number of print copies

=  supported film sizes of the connected DICOM SCP
= supported film formats of the DICOM SCP

=  |ookup table definition.

The printing is only suspended in the case of a failure return status of the SCP.

Basic Film Session SOP Class

The Basic Film Session information object definition describes all the user-defined parameters, which are common for all
the films of a film session. The Basic Film Session refers to one or more Basic Film Boxes that are printed on one hard-
copy printer.

The ARTIS one DICOM print management SCU supports the following DIMSE Service elements for the Basic Film Session
SOP Class as SCU:

L N-CREATE
L] N-DELETE
The Basic Film Session SOP Class N-CREATE-RQ (SCU) uses the following attributes:

Table 25 - Basic Film Session N-CREATE attributes

Attribute Name Tag Usage SCU Supported Values
Number of Copies (2000,0010) U “"
BLUE FILM
Medium Type (2000,0030) u CLEAR FILM
PAPER
. o MAGAZINE
Film Destination (2000,0040) U
PROCESSOR

U = User Option
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The number of copies sent to the DICOM Printer is always 1, the job is sent n times for n copies.

The affected SOP Instance UID received with N-CREATE-RSP message will be kept internally and used for later requests
(e.g. N-DELETE-RQ) on the Basic Film Session — see below:

Table 26 - Affected SOP Instance UID

Attribute Name Tag Source of Information

(0000,1000)
Requested SOP Instance UID EN
(0000,1001)

Affected SOP Instance UID of N-CREATE-
RSP on Basic Film Session

The N-DELETE-RQ on the Basic Film Session SOP Class is used to remove the complete Basic Film Session SOP Instance
hierarchy.

The Basic Film Session SOP Class interprets the following status codes (from N-CREATE-RSP, N-DELETE-RSP messages):

Table 27 - Basic Film Session Status Codes

Service Status Meaning Error Codes
Film session SOP instances hierarchy does not contain film
box SOP instances 600
Failure Unable to create print job, print queue is full C601
Image size is larger than images box size C603
Memory allocation not supported B600
Warning Film session printing is not supported B601
Film box does not contain image box (empty page) B602
Success Film belonging to the film session are accepted for printing 0000

Basic Film Box SOP Class

The Basic Film Box information object definition describes all the user-defined parameter of one film of the film session.
The Basic Film Box information description defines the presentation parameters, which are common for all images on a
given sheet of film.

The Basic Film Box refers to one or more Image Boxes.

Supported Service Elements as SCU are:

= N-CREATE
= N-ACTION
=  N-DELETE

The Basic Film Box SOP Class N-CREATE-RQ message uses the following attributes (the actual values for each attribute
depend on DICOM printer configuration within the ARTIS one DICOM print management SCU):

Table 28 - Basic Film Box N-CREATE attributes

Attribute Name Tag Usage SCU Supported Values
Image Display Format (2010,0010) M STANDARD\1,1
Referenced Film Session Sequence | (2010,0500) M n. a.
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> Referenced SOP Class UID (0008,1150) M 1.2.840.10008.5.1.1.1
> Referenced SOP Instance UID (0008,1155) M
Film Orientation (2010,0040) M PORTRAIT
8INXTOIN, TOINX12IN,
T0INX14IN,
T1INX14IN,,
Film Size ID (2010,0050) M 14INX14IN,
14INX17IN,
24CMX24CM,
24CMX30CM
L. BILINEAR, CUBIC,
Magnification Type (2010,0060) M NONE, REPLICATE
Max Density (2010,0130) u >0
Min Density (2010,0120) U 50 >value>0
>0
lllumination (2010,015E) u Required if Presenta-
tion
LUT is present.
>0
Reflective Ambient Light (2010,0160) u Req“'mdti';:rese”ta'
LUT is present.
Referenced Presentation LUT Se- (2050,0500) U
quence

The N-CREATE-RSP message from the Print SCP includes the Referenced Image Box Sequence with SOP Class/Instance
UID pairs which will be kept internally and used for the subsequent Basic Image Box SOP Class N-SET-RQ messages.

When all Image Boxes (including parameters) for the film-sheet have been set, the DICOM print manager will issue an N-

M = Mandatory, U = User Option

ACTION-RQ message with the SOP Instance UID of the Basic Film Box and the Action Type ID of 1.

The affected SOP Instance UID received with N-CREATE-RSP message will be kept internally and used for later requests

(e.g. N-DELETE-RQ) on the Basic Film Box - see below:

Table 29 - Affected SOP Instance UID

Attribute Name

Tag

Source of Information

Requested SOP Instance UID

(0000,1000)

9
(0000,1001)

Affected SOP Instance UID of N-CREATE-RSP on
Basic Film Box
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The Basic Film Box SOP Class

interprets the following status codes:

Table 30 - Basic Film Box Status Codes

Service Status Meaning Error Codes
Unable to create print job, print queue is full C601
Failure
Image size is larger than images box size C603
Film box does not contain image box (empty page) B603
Warning Requested MinDensity or MaxDensity outside of Printer’s op- B605
erating range
Success Film accepted for printing 0000

Basic Grayscale Image Box SOP Class

The Basic Grayscale Image Box information object definition is the presentation of an image and image related data in
the image area of a film. The Basic Grayscale Image Box information describes the presentation parameters and image

pixel data, which apply to a single image of a sheet of film.

The Grayscale Image Box SOP Class uses only the N-SET-RQ with the following attributes:

Table 31 - Basic Grayscale Image Box N-SET attributes

Attribute Name Tag Usage SCU Supported Values
Image Position (2020,0010) M 1
BASIC Grayscale Image Sequence (2020,0110) M n. a.
> Samples per Pixel (0028,0002) M 1
> Photometric Interpretation (0028,0004) M MONOCHROME2
> Rows (0028,0010) M <Printer/Film config>
> Columns (0028,0011) M <Printer/Film config>
> Pixel Aspect Ratio (0028,0034) M (1:1)
> Bits Allocated (0028,0100) M 8,16
> Bits Stored (0028,0101) M 8,12
> High Bit (0028,0102) M 7,11
> Pixel Representation (0028,0103) M 0
> Pixel Data (7FE0,0010) M

M = Mandatory

The Grayscale Image Box SOP Class interprets the following status codes:

Table 32 - Basic Grayscale Image Box Status Codes

Service Status Meaning Error Codes
Image contains more pixel than printer can print in Image
8 €603
Failure oX
Insufficient memory in printer to store the image C605
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Service Status Meaning Error Codes

Requested MinDensity or MaxDensity outside of Printer’s op-

. B605
erating range

Warning

Success 0000

Presentation LUT SOP Class

The Presentation LUT tailors image hardcopy printing for specific modalities, applications and user preferences.

The output of the Presentation LUT is Presentation Values (P-Values). P-Values are approximately related to human per-
ceptual response. They are intended to facilitate common input for hardcopy. P-Values are intended to be independent
of the specific class or characteristics of the hardcopy device.

The Presentation LUT SOP Class uses only the N-CREATE-RQ with the following attributes:

Table 33 - Presentation LUT N-CREATE attribute

Attribute Name Tag Usage SCU Supported Values

Presentation LUT Shape (2050,0020) u IDENTITY

U = User Option

The affected SOP Instance UID received with N-CREATE-RSP message will be kept internally and is used for later requests
on the Basic Film Box (N-CREATE-RQ) and on the Presentation LUT (N-DELETE-RQ) - see below:

Table 34 - Affected SOP Instance UID

Attribute Name Tag Source of Information

(0000,1000)
Requested SOP Instance UID BN
(0000,1001)

Affected SOP Instance UID of N-CREATE-RSP
on Presentation LUT

The Presentation LUT SOP Class interprets the following status codes:

Table 35 - Presentation LUT Status Codes

Service Status Meaning Error Codes

Success Presentation LUT successfully created 0000

Requested MinDensity or MaxDensity outside of printer's op-
Warning erating range. The printer will use its respective minimum or B605
maximum density value instead.

Printer SOP Class
The Printer SOP Class allows to monitor the status of the hardcopy printer in a synchronous and an asynchronous way.

The SCU uses the mandatory N-EVENT Report DIMSE service to monitor the changes of the printer status in an asynchro-
nous way.

The following returned information is supported:

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11 42 of 154



Table 36 - Used Printer N-EVENT Report attributes

Event-type Name Event Attributes Tag Usage SCU
Normal 1

Warning 2 Printer Status Info (2110,0020) u
Failure 3 Printer Status Info (2110,0020) U

U = User Option

Table 37 - Mandatory Printer N-GET-RSP, N-EVENT-REPORT-RQ attributes

Attribute Name Tag Usage SCP Supported Values
Printer Status (2110,0010) M NORMAL, FAILURE, WARNING
Printer Status Info (2110,0020) M See tables in Annex for details.

M = Mandatory

Note: For a detailed description on how ARTIS one reacts on different printer status messages, please refer to the Annex section “DI-
COM Print SCU - detailed status displays”.

Print Job SOP Class

The Print Job SOP Class allows to monitor the execution of the print process.

The ARTIS one DICOM Print Management application supports the optional N-EVENT-REPORT DIMSE Service to receive
the changes of the Print Job Status in an asynchronous way.

It can receive Events from the Print SCP asynchronously:

=  N-EVENT-REPORT

Note: The underlying syngo DICOM Print AE does not support receiving of N-EVENT-REPORT messages from camera dur-
ing open print sessions. This is typically configurable in the camera setup.

The following information is supported:

Table 38 - Used Print Job N-EVENT Report attributes

Event-type Name Event Attributes Tag Usage SCU
Execution Status Info (2100,0030) U
Print Job 1D (2100,0010) | (Print Queue Manage-
Normal 1 ment SOP Class not
supported)
Film Session Label (2000,0050) u
Printer Name (2110,0030) U
Execution Status Info (2100,0030) u
Printing 2 Print Job ID (2100,0010) | (Print Queue Manage-
ment SOP Class not
supported)
Film Session Label (2000,0050) u
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Event-type Name Event Attributes Tag Usage SCU
Printer Name (2110,0030) U
Execution Status Info (2100,0030) U
Print Job 1D (2100,0010) | (Print Queue Manage-
Done 3 ment SOP Class not
supported)
Film Session Label (2000,0050) u
Printer Name (2110,0030) U
Execution Status Info (2100,0030) u
Print Job ID (2100,0010) | (Print Queue Manage-
Failure 4 ment SOP Class not
supported)
Film Session Label (2000,0050) u
Printer Name (2110,0030) u

U = User Option

Note: For a detailed description on how ARTIS one reacts on different printer status messages, please refer to the Annex section “DI-
COM Print SCU - detailed status displays”.

4.2.6.3.2 Activity - Show Device Status

4.2.6.3.2.1 Description and Sequencing of Activity

With no printing activity ongoing (“idle time”), the ARTIS one DICOM Print SCU application will cyclically request the
printer status to update the related printer state in the Printing UL.

4.2.6.3.2.2 Proposed Presentation Context

The ARTIS one DICOM application will propose Presentation Contexts as shown in the following table:

Table 39 - Presentation Context Table "Show Device Status"

Presentation Context Table - “Show Device Status”
Abstract Syntax Transfer Syntax
Ext.
Name uID Name List UID List
Role | Neg.
Implicit VR Little Endian 1.2.840.10008.1.2
Printer SOP Class 1.2.840.10008.5.1.1.16 Explicit VR Little Endian 1.2.840.10008.1.2.1 SCU None
Explicit VR Big Endian 1.2.840.10008.1.2.2

4.2.6.3.2.3 SOP Specific Conformance

The Printer SOP Class allows to monitor the status of the hardcopy printer in a synchronous and an asynchronous way.
The Print SCU AE application will cyclically “ask” the Printer (SCP) for its status synchronously:

. N-GET as SCU

The following information is supported:
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Table 40 - Used Printer N-EVENT Report attributes

Event-type Name Event Attributes Tag Usage SCU
Normal 1

Warning 2 Printer Status Info (2110,0020) u
Failure 3 Printer Status Info (2110,0020) U

U = User Option

Table 41 - Mandatory Printer N-GET-RSP, N-EVENT-REPORT-RQ attributes

Attribute Name Tag Usage SCP Supported Values
Printer Status (2110,0010) M NORMAL, FAILURE, WARNING
Printer Status Info (2110,0020) M See tables in Annex for details.

M = Mandatory

Note: For a detailed description on how ARTIS one reacts on different printer status messages, please refer to the Annex section “DI-
COM Print SCU - detailed status displays”.

4.2.6.4 Association Acceptance Policy

4.2.7 Worklist SCU AE

4.2.7.1 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services” section ,Workflow Management” in the “Conform-
ance Statement Overview”.

4.2.7.2 Association Policies

4.2.7.2.1 General

It is possible to configure a cyclic update of the modality Scheduler DB through a background worklist request with
date/time and modality information.

In addition, the user can request worklist update with “Update Worklist”. No duplicate entries will be added in the Sched-
uler DB. Entries are uniquely identified by the Study Instance UID (0020,000D) for the Requested Procedure and the SPS
ID (0040,009) in the SPS Sequence (0040,0100).

An interactive worklist query can be issued with search criteria entered in the patient-based Query dialog from the pa-
tient browser.

The default PDU size used will be 512 KB.

4.2.7.2.2 Number of Associations

The ARTIS one DICOM application initiates one association at a time to query worklist entry data.
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4.2.7.2.3 Asynchronous Nature

The ARTIS one DICOM software does not support asynchronous communication (multiple outstanding transactions over
a single association).

4.2.7.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information” in the
“Conformance Statement Overview”.

4.2.7.3 Association Initiation Policy

The ARTIS one DICOM application will cyclically query the worklist provider and by request from the patient registration
interface. It establishes an association by using the

= C-FIND with Worklist information model

It is possible to configure multiple worklist providers but only one can be active at a time. The active worklist provider can be
selected in the user settings.

4.2.7.3.1 Activity - (cyclic) Update Worklist
4.2.7.3.1.1 Description and Sequencing of Activity

A network application will perform worklist queries with the C-FIND request at regular intervals. In addition, it can be
triggered by immediate request. The received worklist items will be compared with the contents of the local Scheduler
DB. New items will be inserted into Scheduler DB.

After each broad query, all Requested Procedures / Scheduled Procedure Steps that were canceled or rescheduled to
another modality at the RIS will be automatically removed from the Scheduler DB if :

1. the Examination of this procedure has not been started or finished yet, and

2. the corresponding configuration item “Automatic removal of canceled/rescheduled Request” was checked in the Ser-
vice Ul under DICOM/HIS-RIS Node.

No automatic clean-up of the Scheduler DB is performed after a Patient-based Query since the worklist received - due to
restricted search criteria - does not correspond to the list of all currently scheduled procedures for the modality.

4.2.7.3.1.2 Proposed Presentation Context

The ARTIS one DICOM application will propose Presentation Contexts as shown in the following table:

Table 42 - Presentation Context “Update Worklist”

Presentation Context Table - “Update Worklist”
Abstract Syntax Transfer Syntax
Ext.
Description Name List UID List Role |Neg.
Explicit VR Little Endi 1.2.840.10008.1.2.1
1.2.840.10008.5.1.4.31 XPlet T e Endian
Modality Worklist Inf :on Model - FIND Explicit VR Big Endian 1.2.840.10008.1.2.2 SCU | None
odality Worklist Information Modef - Implicit VR Little Endian 1.2.840.10008.1.2
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4.2.7.3.1.3 SOP Specific Conformance

= Search Key Attributes for the Worklist C-FIND

The ARTIS one DICOM worklist SCU supports “broad worklist queries” with all required search keys. The following table
describes the “broad query” search keys that the SCU supports.

Table 43 - Supported Broad Worklist Query Search Key Attributes

. Matching

Attribute Name Tag Key Type Query Value
Scheduled Procedure Step
Scheduled Procedure Step Sequence (0040,0100) R
>Scheduled Station AE Title
(It depends on user configuration (Options->Configu-
ration-> Patient Registration) if the "own AET" is pro- | (0040,0001) R <own AET> or <zero length>
vided or not. Use the "HIS/RIS" tab card for configura-
tion.)

>Schedule Procedure Step Start Date

(It depends on user configuration (Options->Configu-
ration-> Patient Registration) if Date range with a (0040,0002) R
fulltime range or an interactive input dialog for
date/time specification is used.)

<config. Date>-<config.
Date> or range from Ul

>Schedule Procedure Step Start Time

(It depends on user configuration (Options->Configu- 00.00-235959.00 or range
ration-> Patient Registration) if the actual Date with | (0040,0003) R g
a fulltime range or an interactive input dialog for
date/time specification is used.)

from Ul

>Modality

(It depends on user configuration (Options->Configu-
ration-> Patient Registration) if the "Modality" is pro- | (0008,0060) R
vided or not. Use the "HIS/RIS" tab card for configura-
tion.)

<zero length> or <config-
ured Modality>

R = Required

= Return Key Attributes of the Worklist C-FIND

The ARTIS one DICOM Worklist SCU supports worklist queries with return key attributes of all types. The following table
describes the return keys that the SCU supports.

An “X" in the Ul column will indicate the attribute is displayed in the user interface. The display is influenced by the re-
lated configuration.

A tag in the 10D column will indicate that the related attribute is included into the SOP Instances of the 10Ds created
during processing of this worklist request.

A tag in the MPPS column will indicate that the related attribute is included into the SOP Instances of the MPPS objects
created during processing of this worklist request. ( See also the tables “Attributes used for the Performed Procedure
Step N-CREATE” and “Attributes used for the Performed Procedure Step N-SET".)
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Table 44 - Basic Worklist C-FIND-RSP Return Key Attributes

Return
Attribute Name Tag Key |UI 10D MPPS
Type

SOP Common
Specific Character Set (0008,0005) 1C (0008,0005) | (0008,0005)
Scheduled Procedure Step
Scheduled Procedure Step Sequence (0040,0100) 1
>Modality (0008,0060) 1 x | (0008,0060) | (0008,0060)
>Requested Contrast Agent (0032,1070) 2C X
>Scheduled Station AE Title
(“Scheduled Station AE Title” is taken as default for (0040,0001) 1 (0040,0241)
“Performed Station AE Title")
>Scheduled Procedure Step Start Date (0040,0002) 1 X
>Scheduled Procedure Step Start Time (0040,0003) 1 X
>Scheduled Procedure Step End Date (0040,0004) 3
>Scheduled Procedure Step End Time (0040,0005) 3
>Scheduled Performing Physician’s Name
(“Scheduled Performing Physician’s Name” is taken as | (0040,0006) 1 x [ (0008,1050) | (0008,1050)
default for “Performing Physician’s Name”)
>Scheduled Procedure Step Description (0040,0007) | (0040,0007)
(“Scheduled Procedure Step Description” is taken as (0040,0007) 1C X (0040,0254)

P TS : (0040,0254)
default for “Performed Procedure Step Description”)
>Scheduled Protocol Code Sequence
(Universal Sequence Match) (0040,0008) 1c 588:88;)(6)3; 28828822(8);
(“Scheduled Protocol Code Sequence” is taken as de- ' '
fault for “Performed Protocol Code Sequence”)
>>Code Value (0008,0100) 1C X
>>Coding Scheme Designator (0008,0102) 1C X
>>Coding Scheme Version (0008,0103) 3 X
>>Code Meaning (0008,0104) 3 X
>Scheduled Procedure Step ID (0040,0009) | (0040,0009)
(“Scheduled Procedure Step ID” is taken as default for (0040,0009) 1 X (0040:0253) (0040:0253)
“Performed Procedure Step ID”)
>Scheduled Station Name (0040,0010) 2 X
>Scheduled Procedure Step Location
(“Scheduled Procedure Step Location” is taken as de- | (0040,0011) 2 X (0040,0243)
fault for “Performed Location”)
>Pre-Medication (0040,0012) 2C X
>Scheduled Procedure Step Status (0040,0020) 3 X
>Comments on the Scheduled Procedure Step (0040,0400) 3 X
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Return

Attribute Name Tag Key |UI 10D MPPS
Type
Requested Procedure
?;;fcr’?;ced Study Sequence (Universal Sequence (0008,1110) > (0008,1110) (0008,1110)
>Referenced SOP Class UID (0008,1150) 1C
>Referenced SOP Instance UID (0008,1155) 1C
Study Instance UID (0020,000D) 1 x | (0020,000D) | (0020,000D)
Requested Procedure Description (0032,1060) 1C x | (0032,1060) | (0032,1060)
Requested Procedure Code Sequence (Universal Se-
quence Match) . (0032,1064) 1C (0008,1032) (0008,1032)
(“Requested Procedure Code Sequence” is taken as de- (0032,1064)
fault for “Procedure Code Sequence”)
>Code Value (0008,0100) 1C X
>Coding Scheme Designator (0008,0102) 1C X
>Coding Scheme Version (0008,0103) 3 X
>Code Meaning (0008,0104) 3 X
Requested Procedure ID
(“Requested Procedure ID” is taken as default for (0040,1001) 1 X 2883888?8 288‘2‘888?8
“Study ID”)
Reason for the Requested Procedure (0040,1002) 3
Requested Procedure Priority (0040,1003) 2 X
Patient Transport Arrangements (0040,1004) 2
Requested Procedure Location (0040,1005) 3
Confidentiality Code (0040,1008) 3 X
Reporting Priority (0040,1009) 3
Names of Intended Recipients of Results (0040,1010) 3 x | (0008,1048)
Requested Procedure Comments (0040,1400) 3 X
Imaging Service Request
Accession Number (0008,0050) 2 x | (0008,0050) (0008,0050)
Referring Physician’s Name (0008,0090) 2 x | (0008,0090)
Requesting Physician (0032,1032) 2 X 288821823
Requesting Service (0032,1033) 3 x | (0032,1033)
Issuing Date of Imaging Service Request (0040,2004) 3
Issuing Time of Imaging Service Request (0040,2005) 3
Placer Order Number / Imaging Service Request
(Old tag (0040,2006) is retired and not used.) (0040.2016) 3 (0040,2016)
Filler Order Number / Imaging Service Request
(Old tag (0040,2007) is retired and not used.) (0040.2017) 3 (0040,2017)
Order entered by ... (0040,2008) 3
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Return

Attribute Name Tag Key |UI 10D MPPS
Type
Order Enterer’s location (0040,2009) 3
Order Callback Phone Number (0040,2010) 3
Imaging Service Request Comments (0040,2400) 3 X

Visit Identification

Institution Name (0008,0080) 3 x | (0008,0080)

Institution Address (0008,0081) 3 - (0008,0081)

Institution Code Sequence (Universal Sequence (0008,0082) 3

Match)

Admission ID (0038,0010) 2 X
Issuer of Admission ID (0038,0011) 3

Visit Status

Visit Status ID (0038,0008) 3
Current Patient Location (0038,0300) 2 X
Patient’s Institution Residence (0038,0400) 3

Visit Comments (0038,4000) 3

Visit Relationship

Referenced Study Sequence (Universal Sequence

Match) (0008,1110) 3 - | (0008,1110) | (0008,1110)
>Referenced SOP Class UID (0008,1150) 1C

>Referenced SOP Instance UID (0008,1155) 1C

?j;tecr;)nced Patient Sequence (Universal Sequence (0008,1120) 5 | ©0008,1120) | (0008,1120)
>Referenced SOP Class UID (0008,1150) 1C

>Referenced SOP Instance UID (0008,1155) 1C

Visit Admission

Referring Physician’s Name (0008,0090) 2 x | (0008,0090)

Admitting Diagnosis Description (0008,1080) 3 x | (0008,1080)

Patient Identification

Patient’s Name (0010,0010) 1 x | (0010,0010) | (0010,0010)
Patient ID (0010,0020) 1 x | (0010,0020) | (0010,0020)
Issuer of Patient ID (0010,0021) 3 - (0010,0021)

Other Patient IDs (0010,1000) 3 x | (0010,1000)

Other Patient IDs Sequence (0010,1002) 3 - (0010,1002)

>Patient ID (0010,0020) 1C x | (0010,0020)

>Issuer of Patient ID (0010,0021) 3 x | (0010,0021)

>Type of Patient ID (0010,0022) 1C x | (0010,0022)

Other Patient Names (0010,1001) 3 x | (0010,1001)
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Return

Attribute Name Tag Key |UI 10D MPPS
Type

Patient’s Birth Name (0010,1005) 3 (0010,1005)
Patient’s Mother’s Birth Name (0010,1060) 3 (0010,1060)
Medical Record Locator (0010,1090) 3 (0010,1090)
Patient Demographic
Patient’s Birth Date (0010,0030) 2 x | (0010,0030) | (0010,0030)
Patient’s Birth Time (0010,0032) 3 (0010,0032)
Patient’s Sex (0010,0040) 2 x | (0010,0040) | (0010,0040)
Ziteicre]::sl\;;stg’rfjnce Plan Code Sequence (Universal Se- (0010,0050) 3 (0010,0050)
>Code Value (0008,0100) 1C
>Coding Scheme Designator (0008,0102) 1C
>Coding Scheme Version (0008,0103) 3
>Code Meaning (0008,0104) 3
Patient's Age (0010,1010) 3 x | (0010,1010)
Patient’s Size (0010,1020) 3 x | (0010,1020)
Patient's Weight (0010,1030) 2 x | (0010,1030)
Patient’s Address (0010,1040) 3 x | (0010,1040)
Military Rank (0010,1080) 3 x | (0010,1080)
Branch of Service (0010,1081) 3 (0010,1081)
Country of Residence (0010,2150) 3 (0010,2150)
Region of Residence (0010,2152) 3 (0010,2152)
Patient’s Telephone Numbers (0010,2154) 3 (0010,2154)
Ethnic Group (0010,2160) 3 x | (0010,2160)
Occupation (0010,2180) 3 (0010,2180)
Patient’s Religious Preference (0010,21F0) 3 (0010,21F0)
Patient Comments (0010,4000) 3 x | (0010,4000)
Patient Data Confidentiality Constraint Description (0040,3001) 2 (0040,3001)
Patient Medical
Medical Alerts (0010,2000) 2 x | (0010,2000)
Contrast Allergies (0010,2110) 2 x | (0010,2110)
Pregnancy Status (0010,21C0) 2 x | (0010,21C0)
Smoking Status (0010,21A0) 3 x | (0010,21A0)
Last Menstrual Date (0010,21D0) 3 x | (0010,21D0)
Additional Patient History (0010,21B0) 3 x | (0010,21B0)
Special Needs (0038,0050) 2 x | (0038,0050)
Patient State (0038,0500) 2 x | (0038,0500)
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Return
Attribute Name Tag Key |UI 10D MPPS

Type

Patient Relationship

Referenced Study Sequence (Universal Sequence

Match) (0008,1110) 3 - | (0008,1110) | (0008,1110)
>Referenced SOP Class UID (0008,1150) 1C
>Referenced SOP Instance UID (0008,1155) 1C

Referenced Visit Sequence (Universal Sequence

Match) (0008,1125) 3

Referenced Patient Alias Sequence (Universal Se-

quence Match) (0038,0004) 3

= The Worklist SCU interprets the following status codes:

Table 45 - Status Codes "Update Worklist"

Service Status Meaning Error Codes | Related Fields
Refused Out of Resources A700 (0000,0902)
. (0000,0901)
Identifier does not match SOP Class A900
(0000,0902)
Failed
(0000,0901)
Unable to process Cxxx
(0000,0902)
Cancel Matching terminated due to Cancel request FEOO None
Success Matching is complete - No final Identifier is supplied 0000 None
Matches are continuing - Current Match is supplied and any
Optional Keys were supported in the same manner as Re- FFOO Identifier
quired Keys
Pending
Matches are continuing - Warning that one or more Optional
Keys were not supported for existence and/or matching for FFO1 Identifier
this identifier

4.2.7.3.2 Activity - Get Worklist
4.2.7.3.2.1 Description and Sequencing of Activity

With "Get Worklist" in the patient-based Worklist Query dialog, the entered attributes are used to form a worklist request
identifier. The response data is used to fill the Patient Registration dialog. The response data are additionally placed in
the Scheduler DB.

4.2.7.3.2.2 Proposed Presentation Context

This Activity will propose the same Presentation Context as with “Update Worklist”. Please see related table in section
4.2.7.3.1.2.
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4.2.7.3.2.3 SOP Specific Conformance

The ARTIS one DICOM worklist SCU supports “narrow worklist queries” with all required search keys. The following tables
describe the “narrow query” search keys that the SCU supports.

Table 46 - Patient based "narrow query" Search Key Attributes

. Matching
Attribute Name Tag Key Type Query Value

Scheduled Procedure Step
Scheduled Procedure Step Sequence (0040,0100) R
>Scheduled Performing Physician’s (0040,0006) R input from Ul or <zero
Name length>
Requested Procedure
Requested Procedure ID (0040,1001) 0 input frlzr:ggrl]:r <zero
Imaging Service Request
Accession Number (0008,0050) 0 Input frlzr:ggrl]:r <zero
Referring Physician’s Name (0008,0090) O input frlc;r:glilklsr <Zero
Visit Status
Current Patient Location (0038,0300) 0} input frlc;r:gl#]:r <zero
Patient Identification
Patient's Name (0010,0010) R nput fr@?g‘#}:r <zero

. input from Ul or <zero
Patient ID (0010,0020) R length>

R = Required Key, O = Optional Key

The Return Key Attribute handling and supported Status Codes are identical to the “Update Worklist” activity. Please see
4.2.7.3.1.3 for details.

4.2.7.4 Association Acceptance Policy

4.2.8 Modality PPS SCU AE

4.2.8.1 SOP Classes

For SOP Classes supported, please refer to “Table 1: Network Services” section ,Workflow Management” in the “Conform-
ance Statement Overview”.
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4.2.8.2 Association Policies

4.2.8.2.1 General

The creation of MPPS Instance is done automatically by ARTIS one whenever a patient is registered for image acquisition
through the Patient Registration dialog.

Further updates on the MPPS data can be done interactively from the related MPPS user interface. The MPPS “Complete”
or “Discontinued” states can be set from user interface.

The default PDU size used will be 512 KB.

4.2.8.2.2 Number of Associations

The ARTIS one DICOM application initiates one association at a time to create or set the MPPS instance.

4.2.8.2.3 Asynchronous Nature

The ARTIS one DICOM software does not support asynchronous communication (multiple outstanding transactions over
a single association).

4.2.8.2.4 Implementation Identifying Information

For Implementation Identifying Information please refer to “Table 3 - Implementation Identifying Information” in the
“Conformance Statement Overview".

4.2.8.3 Association Initiation Policy

The ARTIS one DICOM application will notify a RIS (MPPS Manager) about the status of a procedure while it is performed.
It establishes an association by using the

= N-CREATE DIMSE according to the CREATE Modality Performed Procedure Step SOP Instance operation or a

= N-SET DIMSE to update the contents and state of the MPPS according to the SET Modality Performed Procedure Step Infor-
mation operation.

It is possible to configure multiple MPPS providers but only one can be active at a time. The active MPPS provider can be selected
in the user settings.

4.2.8.3.1 Activity - Patient registered
4.2.8.3.1.1 Description and Sequencing of Activity

A patient is registered by the Patient Registration “Exam” action. From this event the trigger to create a MPPS Instance is derived.
The related Instance is then immediately communicated to the configured RIS system. An association is established and the MPPS
Instance is sent.

4.2.8.3.1.2 Proposed Presentation Context

The ARTIS one DICOM application will propose Presentation Contexts as shown in the following table:
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Table 47 - Presentation Context “Patient Registered”

Presentation Context Table — “Patient Registered”

Modality Performed Procedure Step

Implicit VR Little Endian

1.2.840.10008.1.2

Abstract Syntax Transfer Syntax
Ext.
Description Name List UID List Role |Neg.
Explicit VR Little Endian 1.2.840.10008.1.2.1
1.2.840.10008.3.1.2.3.3 . ) .
Explicit VR Big Endian 1.2.840.10008.1.2.2 SCU None

4.2.8.3.1.3 SOP Specific Conformance

= Attributes for the Performed procedure Step N-CREATE

The Siemens ARTIS one DICOM Modality Performed Procedure Step SCU informs the remote SCP when the examination
of a scheduled procedure step will be performed (i.e. the patient is registered). The N-CREATE message is sent when the

examination is started with successful registration of the patient data. The following table describes the supported at-

tributes of an N-CREATE message.

Table 48 - Performed Procedure Step N-CREATE Attributes

Attribute Name Tag Type Value
SOP Common
Specific Character Set (0008,0005) 1C from MWL or created
Performed Procedure Step Relationship
Scheduled Step Attribute Sequence (0040,0270) 1
>Study Instance UID (0020,000D) 1 from MWL or created
>Referenced Study Sequence (0008,1110) 2 from MWL or <zero length>
>>Referenced SOP Class UID (0008,1150) 1C
>>Referenced SOP Instance UID (0008,1155) 1C
>Accession Number (0008,0050) 2 from MWL or user input
;Efscter Order Number/imaging Service Re- (0040,2016) 3 from MWL or <zero length>
;Ezlsetr Order Number/imaging Service Re- (0040,2017) 3 from MWL or <zero length>
>Requested Procedure ID (0040,0001) 2 from MWL or user input
>Requested Procedure Description (0032,1060) 2 from MWL or <zero length>
>Scheduled Procedure Step ID (0040,0009) 2 from MWL or <zero length>
>Scheduled Procedure Step Description (0040,0007) 2 from MWL or <zero length>
>Scheduled Protocol Code Sequence (0040,0008) 2 from MWL or <zero length>
>>Code Value (0008,0100) 1C
>>Coding Scheme Designator (0008,0102) 1C
>>Coding Scheme Version (0008,0103) 3
>>Code Meaning (0008,0104) 3
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Attribute Name Tag Type Value
Patient’s Name (0010,0010) 2 from MWL or user input
Patient ID (0010,0020) 2 from MWL or user input
Patient’s Birth Date (0010,0030) 2 from MWL or user input
Patient’s Sex (0010,0040) 2 from MWL or user input
Referenced Patient Sequence (0008,1120) 2 from MWL or <zero length>
>Referenced SOP Class UID (0008,1150) 1C
>Referenced SOP Instance UID (0008,1155) 1C
Performed Procedure Step Information
Performed Procedure Step ID (0040,0253) 1 From SPS ID or created
Performed Station AE Title (0040,0241) 1 own AE Title
Performed Station Name (0040,0242) 2 own hostname
Performed Location (0040,0243) 2 ;cg;r;tszs location or <zero
Performed Procedure Step Start Date (0040,0244) 1 created
Performed Procedure Step Start Time (0040,0245) 1 created
Performed Procedure Step Status (0040,0252) 1 “IN PROGRESS”
Performed Procedure Step Description (0040,0254) 2 ;‘;(;;ESS Description or <zero
Performed Procedure Type Description (0040,0255) 2 <zero length>
Procedure Code Sequence (0008,1032) 2 ir:):;eRreoqltéi;ttehd:rocedure Code
>Code Value (0008,0100) 1C
>Coding Scheme Designator (0008,0102) 1C
>Coding Scheme Version (0008,0103) 3
>Code Meaning (0008,0104) 3
Performed Procedure Step End Date (0040,0250) 2 <zero length>
Performed Procedure Step End Time (0040,0251) 2 <zero length>
(Sifen;?ents on the Performed Procedure (0040,0280) 3 <zero length>
Image Acquisition Results
Modality (0008,0060) 1 XA
Study ID (0020,0010) 5 Z:(;rantgdequested Procedure ID or
Performed Protocol Code Sequence (0040,0260) 2 ];ré)qnl]jrf?:gl:ljgesgﬂgoncg,:h?de
>Code Value (0008,0100) 1C
>Coding Scheme Designator (0008,0102) 1C
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Attribute Name Tag Type Value
>Coding Scheme Version (0008,0103) 3
>Code Meaning (0008,0104) 3
Performed Series Sequence (0040,0340) 2
>Performing Physician’s Name (0008,1050) 2C from MWL or user input
>Operator's Name (0008,1070) 2C User input
>Series Instance UID (0020,000E) 1C created
>Series Description (0008,103E) 2C <zero length>
>Retrieve AE Title (0008,0054) 2C <zero length>
>Protocol Name (0018,1030) 1C from organ program
>Referenced Image Sequence (0008,1140) 2C <zero length>
>Referenced Non-Image Composite SOP In- (0040,0220) 2C <zero length>
stance Sequence
Radiation Dose
ggz;c](zr:ic Structure, Space or Region Se- (0008,2229) 3 <zero length>
Total Time of Fluoroscopy (0040,0300) 3 <zero length>
Total Number of Exposures (0040,0301) 3 <zero length>
Distance Source to Detector (0018,1110) 3 <zero length>
Distance Source to Entrance (0040,0306) 3 <zero length>
Entrance Dose (0040,0302) 3 <zero length>
Entrance Dose in mGy (0040,8302) 3 <zero length>
Exposed Area (0040,0303) 3 <zero length>
Image and Fluoroscopy Area Dose Product (0018,115E) 3 <zero length>
Comments on Radiation Dose (0040,0310) 3 <zero length>
Exposure Dose Sequence (0040,030E) 3 <zero length>
Billing and Material Management Code
Billing Procedure Step Sequence (0040,0320) 3 <zero length>
Film Consumption Sequence (0040,0321) 3
>Number of Films (2100,0170) 3 <zero length>
>Medium Type (2000,0030) 3 <zero length>
>Film Size ID (2010,0050) 3 <zero length>
Billing Supplies and Devices Sequence (0040,0324) 3
>Billing Item Sequence (0040,0296) 3 <zero length>
>Quantity Sequence (0040,0293) 3
>>Quantity (0040,0294) 3 <zero length>
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Attribute Name

Tag

Type

Value

>>Measuring Units Sequence

(0040,0295)

<zero length>

=  The Performed Procedure Step SCU interprets the following N-CREATE status codes:

Table 49 - Status Codes "Patient Registered"

Service Status Meaning Error Codes
Processing Failure 0110
No such attribute 0105
Invalid attribute value 0106
Duplicate SOP Instance 0111
No such SOP Instance 0112

Failure
No such SOP Class 0118
Class Instance conflict 0119
Missing attribute 0120
Missing attribute value 0121
Resource limitation 0213

Success MPPS Instance created 0000

4.2.8.3.2 Activity - MPPS Update
4.2.8.3.2.1 Description and Sequencing of Activity

With the MPPS Ul the status of the MPPS Instance can be set to “COMPLETED” or “DISCONTINUED". During performance
of the procedure the status will remain “IN PROGRESS".

4.2.8.3.2.2 Proposed Presentation Context

For "MPPS Update" the same Presentation Contexts as with “Patient registered” are proposed. Please see related table in

section 4.2.8.3.1.2.

4.2.8.3.2.3 SOP Specific Conformance

= Attributes for the Performed procedure Step N-SET

The Siemens ARTIS one DICOM Modality Performed Procedure Step SCU informs the remote SCP about the performed
examination and its status. The N-SET message is sent after each acquisition (status "IN PROGRESS") and per finished

examination (finished status “COMPLETED", or incomplete status “DISCONTINUED"). The following table describes the
supported attributes of an N-SET message.
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Table 50 - Performed Procedure Step N-SET Attributes

Attribute Name Tag Type Value
Performed Procedure Step Information
"IN PROGRESS" during procedure,
Performed Procedure Step Status (0040,0252) 3 “COMPLETED” or “DISCONTINUED”
for final N-SET
Performed Procedure Step Description (0040,0254) 3 ];j)tm SPS Description or user in-
Procedure Code Sequence (0008,1032) 3 from Requested Procedure
>Code Value (0008,0100) 1C
>Coding Scheme Designator (0008,0102) 1C
>Coding Scheme Version (0008,0103) 3
>Code Meaning (0008,0104) 3
Performed Procedure Step End Date (0040,0250) 1 created
Performed Procedure Step End Time (0040,0251) 1 created
gtoen;;nents on the Performed Procedure (0040,0280) 3 user input
Image Acquisition Results
Performed Protocol Code Sequence (0040,0260) 3 ;r:)g:]cs.gheduled Protocol Code Se-
>Code Value (0008,0100) 1C
>Coding Scheme Designator (0008,0102) 1C
>Coding Scheme Version (0008,0103) 3
>Code Meaning (0008,0104) 3
Performed Series Sequence (0040,0340) 1
>Performing Physician’s Name (0008,1050) 2C from MWL or user input
>Protocol Name (0018,1030) 1C from related SOP Instance
>Operator's Name (0008,1070) 2C user input
>Series Instance UID (0020,000E) 1C from related SOP Instance
>Series Description (0008,103E) 2C from related SOP Instance
>Retrieve AE Title (0008,0054) 2C
>Referenced Image Sequence (0008,1140) 2C series mateq °0P
Instances as items
>>Referenced SOP Class UID (0008,1150) 1C
>>Referenced SOP Instance UID (0008,1155) 1C
>Referenced Standalone SOP Instance Se- (0040,0220) 2 <zero length>

quence

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11

59 of 154




Attribute Name Tag Type Value

Radiation Dose

Total Time of Fluoroscopy (0040,0300) 3

Total Number of Exposures (0040,0301) 3

Entrance Dose in mGy (0040,8302) 3 ig;t?;u!?(:gd over complete pro-

Image and Fluoroscopy Area Dose Product (0018,115E) 3 sgzl:rrr;uslsggd(ﬁé/;ig;r;ﬂ)plete pro-

Exposure Dose Sequence (0040,030E) 3 (()ancgtjirgtlig;e;cﬁljgraod)iation event

>Radiation Mode (0018,115A) 3 "PULSED"

>KVP (0018,0060) 3 peak KV used for this event (KV)

>X-ray Tube Current in A (0018,8151) 3 tube current used for this event

>Exposure Time (0018,1150) 3 time of x-ray in ms for this event
additional acquisition specific in-

>Comments on Radiation Dose (0040,0310) 3 onr:an;TZ’triggu(cEtr,];?;acyeFDiIEc)Zf,I (5[2.5()5
as text

Comments on Radiation Dose (0040,0310) 3 user input

Billing and Material Management Code

Film Consumption Sequence (0040,0321) 3

>Number of Films (2100,0170) 3

>Medium Type (2000,0030) 3

>Film Size ID (2010,0050) 3
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= The Performed Procedure Step SCU interprets the following N-SET status codes:

Table 51 - Status Codes "MPPS Update"

Service Status Meaning Error Codes
Processing Failure: Performed Procedure Step Object may no
longer be updated. 0110
No such attribute 0105
Invalid attribute value 0106
No such SOP Instance 0112

Failure Invalid Object instance 0117
No such SOP Class 0118
Class Instance conflict 0119
Missing attribute value 0121
Resource limitation 0213

Success MPPS Instance set 0000

=  Handling of Performed Procedure Step ID in case
= MPPS is not configured or
= Unscheduled case

The attribute “Performed Procedure Step ID” (0040,0253) will be encoded based on "YYYYMMDDHHMMSS". This date
and time are based on the time when the first image is acquired.

4.2.8.4 Association Acceptance Policy

4.3 Network Interfaces

4.3.1 Physical Network Interface

The DICOM Interface of the ARTIS one provides DICOM TCP/IP Network Communication Support and uses the TCP/IP pro-
tocol stack from the operating system. It uses the MergeCOM subroutine library. All available Ethernet interfaces are
supported.

4.3.2 Additional Protocols
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4.4  Configuration

4.4.1 AE Title/Presentation Address Mapping

Local AE Titles

According to the DICOM Standard, the AET string can be up to 16 characters long and must not contain any extended
characters, only 7-bit ASCII characters (excluding Control Characters).

Note: The current implementation of syngo does not allow Spaces and special characters (like &<>") in the AE title
string.

Change of the default AE Titles chosen by the system can be performed in the Service Ul under “Configuration / DICOM |
General” item - first page.

Table 52 - Default AET Characteristics

Application Entity Default AE Title TCP/IP Port
Verification SCU -

L. 104 (fixed)

Verification SCP 2762 (TLS)
Storage SCU -

STU_<hostname> 104 (fixed)

Storage SCP 2762 (TLS)
Query/Retrieve SCU -

. 104 (fixed)
Query/Retrieve SCP 2762 (TLS)
Print SCU PRI_<hostname> -
Worklist SCU -

HRI_<hostname>
MPPS SCU - -

Remote AE Titles

When "trusted host functionality" is enabled, all external AE Titles have to be configured to be able to communicate with
ARTIS one.

For each remote AE the following data and capabilities can be configured:

Table 53 - Remote AE Configuration Items

Remote AE Configuration

Comment
Item

As defined in the network domain. This has to be configured also for

Host Name any DICOM AE that wishes to connect to SCP services of ARTIS one.

As defined in the network domain. This has to be configured also for

TCPIIP address any DICOM AE that wishes to connect to SCP services of ARTIS one.

. Name for the AE used in the user interfaces of the ARTIS one applica-
Logical Name

tions.
AE Title AET, as provided by network administration
Port Number Port Number, as provided by network administration

If Storage Service support is checked

Transfer Syntax Selection of uncompressed transfer Syntaxes supported by remote AE

Compression Selection of additional compression Syntaxes supported for remote AE
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Remote AE Configuration
Item

Comment

Default Node

“first default”/"second default”/["no default”] - activating this feature will
show “Send to <logical name>" in the Transfer tool menu for quick ac-
cess.

Preference Node

When checked, the remote AE will be assigned to a keyboard shortcut
key.

Archive Node

When checked, sending to remote AET will set status of a(rchived), else
s(ent) is indicated.

Default Archive

When checked, the remote AE will be listed as default archive in User
interfaces.

Graphics in Pixel Data

When checked, the DICOM overlay will not be encoded in attribute
(60xx,3000) Overlay Data, but masked in the “unused bits” of the pixel
data (only for uncompressed transfer syntaxes). For backwards compat-
ibility with legacy AE.

Select SC node

Select a previously configured node as target for Storage Commitment
when sending DICOM objects to the configured AE. Default is the same
node as to which the Objects are sent.

Select SC AET

Select AET that corresponds to the above selected node that receives
the Storage Commitment request. Default is the above specified “AE Ti-
tle”.

SC Result in same associa-
tion

When checked the ARTIS one DICOM application will await the Storage
Commitment N-EVENT-REPORT on the same association. Default is “not
checked” (= different association).

SC result timeout

Timeout in hours and minutes to wait at the open association. Default:
01:00 (hours:minutes).

If Storage Commitment Service support is checked

The related Storage Commitment configuration is either in the Storage
section of the same AET or different AET (in case the current AET is only
Storage Commitment Provider).

If Query Service support is checked

provides DICOM Query
model

The Query models supported by this AET can be selected. When possi-
ble, the STUDY ROOT model should preferably be configured

If Retrieve Service support is

checked

Checking Retrieve support for an AET is the only needed configuration
item. This will allow access to the “Import” feature in the Query result
browser.

If Modality Worklist Service

support is checked

Query Waiting time

The time to wait for the C-FIND-RSP after sending the C-FIND-RQ (de-
fault 20 sec.)

Max Query Match Number

The maximum number of entries accepted in one worklist (default is
200)

Query Interval

The time between two C-FIND-RQ to the Hospital Information system
(default is 60 min, minimum is 3 min, maximum is 1440 min i.e. 24
hours)

Automatic removal of can-
celed/rescheduled Requests

Checking this item will remove all unused entries from the scheduler
list prior to inserting the worklist responses with each query.

General

Trusted Host

When checked, association is only accepted when pair of AET and

TCP/IP address is known in the configuration.
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4.4.2 Parameters

System parameters can be changed in the Service Ul under “Configuration / DICOM / General” item - second page.

Table 54 - General parameter settings and timeouts

Time-out Values

Default -
Min Max
Parameter Value Comment
[sec] [sec]
[sec]
. I i Wait for an Association Request or wait
Accepting/Rejecting an Association Request 60 15 600 for a Peer to shut down the Association
Association Open Request 60 15 600 Wait for a reply to an Association Ac-
cept Request

Association Close Request 60 15 600 Wait for a reply to an Association Re-
lease Request

Accepting a Message over Network 60 15 600 Wait for a Network Write to be ac-
cepted

Waiting for Data between TCP/IP Packets 60 15 600 Wait for Data between TCP/IP packets

Response from Remote Node for Stor- Time between Service Request and Ser-

. 600 15 600 .
age/Query/Retrieve vice Response
Accept network connect 60 15 600
General Transfer Setting

Simultaneous DICOM associations 10 1 10 Numper of simultaneous associations
running.
Proposed PDU size, each selectable
value is doubled from previous, starting

Maximum PDU Size 512 KB 4 KB 1 MB with 4 KB. Additionally, for optimiza-
tion for some networks 28 KB are pro-
vided.
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5 Media Interchange

5.1 Implementation Model

5.1.1 Application Data Flow Diagram

DICOM Standard Interface

ecccee

Display Di- FSC . -
rectory .
e
i FSR :
Write @ F--------
Image :
ARTIS one :
AE s :
Read i FSC : ' )
________ >
Image : l
e
FSR : cD/
DVD

eeccccccccccccse

Figure 3: Media Interchange Application Data Flow Diagram

The ARTIS one provides the functionality to Import or Export DICOM Instances from and to the File System. During ex-
port, a DICOMDIR may also be generated (user selection). A complete I1SO Image ready-to-burn can also be generated.
All SOP Classes defined in Table 1are supported for the Import/Export functionality.
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5.1.2 Functional definitions of AEs

The ARTIS one application is capable of

e creating a new File-set in the File System (Export to ...)
e importing SOP Instances from the medium onto local storage

e writing the File-sets DICOMDIR information into the file system and joining it to an ISO image.

5.1.3 Sequencing of Real-World Activities

Whenever data is written to an external media, ARTIS one creates a DICOMDIR from the selected data and creates an ISO
image of the selected data on the local hard disk. Depending on the selected data and options (selected media size, with
or without compression) either General Purpose CD profile or DVD-J2K profile are used.

DVD, USB or CD ARTIS one

Select data

and options

Create DICOMDIR and
images as ISO file <

Write media
Display Content of media
| File System;

Trigger Import Request

A

v

Import images into local DB

Update Browser content

Figure 4: Sequence diagram — Media creation

5.1.4 File Meta Information for Implementation Class and Version

This section describes the values assigned to the File Meta Information attributes (see part PS 3.10) that pertain to the
Implementation Class and Version. The implementation Class UID and the Implementation Version name in the File
Meta Header are the same as the values specified for networking.
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Table 55: Implementation Class/Version Name - Media Interchange

File Meta Information Version 0001
Implementation Class UID 1.3.12.2.1107.5.4
Implementation Version Name " SIEMENS_EAS VA10"

5.2 AE Specifications

5.2.1 Media Storage AE — Specification

The ARTIS one provides conformance to the following Application Profiles as an FSC as well as an FSR. The FSU role is
only supported only on a non-optical storage device (e.g. USB stick).

Table 56: Media - Application Profiles and Real-World Activities

Application Profiles Supported Real-World Activity Role Serg;:iocr:ass

STD-GEN-CD

Browse Directory Information FSRESC
STD-GEN-DVD Import into Application FSU’ ! Interchange
Export to local Archive Media

STD-GEN-DVD-JPEG

5.2.1.1 Real-World Activities

5.2.1.1.1 Activity “Browse Directory Information”

The ARTIS one acts as FSR using the interchange option when requested to read the media directory.

The ARTIS one will read the DICOMDIR and insert those directory entries that are valid for the application profiles sup-
ported, into a local database. The database then is used for browsing media contents.

Note: The “Icon Image Sequence” is also supported in DICOMDIR. But only those Icon Images with “Bits Allocated”
(0028,0100) equal to 8 and size of 64x64 or 128x128 pixels are imported into database and are visible in the Browser.

5.2.1.1.2 Real World Activity “Import into Application”
The ARTIS one application acts as FSR using the interchange option when requested to read SOP Instances from the me-
dium into the application.

The SOP Instance selected from the media directory will be copied into the running Application. Only SOP Instances, that
are valid for the application profile supported and supported by ARTIS one, can be retrieved from media.

5.2.1.1.3 Real-World Activity “Export to local Archive Media”

The ARTIS one application acts as FSU (for media with existing DICOM file-set) or FSC (media not initialized) using the
interchange option when requested to copy SOP Instances from the local storage to local Archive Medium. The activity
as FSU is only possible as long as the local burning SW of ARTIS one has not already processed the generated ISO file.

The ARTIS one application will receive a list of SOP Instances to be copied to the local archive medium. Depending on the
profile selected (Standard: uncompressed, with DICOMDIR; Patient: compressed with DICOMDIR) the SOP Instances will
be taken, and an ISO file is being generated that includes the DICOMDIR and the corresponding objects.

It is then up to ARTIS one local configuration (if equipped with a local media burner) to burn the ISO file to the appropri-
ate media.
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5.2.1.2 SOP Classes and Transfer Syntaxes

These Application Profiles are based on the Media Storage Service Class with the Interchange Option. The ARTIS one
provides Standard Conformance to the SOP Classes listed in “Table 1: Network Services” section "SOP Classes Created by
the ARTIS one" and "SOP Classes Managed by the ARTIS one" in the “Conformance Statement Overview".

Using the Application Profiles supporting compression (STD-GEN-xxx) the following Transfer Syntaxes are supported:

Table 57: Transfer Syntaxes for STD-GEN-xxx

UID value Transfer Syntax OTjZ%fs
1.2.840.10008.1.2.1 Explicit Value Representation Little Endian native yes
1.2.840.10008.1.2.4.50 JPEG Baseline (Process 1) lossy compressed yes
1.2.840.10008.1.2.4.51 JPEG Extended (Process 2 & 4) lossy compressed yes
12s0to00e 2470 | peleee Nermemac) SO e |

5.3  Augmented and Private Application Profiles

5.4  Media Configuration

5.4.1 Single- / Multi-Session CD burning

Please refer to most recent Service / Configuration documentation of ARTIS one for changing between the single-session
and multi-session recording modes.

5.4.2 “Viewer on CD”

Please refer to most recent Service / Configuration documentation of ARTIS one for changing between the
ACOM.PC Lite 2.0 or syngo FastView

as application that is included onto the medium as part of the “Viewer on CD” feature, if the feature is checked in the
Media Creation user interface (see also next configuration item).

5.4.3 Auto-Labeling

Please refer to most recent Service | Configuration documentation of ARTIS one for activating the auto-labeling of CD
media to avoid the label inquiry dialog when using automatic media export. The auto-labeling can be activated with the
“Viewer on CD" feature being implicitly checked or not.
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6

Support of Extended Character Sets

The ARTIS one DICOM application supports the following character sets as defined in the four tables below:

Table 58: Single-Byte Character Sets without Code Extension

Character Set Descrip-

Defined Term

ISO registration

Character Set

tion number

Default repertoire none ISO_IR6 ISO 646:

Latin alphabet No. 1 ISO_IR 100 ISO_IR 100 Supplementary set
ISO_IR 6 ISO 646:

Latin alphabet No. 2 ISO_IR 101 ISO_IR 101 Supplementary set
ISO_IR 6 ISO 646

Latin alphabet No. 3 ISO_IR 109 ISO_IR 109 Supplementary set
ISO_IR 6 ISO 646

Latin alphabet No.4  |ISO_IR110 ISO_IR 110 Supplementary set
ISO_IR 6 ISO 646

Cyrillic ISO_IR 144 ISO_IR 144 Supplementary set
ISO_IR6 ISO 646

Arabic ISO_IR 127 ISO_IR 127 Supplementary set
ISO_IR 6 ISO 646

Greek ISO_IR 126 ISO_IR 126 Supplementary set
ISO_IR 6 ISO 646

Hebrew ISO_IR 138 ISO_IR 138 Supplementary set
ISO_IR6 ISO 646

Latin alphabet No. 5 ISO_IR 148 ISO_IR 148 Supplementary set
ISO_IR 6 ISO 646

Japanese ISO_IR13 ISO_IR13 JIS X 0201: Katakana
ISO_IR 14 JIS X 0201: Romaji
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Table 59: Single-Byte Characters Sets with Code Extension

Character Set De- Defined Term Standard for ESC sequence |(ISO registra- Character Set
scription Code Extension tion number
Default repertoire ISO 2022 IR 6 ISO 2022 ESC 02/08 04/02 ISO-IR 6 ISO 646
Latin alphabet No.1  |ISO 2022 IR 100 ISO 2022 ESC 02/13 04/01 ISO-IR 100  |Supplementary set
ISO 2022 ESC 02/08 04/02 ISO-IR 6 ISO 646
Latin alphabet No.2  [ISO 2022 IR 101 ISO 2022 ESC 02/13 04/02 ISO-IR 101  |Supplementary set
ISO 2022 ESC 02/08 04/02 ISO-IR 6 ISO 646
Latin alphabet No.3  |ISO 2022 IR 109 ISO 2022 ESC02/13 04/03 ISO-IR 109  |Supplementary set
I1ISO 2022 ESC 02/08 04/02 ISO-IR 6 ISO 646
Latin alphabet No.4 ISO 2022 IR 110 1ISO 2022 ESC 02/13 04/04 1ISO-IR 110 Supplementary set
I1ISO 2022 ESC 02/08 04/02 ISO-IR 6 ISO 646

Multi-Byte Character Sets without Code Extension

Table 60: Multi-Byte Character Sets without Code Extension

Character Set De- Defined Term ISO registration num- Character Set
scription ber
Unicode ISO_IR 192 ISO 10646 Unicode in UTF-8
Chinese GB18030 GB18030 GB 18030-2000 (China Association for
Standardization)

Table 61: Multi-Byte Character Sets with Code Extension

Character Set De- Defined Term Standard for | ESC sequence |ISOregistra-| Character Set

scription Code Exten- tion number
sion
Japanese ISO 2022 IR 87 ISO 2022 ESC 02/04 04/02  |ISO-IR 87 JIS X 0208: Kanji

ISO 2022 IR 159 ISO 2022 ESC02/04 02/08  |ISO-IR 159  JISX 0212: Supple-
04/04 mentary Kanji set

Chinese8 ISO 2022 IR 58 1ISO 2022 ESC 02/04 04/01 ISO-IR 58 GB2312-80 (China
Association for
Standardization)

All Special Character Sets (SCS) listed above are supported for incoming Data. When creating new Instances, the system
will use the default SCS (or SCS List) configured on the machine.

8 Note: This Character Set is an extension of DICOM for the Chinese language.
© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11 70 of 154



When there is a mismatch between the given character set in attribute (0008,0005) and the characters in an 10D re-
ceived by the system, then the following measures are taken to make the characters DICOM conform:

e Convert each illegal character toa 7'

There are three categories of character sets which have to be differentiated because of their different encoding formats:

e Conventional ISO character sets: ISO_IR 6, ISO 2022 IR 6, ISO_IR 100, etc.
- encoded in ISO 2022

e ISO_IR192 - encoded in UTF-8
e GB18030 - encoded in GB18030

It is not possible to recognize the following mismatches automatically on receiving or importing:

e An attribute value is encoded in ISO_IR 192 <- (0008,0005) contains a conventional ISO character set as pri-
mary character set

e An attribute value is encoded in GB18030 <-> (0008,0005) contains a conventional ISO character set as pri-
mary character set

e An attribute value is encoded in 1ISO 2022 <-> (0008,0005) contains ISO_IR 192
e An attribute value is encoded in ISO 2022 €<-> (0008,0005) contains GB18030

An 10D that contains one of the above-mentioned inconsistencies is not DICOM conform. As these kinds of inconsisten-
cies cannot be recognized by the system, the 10D will not be rejected but the character data might be corrupted.

The ARTIS one supports Kanji characters in the byte zones after 74 (79, 7A, 7B and 7C).
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7 Security

7.1  Security Profile

The ARTIS one DICOM application conforms to the IHE Basic Security Integration Profile that is used for the DICOM Com-
munication.

It allows the use of either a conventional (non-secure) DICOM communication or a secure DICOM communication. For
secure DICOM communication the application uses Transport Layer Protocol (TLS v1.1 and TLS v1.2). Following features
are supported for the secure DICOM communication. The port in which the application acts as SCP for secure DICOM

communication is 2762 (fixed). The port in which the application acts as SCP for unsecure DICOM communication is 104
(fixed).

The following security profile are done in ARTIS one DICOM application using TLS protocols
e Secure authentication of node
e Integrity and confidentiality of transmitted data.

e Generation of audit trail records access control and user authentication.

7.1.1  Security Transport Connection Profiles

The ARTIS one DICOM application conforms to the Basic TLS Transport Connection Profile.

The ARTIS one DICOM application initiates the TLS connections and accepts TLS connections with Storage commitment.
It provides a configuration panel by which local systems can configure the certificate that needs to bind for DICOM com-
munication. Secure communication is a “mode of operation” supported by the implementation of the DICOM Basic TLS
Secure Transport Connection Profile. This functionality will be used by the nodes that can authenticate each other be-
fore they exchange DICOM information. For secure communication the TLS protocol is used which provides message
authentication, integrity and confidentiality. The application supports the following protocol versions TLS Protocol v1.1
and v1.2.

The ARTIS one DICOM application supports X.509 certificates. The type of X.509 certificates that are supported are:
1) Self-Signed certificate
2) Certificate for which chain building (Trusted chain building, Trusted CA) is possible.

The following TLS certification checks will be done (TLS Handshake). The machine (either server or client) that will send
its certificate will :

e Choose the certificate according to Common Name (CN), if the local self-signed is used. If customer specific
certificate needs to be used then Serial Number of the certificate is used for choosing the certificate.

The server verifies
e that the client certificate is X.509 certificate which in not tampered with
e that the client certificate is in the list of trusted certificates (Trust Chain Building)
e that the client certificate is not in the revoked list.

e that the client certificate is not expired (present time is between “Valid From” and “Valid To" fields of X.509
certificate)

e that the client certificate has the correct purpose (at least the client authentication purpose).
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The client verifies
e that the server certificate is a X.509 certificate which is not tampered with
e that the server certificate is in the list of trusted certificates (Trust Chain Building)
e that the server certificate is not in the revoked list.

e that the server certificate is not expired (present time is between “Valid From” and “Valid To” fields of X.509
certificate)

e that the server certificate has the correct purpose (at least the server authentication purpose).
In addition, the following validation is done:

1) ‘Direct certificate validation’ for self-signed certificate, i. e. the self-signed certificate of the remote node must be
present in the ‘Trusted Root Certificate’ StoreCertificate received from peer have multiple X.509 certificates within
the TLS Handshake.

2) ARTIS one DICOM application can receive X.509 certificate chain(Full certificate chain, Partial certificate chain or only
End certificate) in the TLS handshake from peer. For all the cases for successful Trust chain Building all the certificates
shall be installed in the Windows certificate Store of the Local Machine. i.e. All The intermediate must be imported to

Intermediate Certificate Authorities>Certificates and the root certificate must be imported to the Trusted Root Certif-
icates - Certificates.

The X.509 certificate imported and used for DICOM communication
1) must have purpose set for Client and Server Authentication.
2) must be exportable to generate the certificate file and private key file.

If intermediate and root X.509 certificates are present then the intermediate certificate must be imported to Intermediate
Certificate Authorities - Certificates. The root certificate must be imported to the Trusted Root Certificates - Certificates.

The ARTIS one DICOM application communicates with either of the following Cipher suites for encrypting the data send
across the network.

TLS_RSA_WITH_AES_128 CBC_SHA
TLS_RSA_WITH_3DES_EDE_CBC_SHA

Note: Support for NULL Cipher (TLS_RSA_WITH_NULL_SHA) is not there. The secure communication is FIPS mode enabled

client_helic

senser_helko

certficate

certficate_reguest

server_helio_done

A A 4

certficate

client_key__exchange

certficate_werify

change_cipher_spec
Finished

change_cipher_spec

Tinis he-d

Figure 5: TLS Handshake Message Protocol
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7.2  Application Level Confidentiality Profile

Application Level Confidentiality Profiles address the following aspects of security Data Confidentiality at the application
layer.

These Profiles are targeted toward creating a special purpose, de-identified version of an already existing Data Set. This
profile is not intended to replace the original SOP Instance from which the de-identified SOP Instance is created. The de-
identified SOP Instances are useful, for example, in creating teaching or research files, performing clinical trials, or sub-
mission to registries where the identity of the patient and other individuals is required to be protected.

7.2.1 Anonymization workflow (De-identifier)

syngo provides a functionality to export the DICOM data to configured offline directories (Local Path / Network path /
USB). The data exported can be exported anonymous where the Patient Identification parameters like Patient Name,
Patient ID etc., are removed or replaced as per the table below.

Table 62: Application Level Confidentiality Profile attributes (standard tags)

DICOM Tag Attribute Name Anonymized
(0002,0003) Media Storage SOP Instance UID Yes
(0008,0014) Instance Creator UID Yes
(0008,0018) SOP Instance UID Yes
(0008,0050) Accession Number Yes
(0008,0080) Institution Name Yes
(0008,0081) Institution Address Yes
(0008,0090) Referring Physician’s Name Yes
(0008,0092) Referring Physician's Address Yes
(0008,0094) Referring Physician's Telephone Numbers Yes
(0008,1010) Station Name Yes
(0008,1030) Study Description Yes
(0008,103E) Series Description Yes
(0008,1040) Institutional Department Name Yes
(0008,1048) Physician(s) of Record Yes
(0008,1050) Performing Physicians’ Name Yes
(0008,1060) Name of Physician(s) Reading Study Yes
(0008,1070) Operators’ Name Yes
(0008,1080) Admitting Diagnoses Description Yes
(0008,1120) Referenced Patient Sequence Yes
(0008,1155) Referenced SOP Instance UID Yes
(0008,1250) Related Series Sequence Yes
(0008,2111) Derivation Description Yes
(0010,0010) Patient's Name Yes
(0010,0020) Patient ID Yes
(0010,0030) Patient’s Birth Date Yes
(0010,0032) Patient's Birth Time Yes
(0010,0040) Patient’s Sex Yes
(0010,1000) Other Patient IDs Yes
(0010,1001) Other Patient Names Yes
(0010,1005) Patient's Birth Name Yes
(0010,1010) Patient's Age Yes

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11

74 of 154



DICOM Tag Attribute Name Anonymized
(0010,1020) Patient’s Size Yes
(0010,1030) Patient’s Weight Yes
(0010,1040) Patient Address Yes
(0010,1060) Patient's Mother's Birth Name Yes
(0010,1090) Medical Record Locator Yes
(0010,2154) Patient’s Telephone Numbers Yes
(0010,2160) Ethnic Group Yes
(0010,2180) Occupation Yes
(0010,21B0) Additional Patient’s History Yes
(0010,4000) Patient Comments Yes
(0018,1000) Device Serial Number Yes
(0018,1030) Protocol Name Yes
(0020,000D) Study Instance UID Yes
(0020,000E) Series Instance UID Yes
(0020,0010) Study ID Yes
(0020,0052) Frame of Reference UID Yes
(0020,0200) Synchronization Frame of Reference UID Yes
(0020,4000) Image Comments Yes
(0040,0275) Request Attributes Sequence Yes
(0040,A124) uiD Yes
(0040,A730) Content Sequence Yes
(0088,0140) Storage Media File-set UID Yes
(3006,0024) Referenced Frame of Reference UID Yes
(3006,00C2) Related Frame of Reference UID Yes
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8 Annexes

8.1 10D Contents

8.1.1 Created SOP Instances

8.1.1.1 X-Ray Angiographic Image Standard Extended SOP Class

The ARTIS one system will create images during acquisition and with post processing applications. Those will be en-
coded as XA Standard Extended SOP Class. Images created during post processing will be marked as derived. Please see
the following table for a complete overview of supplied Type 1/2/3 Standard and additional Private Attributes:

The Standard DICOM Modules will be used to encode ECG data.

8.1.1.1.1 “Acquired Image” or derived XA image

Table 63 - XA acquired or derived image

Attribute Name Tag Value

Specific Character Set (0008,0005) | From Configuration / RIS

See “8.5.1.6 SOP Common Module - Image Type

Image Type

(0008,0008)

Extensions”

SOP Class UID

(0008,0016)

1.2.840.10008.5.1.4.1.1.12.1

SOP Instance UID

(0008,0018)

Study Date

(0008,0020)

<yyyymmdd>

Series Date

(0008,0021)

<yyyymmdd>

Acquisition Date

(0008,0022)

Date of Original Acquisition (X-Ray event)

Content Date

(0008,0023)

<yyyymmdd> (Date of pixel data creation)
Note: in Resize or Ready Process mode pixel
data is created at date of transfer

Study Time

(0008,0030)

<hhmmss>

Series Time

(0008,0031)

<hhmmss>

Acquisition Time

(0008,0032)

Time of Original Acquisition (X-Ray event)

Content Time

(0008,0033)

<hhmmss> (Time of pixel data creation)
Note: in Resize or Ready Process mode pixel
data is created at date of transfer

Accession Number

(0008,0050)

From RIS or “Accession No.” input

Modality

(0008,0060)

XA

Manufacturer

(0008,0070)

Siemens

Institution Name

(0008,0080)

From RIS or “Institution Name” input

Institution Address

(0008,0081)

From RIS or from configuration

Referring Physician's Name

(0008,0090)

From RIS or input

Station Name

(0008,1010)

From Configuration
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Attribute Name

Tag

Value

Study Description

(0008,1030)

From RIS or “Study” input

Procedure Code Sequence (0008,1032) | From RIS
>Code Value (0008,0100) | From RIS
>Coding Scheme Designator (0008,0102) | From RIS
>Code Meaning (0008,0104) | From RIS

Series Description

(0008,103E)

User input (Label), “Organ Program” name or
type of object, e.g.: Exam Protocol SR

Physicians of Record

(0008,1048)

From RIS (0040,1010) Names of Intended Recip-

ients of Results

Performing Physician's Name

(0008,1050)

From RIS or input

Operator's Name

(0008,1070)

“Operator 1"\"Operator 2" input

Admitting Diagnosis Description

(0008,1080)

From RIS or input

Manufacturer's Model Name (0008,1090) | AXIOM-Artis
Referenced Study Sequence (0008,1110) | From RIS
>Referenced SOP Class UID (0008,1150)

>Referenced SOP Instance UID (0008,1155)

Egge;rg:cc:d Performed Procedure Step (0008,1111)

>Referenced SOP Class UID (0008,1150)

>Referenced SOP Instance UID (0008,1155)

Referenced Patient Sequence (0008,1120) | From RIS

>Referenced SOP Class UID

(0008,1150)

>Referenced SOP Instance UID

(0008,1155)

Derivation Description

(0008,2111)

Notes about transformation steps

Start Trim

(0008,2142)

<1st frame to display>

Stop Trim

(0008,2143)

<last frame to display>

Recommended Display Frame Rate

(0008,2144)

(in fls)

Irradiation Event UID

(0008,3010)

Patient's Name

(0010,0010)

From RIS or input

Patient ID

(0010,0020)

From RIS or input

Issuer of Patient ID

(0010,0021)

From RIS

Patient's Birth Date

(0010,0030)

From RIS or input

Patient's Birth Time

(0010,0032)

From RIS

Patient's Sex

(0010,0040)

From RIS or input

Other Patient IDs (0010,1000) | From RIS
Other Patient Names (0010,1001) | From RIS
Other Patient IDs Sequence (0010,1002) | From RIS
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Attribute Name Tag Value
>Patient ID (0010,0020) | From RIS
>Issuer of Patient ID (0010,0021) | From RIS
>Type of Patient ID (0010,0022) | From RIS
Patient's Birth Name (0010,1005) | From RIS

Patient's Age

(0010,1010)

Calculated from “Date of Birth” input

Patient's Size

(0010,1020)

From RIS or input (in meters)

Patient's Weight

(0010,1030)

From RIS or input (in kilograms)

Patient’s Address

(0010,1040)

From RIS or input

Patient’s Mother’s Birth Name (0010,1060) | From RIS
Military Rank (0010,1080) | From RIS
Branch of Service (0010,1081) | From RIS
Medical Record Locator (0010,1090) | From RIS
Medical Alerts (0010,2000) | From RIS
Allergies (0010,2110) | From RIS
Country of Residence (0010,2150) | From RIS
Region of Residence (0010,2152) | From RIS
Ethnic Group (0010,2160) | From RIS
Occupation (0010,2180) | From RIS
Smoking Status (0010,21A0) | From RIS
Additional Patient History (0010,21B0) | From RIS
Pregnancy Status (0010,21C0O) | From RIS
Last Menstrual Date (0010,21D0) | From RIS
Patient’s Religious Preference (0010,21F0) | From RIS

Patient Comment

(0010,4000)

From RIS or “Patient Comment” input

Contrast/Bolus Agent

(0018,0010)

From organ program settings

Cine Rate

(0018,0040)

<acquired frame rate>

KVP

(0018,0060)

<peak KV used> (KV)

Device Serial Number

(0018,1000)

<modality serial number>

Software Versions

(0018,1020)

Protocol Name

(0018,1030)

“Organ Program” input

Contrast Bolus Ingredient

(0018,1048)

From organ program settings

Frame Time

(0018,1063)

(msec/frame) for special objects

Frame Time Vector

(0018,1065)

<number of Frame values>(msec)

Distance Source to Detector

(0018,1110)

Source Image Receptor Distance (SID) (mm)
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Attribute Name

Tag

Value

Distance Source to Patient

(0018,1111)

Source Object Distance (SOD) (mm)

From auto calibration or manual calibration

Estimated Radiographic Magnification
Factor

(0018,1114)

<Ratio of SID/SOD>

Exposure Time

(0018,1150)

<duration of x-Ray exposure>(msec)

X-Ray Tube Current

(0018,1151)

(mA)

Exposure in pAs

(0018,1153)

Average per frame value * number of frames

Average Pulse Width (0018,1154) | (msec)
Radiation Setting (0018,1155) |SC|GR
Radiation Mode (0018,115A) | PULSED
Image and Fluoroscopy Area Dose Prod- (0018,115E) | (dGy*cm*cm)

uct

Intensifier Size

(0018,1162)

<(zoomed) diameter> (mm)

Imager Pixel Spacing

(0018,1164)

(mm)

Focal Spots

(0018,1190)

(mm)

Positioner Motion

(0018,1500)

STATIC | DYNAMIC

Positioner Primary Angle

(0018,1510)

(degrees); 0 with DYNAMIC

Positioner Secondary Angle

(0018,1511)

(degrees); 0 with DYNAMIC

Positioner Primary Angle Increment

(0018,1520)

Only with DYNAMIC (absolute values)

Positioner Secondary Angle Increment

(0018,1521)

Only with DYNAMIC (absolute values)

Shutter Shape

(0018,1600)

RECTANGULAR

Shutter Left Vertical Edge

(0018,1602)

<column number left edge>

Shutter Right Vertical Edge

(0018,1604)

<column number right edge>

Shutter Upper Horizontal Edge

(0018,1606)

<row number upper edge>

Shutter Lower Horizontal Edge

(0018,1608)

<row number lower edge>

Collimator Shape

(0018,1700)

RECTANGULAR

Collimator Left Vertical Edge

(0018,1702)

<column number left edge>

Collimator Right Vertical Edge

(0018,1704)

<column number right edge>

Collimator Upper Horizontal Edge

(0018,1706)

<row number upper edge>

Collimator Lower Horizontal Edge

(0018,1708)

<row number lower edge>

Patient Position

(0018,5100)

Mandatory “Patient Position” input

Detector Description

(0018,7006)

Detector ID

(0018,700A)

Private Creator

(0019,00xx)

SIEMENS SMS-AX VIEW 1.0

Attributes according to "8.5.1.2 Angio Viewing Module"

Study Instance UID

(0020,000D)

From RIS or system generated
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Attribute Name

Tag

Value

Series Instance UID

(0020,000E)

Study ID

(0020,0010)

From RIS Requested Procedure ID or system cre-
ated

Series Number

(0020,0011)

Acquisition Number

(0020,0012)

Instance Number

(0020,0013)

Patient Orientation

(0020,0020)

calculated from "Patient Position" input and
from Gantry coordinate data.

Laterality

(0020,0060)

input via L or R marker annotation, else absent

Images in Acquisition

(0020,1002)

Image Comments

(0020,4000)

Not encoded or "SM" or "REF"

Private Creator

(0021,00xx)

SIEMENS SMS-AX ACQ 1.0

Attributes according to "8.5.1.3 Angio Acquisition Data Module"

Private Creator

(0023,00xx)

SIEMENS SMS-AX QUANT 1.0

Attributes according to "8.5.1.4 Angio Qu

antification Module" if image was calibrated

Private Creator

(0025,00xx)

SIEMENS SMS-AX ORIGINAL IMAGE INFO 1.0

Attributes according to "8.5.1.5 Original Image Info Module"

Samples per Pixel

(0028,0002)

1

Photometric Interpretation

(0028,0004)

MONOCHROME?2

Number of Frames

(0028,0008)

Frame Increment Pointer

(0028,0009)

(0018,1063) or (0018,1065)

Rows (0028,0010) |Up to 2480
Columns (0028,0011) |Up to 2480
Bits Allocated (0028,0100) (816

Bits Stored (0028,0101) |8]12]16

High Bit (0028,0102) [7]11]15

Pixel Representation (0028,0103) |0

Pixel Intensity Relationship (0028,1040) |LIN|LOG|DISP
Window Center (0028,1050) | <NAT value>
Window Width (0028,1051) | <NAT value>

VOI LUT Function

(0028,1056)

LINEAR | SIGMOID
not set means linear windowing

Recommended Viewing Mode

(0028,1090)

SUB | NAT

Lossy Image Compression

(0028,2110)

Modality LUT Sequence

(0028,3000)

(if [0028,1040] = LOG)
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Attribute Name

Tag

Value

>LUT Descriptor

(0028,3002)

<num of LUT entries>, <first pixel val mapped>,

<Entry bits alloc>

>Modality LUT Type

(0028,3004)

us

>LUT data

(0028,3006)

<array of data, accord. descriptor>

Representative Frame Number

(0028,6010)

<e.g. frame number of Icon Image>

Mask Subtraction Sequence

(0028,6100)

>Mask Operation (0028,6101) | AVG_SUB
>Mask Frame Numbers (0028,6110)
Private Creator (0029,00xx) | CARDIO-D.R. 1.0

Attributes according to "8.5.1.1 Edge Enhancement Module"

Private Creator

(0029,00xx)

SIEMENS MEDCOM HEADER

Private platform attributes

Study ID Issuer

(0032,0012)

internal study identifier

Requesting Physician (0032,1032) | From RIS
Requesting Service (0032,1033) | From RIS
Requested Procedure Description (0032,1060) | From RIS
Requested Procedure Code Sequence (0032,1064) | From RIS
>Code Value (0008,0100) | From RIS
>Coding Scheme Designator (0008,0102) | From RIS
>Coding Scheme Version (0008,0103) | From RIS
>Code Meaning (0008,0104) | From RIS

Study Comments

(0032,4000)

Patient Registration input

Admission 1D (0038,0010) | From RIS
Special Needs (0038,0050) | From RIS
Patient State (0038,0500) | From RIS
Current Patient Location (0038,0300) | From RIS
Performed Procedure Step Start Date (0040,0244)
Performed Procedure Step Start Time (0040,0245)
Performed Procedure Step ID (0040,0253)
Performed Procedure Step Description (0040,0254)
Request Attributes Sequence (0040,0275)
>Scheduled Procedure Step Description (0040,0007) | From RIS
>Scheduled Procedure Step ID (0040,0009) | From RIS

>Requested Procedure ID

(0040,1001)

From RIS or “Request ID” input

Confidentiality Constraint on Patient
Data Description

(0040,3001)

From RIS
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Attribute Name

Tag

Value

Private Creator

(2121,00xx)

PMI Private Calibration Module Version 2.0

Attributes according to "8.5.1.4 Angio Qu

antification Module" if image was calibrated

Curve Dimensions

(5000,0005)

2

Number of Points

(5000,0010)

<number of data points>

Type of Data

(5000,0020)

ECG

Axis Units

(5000,0030)

DPPS\NONE
(DPPS = data points per second)

Data Value Presentation (5000,0103) | 0000h
Curve Data Descriptor (5000,0110) |0O\1
Coordinate Start Value (5000,0112) |0

Coordinate Step Value

(5000,0114)

<sampling rate>

Curve Data

(5000,3000)

Overlay Rows

(60xx,0010)

Overlay Columns

(60xx,0011)

Number of Frames in Overlay (60xx,0015) | <number>
Overlay Description (60xx,0022)

Overlay Type (60xx,0040) |G

Overlay Origin (60xx,0050) | 1\1

Image Frame Origin (60xx,0051) |1

Overlay Bits Allocated (60xx,0100) |1or16

Overlay Bit Position

(60xx,0102)

12 or O (if Overlay encoded in [60xx,3000])

Overlay Data

(60xx,3000)

<contains Overlay>

Pixel Data

(7FEO,0010)

8.1.1.1.2 Quant Report Images - derived XA

The ARTIS one will generate result images from performing Quantitative Analysis Functions. To ensure image inter-
change, the resulting reports can be converted to standard XA multi-frame images. The pixel data contain the result
information as an image.

All patient level, study level and equipment information are taken from the acquired images of the related procedure.

Acquisition specific information (e.g. KVP, mA) is taken from the original image that was subject to the analysis. Not
applicable information is set either to default values or not set at all.

The overlay graphic and curve module are not used with Quant images.

Quant images are always sent as 1024x1024 12 bit. Multi-frames are used to support reports with multiple pages.
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8.1.1.1.3 Exam Protocol as XA Image
The ARTIS one will generate an X-Ray Radiation Dose SR object to store all dose and acquisition relevant information for
all irradiation events. An excerpt of this information is displayed to the user as "Exam Protocol". This displayed Exam Pro-
tocol can be converted to an XA multi-frame image. The pixel data contain the protocol data as an image.
All patient level, study level and equipment information are taken from the acquired images of the related procedure.

Acquisition specific information (e.g. KVP, mA) and further information is set either to default values (type 1), set to zero
length (type 2) or not set at all.

The overlay graphic and curve module are not used with Exam Protocol as XA image.

8.1.1.2 SR Document SOP Class

The ARTIS one will create an X-Ray Radiation Dose SR for each Study performed on the system. Please refer to next sec-
tions to learn about the SR implementation and the definition of the underlying SR template.

8.1.1.2.1 X-Ray Radiation Dose SR SOP Class

The ARTIS one will create X-Ray Radiation Dose SRs implementing TID 10001 Projection X-Ray Radiation Dose

For every single irradiation event an entry is made into the SR.
The scope of accumulation is "Study". Updating of a SR will not change the SOP Instance UID.

All patient level, study level and equipment information are taken from the acquired images of the related procedure.
Attribute mapping from Modality Worklist to X-Ray Radiation Dose SR is equal to the mapping into acquired images.
For details on the contents of the Accumulated X-Ray Dose Container (TID 10002), please see table below.

Table 64 - Details on Accumulated X-Ray Dose Data

Concept Name Comments on Concept Value

The accumulated dose area product (measured with dose chamber

Dose Area Product Total near collimator) applied during fluoro and acquisition [Gym?].

Calculated accumulated dose at the RP applied during fluoro and ac-

Dose (RP) Total quisition [Gy]. (Not corrected for backscatter)

Fluoro Dose Area Product Total The accumulated dose area product applied during fluoro [GymZ].
Fluoro Dose (RP) Total Calculated accumulated dose at the RP applied during fluoro [Gy].
Total Fluoro Time Total time of fluoro [s]. (pedal time)

The accumulated dose area product applied during acquisition

Acquisition Dose Area Product Total [Gym?2].

Calculated accumulated dose at the RP applied during acquisition

Acquisition Dose (RP) Total
q (RP) [Gy].

Total Acquisition Time Total time of acquisition [s]. (pedal time)

The Interventional Reference Point (IRP) for the system is always

Reference Point Definition “15cm from Isocenter toward Source”

For details on the contents of the Irradiation Event Container (TID 10003), please see table below (one container per
irradiation event).
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Table 65 - Details on Dose SR Irradiation Event Data

Concept Name Comments on Concept Value
Acquisition Plane “Single Plane”
DateTime Started Start of X-Ray

“Fluoroscopy” - irradiation applied by Fluoro pedal
“Stationary Acquisition” - irradiation applied by Acquisition pedal, no
system-controlled movement

Irradiation Event Type “Stepping Acquisition” - irradiation applied by Acquisition pedal, sys-
tem-controlled stepping movement

“Rotational Acquisition” - irradiation applied by Acquisition pedal, sys-
tem-controlled rotational movement

Acquisition Protocol Name of the organ program used to parameterize this irradiation

event
Patient Table Relationship “headfirst” or “feet-first”
Patient Orientation “recumbent”
Patient Orientation Modifier “supine”, “prone”, “right lateral decubitus” or “left lateral decubitus”

The Interventional Reference Point (IRP) for the system is always

Reference Point Definition “15cm from Isocenter toward Source”

Acquired Image SOP Instance UID of the acquired image as link to that image.

Irradiation Event UID UID identifying this event.

The dose area product (measured with dose chamber near collimator)

Dose Area Product applied by this irradiation event in [Gym?Z].

Patient Equivalent Thickness Equivalent water value of the patient/object [mm]

Dose (RP) Calculated dose at the RP in [Gy]. (Not corrected for backscatter)

Patient-based angle of the primary plane in [deg]. For “Rotational Ac-

Positioner Primary Angle quisition” this is the start position of the movement.

Patient-based angle of the secondary plane in [deg]. For “Rotational

Positioner Secondary Angle Acquisition” this is the start position of the movement.

Only with “Rotational Acquisition” - this is the primary plane end posi-

Positioner Primary End Angle tion of the movement.

Only with “Rotational Acquisition” - this is the secondary plane end

Positioner Secondary End Angle position of the movement.

Angle of the head-feet axis of the table relative to the horizontal
Table Head Tilt Angle plane. Positive values indicate that the head of the table is upwards
[deg].

Rotation of the table in the horizontal plane (clockwise when looking

Table Horizontal Rotation Angle from above the table) [deg].

Angle of the left-right axis of the table relative to the horizontal

Table Cradle Tilt Angle plane. Positive values indicate that the left of the table is upwards
[deg].

Collimated Field Area Collimated field area at detector plane in [m2].

Collimated Field Height Collimated field height at detector plane in [mm].

Collimated Field Width Collimated field width at detector plane in [mm].

X-Ray Filters A CONTAINER with the subsequent items marked with a “>"
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Concept Name

Comments on Concept Value

>X-Ray Filter Type

Either “No Filter” or “Flat filter” is set.

>X-Ray Filter Material

If filter is used, a value of “Copper or Copper Compound” is set.

>X-Ray Filter Thickness Minimum

Minimal thickness of the applied filter in [mm].

>X-Ray Filter Thickness Maximum

Maximal thickness of the applied filter in [mm]. ARTIS one uses uni-
form filter thickness, so this value always matches the minimal thick-
ness value.

Fluoro Mode

Only with “Fluoroscopy” - ARTIS one uses “Pulsed” Fluoroscopy only

Pulse Rate

The used pulse rate for this irradiation event in [pulse/s].

Number of Pulses

The number of X-Ray pulses generated during performance of this ir-
radiation event.

KVP

The mean-value for the voltage applied by this irradiation event in
[kV].

X-Ray Tube Current

The mean-value for the tube current applied by this irradiation event
in [mA].

Exposure Time

Time calculated according to the term “Number of Pulses” x “Average
Pulse Width". It is the “X-Ray on” time and not the “pedal time” for this
irradiation event [ms].

Pulse Width

The mean-value for the pulse width for each X-Ray pulse applied by
this irradiation event in [ms].

Irradiation Duration

Clock time from the start of loading time of the first pulse until the
loading time trailing edge of the final pulse in the same irradiation
event [s]

Exposure

Cumulative x-ray exposure value calculated according to the term “X-
Ray Tube Current” x “Exposure Time" in [pAs]

Focal Spot Size

Size of the focal spot in [mm] that was used during the performance
of this irradiation event.

Distance Source to Detector

The Source Image Distance (SID) as it is valid at the end of the irradia-
tion event in [mm].

Distance Source to Isocenter

The value of the Source to Isocenter distance in [mm].

Table Longitudinal Position

Table Longitudinal Position wrt isocenter. Table motion towards LAO
is positive assuming that the patient is positioned supine and its head
is in normal position [mm].

Value at start of irradiation event in case of table movement.

Table Lateral Position

Table Lateral Position wrt isocenter. Table motion towards CRA is pos-
itive assuming that the patient is positioned supine and its head is in
normal position [mm].

Value at start of irradiation event in case of table movement.

Table Height Position

Table Height Position wrt isocenter. Table motion downwards is posi-
tive [mm].
Value at start of irradiation event in case of table movement.

Table Longitudinal End Position

Table Longitudinal Position at end of irradiation event [mm].
Only set when table was moved during the event.

Table Lateral End Position

Table Lateral Position at end of irradiation event [mm].
Only set when table was moved during the event.
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Concept Name Comments on Concept Value

Table Height Position at end of irradiation event [mm].

Table Height End Position Only set when table was moved during the event.

The value of the Source to Reference Point (defined according to IEC

Distance Source to Reference Point 60601-2-43) distance in [mm].

Target Region Fixed value of “Entire body” is used.

Contains additional information items from the Exam Report in XML
Comment like structure. There are separate contents for “Fluoroscopy” or “Acqui-
sition”. For details see paragraph below this table.

. . The value of “Irradiating Device” is always set. The subsequent items
Device Role in Procedure . p_n s .
marked with a “>" give additional details.

Logical name of the device taken from site configuration. Is also used

>Device Name as Station Name (0008,1010) in DICOM Image Header.

The value of “Siemens” is always set. Is also used as Manufacturer

>Device Manufacturer (0008,0070) in DICOM Image Header.

The value of “AXIOM-Artis” is always set. Is also used as Manufac-

>Device Model Name turer's Model Name (0008,1090) in DICOM Image Header.

Serial number of the device taken from site configuration. Is also used

>Device Serial Number as Device Serial Number (0018,1000) in DICOM Image Header.

In case of “Fluoroscopy” the following XML structure is provided in the “Comment” Concept Value (the values are sample
values and will be individually set for each event):

<FluoroData>

<SceneCounter SRData="1"/>
<PeriDynaStepCount SRData=""/>
<SceneName SRData="FL xLow"/>
<AngulationStep SRData=""/>

<Dose SRData="0.010000"/>
<CurrentTimeProduct SRData="36.720005"/>
<TubeFocalSpot SRData="small"/>
<iiDiameter SRData="220"/>

<Time SRData="20-Sep-10 17:31:57"/>
<IsPuck SRData="False"/>

<SceneTime SRData="4"/>

<FrameRate SRData="7.500000"/>
<NumOfFrames SRData="30"/>
<MaxSkinEntranceDose SRData="0mGy"/>
</FluoroData>

In case of “Stationary Acquisition” or “Rotational Acquisition” the following XML structure is provided in the “Comment”
Concept Value (the values are sample values and will be individually set for each event):

<AcquisitionData>

<SceneCounter SRData="1"/>
<AcqMode SRData="CARD"/>
<PeriDynaStepCount SRData=""/>
<SceneName SRData="Coro RL"/>
<AcqType SRData="FIXED"/>
<AngulationStep SRData=""/>

<Dose SRData="0.070000"/>
<CurrentTimeProduct SRData="561.586121"/>
<TubeFocalSpot SRData="large"/>
<iiDiameter SRData="220"/>

<Time SRData="20-Sep-10 17:32:02"/>
<IsPuck SRData="False"/>
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<SceneTime SRData="9"/>

<FrameRate SRData="10.000000"/>
<NumOfFrames SRData="88"/>
<MaxSkinEntranceDose SRData="0mGy"/>
</AcquisitionData>

8.1.1.2.2 Comprehensive SR SOP Class

The ARTIS one will utilize the Comprehensive SR SOP Class to report measurements from the quantification application.
It is implementing TID 3202 Ventricular Analysis to create the SR.

All patient level, study level and equipment information are taken from the acquired images of the related procedure.

Attribute mapping from Modality Worklist to X-Ray Radiation Dose SR is equal to the mapping into acquired images.
Please refer to Table 44 - Basic Worklist C-FIND-RSP Return Key Attributes for mapping of worklist information.

8.1.2 Usage of attributes from received 10Ds

Please refer to the “SOP-specific conformance...” sections in the DICOM networking part of this DCS for more details on
attribute specific handling.

8.1.3  Attribute mapping

The ARTIS one implements an actor Acquisition Modality according to the IHE Scheduled Workflow (SWF) profile.

8.1.4 Coerced/Modified fields

The ARTIS one DICOM Application is not performing data coercion.

8.2  Data Dictionary of Private Attributes

The following table lists all private attributes created by ARTIS one which may be included in the generated instances.

Table 66: Private Data Element Dictionary

Tag Private Owner Code Name VR VM
(0019,xx00) | SIEMENS SMS-AX VIEW 1.0 Review Mode us 1
(0019,xx01) | SIEMENS SMS-AX VIEW 1.0 Anatomical Background Percent us 1
(0019,xx02) | SIEMENS SMS-AX VIEW 1.0 Number of Phases us 1
(0019,xx03) | SIEMENS SMS-AX VIEW 1.0 Apply Anatomical Background us 1
(0019,xx04) | SIEMENS SMS-AX VIEW 1.0 Pixel Shift Array SS 4-4n
(0019,xx05) | SIEMENS SMS-AX VIEW 1.0 Brightness us 1
(0019,xx06) | SIEMENS SMS-AX VIEW 1.0 Contrast us 1
(0019,xx07) | SIEMENS SMS-AX VIEW 1.0 Enabled Shutters us 1
(0019,xx08) | SIEMENS SMS-AX VIEW 1.0 Native Edge Enh. Percent Gain us 1
(0019,xx09) | SIEMENS SMS-AX VIEW 1.0 Native Edge Enh. LUT Index SS 1
(0019,xx0A) | SIEMENS SMS-AX VIEW 1.0 Native Edge Enh. Kernel Size SS 1
(0019,xx0B) | SIEMENS SMS-AX VIEW 1.0 Subtr. Edge Enh. Percent Gain us 1
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Tag Private Owner Code Name VR VM
(0019,xx0C) [ SIEMENS SMS-AX VIEW 1.0 Subtr. Edge Enh. LUT Index SS 1
(0019,xx0D) | SIEMENS SMS-AX VIEW 1.0 Subtr. Edge Enh. Kernel Size SS 1
(0019,xx0E) | SIEMENS SMS-AX VIEW 1.0 Fade Percent us 1
(0019,xx0F) | SIEMENS SMS-AX VIEW 1.0 Flipped before Laterality Applied us 1
(0019,xx10) | SIEMENS SMS-AX VIEW 1.0 Apply Fade us 1
(0019,xx12) | SIEMENS SMS-AX VIEW 1.0 Zoom us 1
(0019,xx13) | SIEMENS SMS-AX VIEW 1.0 Pan X SS 1
(0019,xx14) | SIEMENS SMS-AX VIEW 1.0 PanY SS 1
(0019,xx15) | SIEMENS SMS-AX VIEW 1.0 Native Edge Enh. Adv Percent Gain SS 1
(0019,xx16) | SIEMENS SMS-AX VIEW 1.0 Subtr. Edge Enh. Adv Percent Gain SS 1
(0019,xx17) | SIEMENS SMS-AX VIEW 1.0 Invert Flag us 1
(0019,xx1A) [ SIEMENS SMS-AX VIEW 1.0 Quant 1K Overlay OB 1
(0019,xx1B) | SIEMENS SMS-AX VIEW 1.0 Full Resolution Flag us 1
(0019,xx1C) | SIEMENS SMS-AX VIEW 1.0 Auto Window Center DS 1
(0019,xx1D) [ SIEMENS SMS-AX VIEW 1.0 Auto Window Width DS 1
(0019,xx1E) | SIEMENS SMS-AX VIEW 1.0 Auto Window Correct Value IS 2
(0019,xx1F) | SIEMENS SMS-AX VIEW 1.0 Sigmoid Window Parameter DS 1
(0019,xx20) | SIEMENS SMS-AX VIEW 1.0 Roadmap Catheter Contrast DS 1
(0019,xx21) | SIEMENS SMS-AX VIEW 1.0 Roadmap Vessel Contrast DS 1
(0019,xx23) | SIEMENS SMS-AX VIEW 1.0 CLEARstent ROI Origin us 2
(0019,xx24) | SIEMENS SMS-AX VIEW 1.0 CLEARstent ROI Size us 2
(0019,xx30) | SIEMENS SMS-AX VIEW 1.0 Frame # Roadmap - Min Amplification us 1
(0019,xx31) | SIEMENS SMS-AX VIEW 1.0 Frame # Roadmap - Vessel Map us 1
(0021,xx00) | SIEMENS SMS-AX ACQ 1.0 Acquisition Type us 1
(0021,xx01) | SIEMENS SMS-AX ACQ 1.0 Acquisition Mode us 1
(0021,xx02) | SIEMENS SMS-AX ACQ 1.0 Footswitch Index us 1
(0021,xx03) | SIEMENS SMS-AX ACQ 1.0 Acquisition Room us 1
(0021,xx04) | SIEMENS SMS-AX ACQ 1.0 Current Time Product SL 1
(0021,xx05) | SIEMENS SMS-AX ACQ 1.0 Dose SL 1
(0021,xx06) | SIEMENS SMS-AX ACQ 1.0 Skin Dose Percent SL 1
(0021,xx07) | SIEMENS SMS-AX ACQ 1.0 Skin Dose Accumulation SL 1
(0021,xx08) | SIEMENS SMS-AX ACQ 1.0 Skin Dose Rate SL 1
(0021,xx0A) | SIEMENS SMS-AX ACQ 1.0 Copper Filter uL 1
(0021,xx0B) | SIEMENS SMS-AX ACQ 1.0 Measuring Field us 1
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Tag Private Owner Code Name VR VM
(0021,xx0E) | SIEMENS SMS-AX ACQ 1.0 Total Steps SS 1
(0021,xx0F) | SIEMENS SMS-AX ACQ 1.0 Dyna X-Ray Info SL 4-4n
(0021,xx10) | SIEMENS SMS-AX ACQ 1.0 Modality LUT Input Gamma us 1
(0021,xx11) | SIEMENS SMS-AX ACQ 1.0 Modality LUT Output Gamma us 1
(0021,xx12) | SIEMENS SMS-AX ACQ 1.0 SH_STPAR OB 1
(0021,xx13) | SIEMENS SMS-AX ACQ 1.0 Acquisition Zoom us 1
(0021,xx14) | SIEMENS SMS-AX ACQ 1.0 Dyna Angulation Step SS 1
(0021,xx15) | SIEMENS SMS-AX ACQ 1.0 DDO Value us 1
(0021,xx16) | SIEMENS SMS-AX ACQ 1.0 DR Single Flag us 1
(0021,xx17) | SIEMENS SMS-AX ACQ 1.0 Source to Isocenter SL 1
(0021,xx19) | SIEMENS SMS-AX ACQ 1.0 ECG Index Array SL 1-n
(0021,xx1A) | SIEMENS SMS-AX ACQ 1.0 FD Flag us 1
(0021,xx1B) | SIEMENS SMS-AX ACQ 1.0 SH_ZOOM OB 1
(0021,xx1C) | SIEMENS SMS-AX ACQ 1.0 SH_COLPAR OB 1
(0021,xx1D) | SIEMENS SMS-AX ACQ 1.0 K-Factor us 1
(0021,xx1E) | SIEMENS SMS-AX ACQ 1.0 EVE us 1
(0021,xx1F) | SIEMENS SMS-AX ACQ 1.0 Total Scene Time SL 1
(0021,xx20) | SIEMENS SMS-AX ACQ 1.0 Restore Flag us 1
(0021,xx21) | SIEMENS SMS-AX ACQ 1.0 Stand Movement Flag us 1
(0021,xx22) | SIEMENS SMS-AX ACQ 1.0 FD Rows us 1
(0021,xx23) | SIEMENS SMS-AX ACQ 1.0 FD Columns us 1
(0021,xx24) | SIEMENS SMS-AX ACQ 1.0 Table Movement Flag us 1
(0021,xx28) | SIEMENS SMS-AX ACQ 1.0 Gamma LUT Sequence SQ 1
(0021,xx29) | SIEMENS SMS-AX ACQ 1.0 Scene Timeins DS 1
(0021,xx2A) | SIEMENS SMS-AX ACQ 1.0 3D Cardiac Phase Center IS 1
(0021,xx2B) | SIEMENS SMS-AX ACQ 1.0 3D Cardiac Phase Width IS 1
(0021,xx30) | SIEMENS SMS-AX ACQ 1.0 Organ Program Info OB 1
(0021,xx31) | SIEMENS SMS-AX ACQ 1.0 Source Image Distance SS 1-n
(0021,xx32) | SIEMENS SMS-AX ACQ 1.0 Original Pixel Spacing DS 2
(0021,xx3B) | SIEMENS SMS-AX ACQ 1.0 mAs Modulation IS 1
(0021,xx3C) | SIEMENS SMS-AX ACQ 1.0 3D R-Peak Reference Time DT 1-n
(0021,xx3D) | SIEMENS SMS-AX ACQ 1.0 ECG Frame Time Vector SL 1-n
(0021,xx3E) | SIEMENS SMS-AX ACQ 1.0 ECG Start Time of Run SL 1
(0021,xx40) | SIEMENS SMS-AX ACQ 1.0 Gamma LUT Descriptor us 3
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Tag Private Owner Code Name VR VM
(0021,xx41) | SIEMENS SMS-AX ACQ 1.0 Gamma LUT Type LO 1
(0021,xx42) | SIEMENS SMS-AX ACQ 1.0 Gamma LUT Data us 1-n
(0021,xx43) | SIEMENS SMS-AX ACQ 1.0 Global Gain us 1
(0021,xx44) | SIEMENS SMS-AX ACQ 1.0 Global Offset us 1
(0021,xx45) | SIEMENS SMS-AX ACQ 1.0 Dipp Mode us 1
(0021,xx46) | SIEMENS SMS-AX ACQ 1.0 Artis System Type us 1
(0021,xx47) | SIEMENS SMS-AX ACQ 1.0 Artis Table Type us 1
(0021,xx48) | SIEMENS SMS-AX ACQ 1.0 Artis Table Top Type us 1
(0021,xx49) | SIEMENS SMS-AX ACQ 1.0 Water Value SS 1
(0021,xx50) | SIEMENS SMS-AX ACQ 1.0 X-ray Tube Type LO 1
(0021,xx51) | SIEMENS SMS-AX ACQ 1.0 3D Positioner Primary Start Angle DS 1
(0021,xx52) | SIEMENS SMS-AX ACQ 1.0 3D Positioner Secondary Start Angle DS 1
(0021,xx53) | SIEMENS SMS-AX ACQ 1.0 Stand Position SS 3
(0021,xx54) | SIEMENS SMS-AX ACQ 1.0 Rotation Angle SS 1
(0021,xx55) | SIEMENS SMS-AX ACQ 1.0 Image Rotation us 1
(0021,xx56) | SIEMENS SMS-AX ACQ 1.0 Table Coordinates SS 3
(0021,xx57) | SIEMENS SMS-AX ACQ 1.0 Isocenter Table Position SS 3
(0021,xx58) | SIEMENS SMS-AX ACQ 1.0 Table Object Distance DS 1
(0021,xx59) | SIEMENS SMS-AX ACQ 1.0 C-Arm Coordinate System FL 1-n
(0021,xx5B) | SIEMENS SMS-AX ACQ 1.0 Table Coordinate System FL 12
(0021,xx5C) | SIEMENS SMS-AX ACQ 1.0 Patient Coordinate System FL 12
(0021,xx5D) | SIEMENS SMS-AX ACQ 1.0 Angulation SL 1-n
(0021,xx5E) | SIEMENS SMS-AX ACQ 1.0 Orbital SL 1-n
(0021,xx62) | SIEMENS SMS-AX ACQ 1.0 Reconstruction Preset us 1
(0021,xx63) | SIEMENS SMS-AX ACQ 1.0 3D Start Angle SS 1
(0021,xx64) | SIEMENS SMS-AX ACQ 1.0 3D Planned Angle SL 1
(0021,xx65) | SIEMENS SMS-AX ACQ 1.0 3D Rotation Plane Alpha SL 1
(0021,xx66) | SIEMENS SMS-AX ACQ 1.0 3D Rotation Plane Beta SL 1
(0021,xx67) | SIEMENS SMS-AX ACQ 1.0 3D First Image Angle SL 1
(0021,xx68) | SIEMENS SMS-AX ACQ 1.0 3D Trigger Angle SS 1-n
(0021,xx71) | SIEMENS SMS-AX ACQ 1.0 Detector Rotation DS 1-n
(0021,xx72) | SIEMENS SMS-AX ACQ 1.0 Physical Detector Rotation SL 1-n
(0021,xx81) | SIEMENS SMS-AX ACQ 1.0 Table Head Tilt SS 1
(0021,xx82) | SIEMENS SMS-AX ACQ 1.0 Table Rotation SS 1
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Tag Private Owner Code Name VR VM
(0021,xx83) | SIEMENS SMS-AX ACQ 1.0 Table Cradle Tilt SS 1
(0021,xx84) | SIEMENS SMS-AX ACQ 1.0 Artis System Family LO 1
(0023,xx08) | SIEMENS SMS-AX QUANT 1.0 Calibration TOD Value IS 1
(0025,xx00) f\'ég"lE,\J'\'FSOS:V.'g'AX ORIGINALIM- 1 iew Native us 1
(0025,xx01) ZIEEAIE,\II\:%SNS_AX ORIGINAL IM- Original Series Number us 1
(0025,xx02) ,SAI(EEAE\J’\::SOS:V.'S-AX ORIGINAL IM- Original Image Number us 1
(0025 003 | SEVENS SMS-AX ORIGINALINE i o s |
(0025,xx04) f\'ég"lE,\J'\'F%S:\’.'g'AX ORIGINAL M- iy width us 1
(0025 05) | SEVENS SMS-AX ORIGINALINE [y g s |
(0025,xx06) f\'ég"lE,\J'\'FSOS:V.'g'AX ORIGINALIM- 1 \in Contrast us 1
(0025,xx07) ZIEEAIE,\II\:%SNS_AX ORIGINAL IM- Original Frame Number us 1
(0025,xx08) ilégﬂlli\‘l\ll:SOS:\/.lg-AX ORIGINAL IM- Original Mask Frame Number us 1
(0025,xx09) )SAIEEAIE\II\::%S:\/.IS—AX ORIGINAL IM- Opac US 1
(0025,xx0A) ,SAI(EEAE\J’\::SOS:V.'S-AX ORIGINAL IM- Original Number of Frames us 1
(0025,xx0B) ZIEEAIE,\II\:%SNS_AX ORIGINAL IM- Original Scene Duration DS 1
(0025,xx0C) f\'ég"lE,\J'\'FSOS:V.'g'AX ORIGINAL IM- Image Object ID LO 1
(0025,xx0D) ZIEEAIE,\II\:%SNS_AX ORIGINAL IM- Original Scene VFR Info SS 1-n
(0025,xx0E) f\'ég"lE,\J'\'F%S:\’.'g'AX ORIGINAL IM- Original Frame ECG Position SS 1
(0025 xc10) | SEVENS SMS-AX ORIGINALINE [ . s | 1
(0025,xx11) | ep > SMSAX ORIGINALINE | iesipe pixel shift us 1
(0025,xx12) ZIEEAIE,\II\:%SNS_AX ORIGINAL IM- Number of Mask Frames us 1
(0025,xx13) ,SAI(EEAE\J’\::SOS:V.'S-AX ORIGINAL IM- Number of Fill Frames us 1
(0025 oc14) | SEVENS SMS-AX ORIGINALINE [y, s | o
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Tag Private Owner Code Name VR VM
(0025,115) | SEMENS SMS-AX ORIGINALIM- |\ ey s | o
(0025,xx16) ,SAI(EEAE\I\::SOSMS-AX ORIGINAL IM- Ready Processing Status IS 1
(0029,xx08) | SIEMENS CSA NON-IMAGE CSA Data Type CS 1
(0029,xx09) | SIEMENS CSA NON-IMAGE CSA Data Version LO 1
(0029,xx10) | SIEMENS CSA NON-IMAGE CSA Data Info OB 1
(0029,xx08) | SIEMENS MEDCOM HEADER MedCom Header Type CS 1
(0029,xx09) | SIEMENS MEDCOM HEADER MedCom Header Version LO 1
(0029,xx10) | SIEMENS MEDCOM HEADER MedCom Header Info OB 1
(0029,xx20) | SIEMENS MEDCOM HEADER MedCom History Information OB 1
(0029,xx31) | SIEMENS MEDCOM HEADER PMTF Information 1 LO 1
(0029,xx32) | SIEMENS MEDCOM HEADER PMTF Information 2 uL 1
(0029,xx33) | SIEMENS MEDCOM HEADER PMTF Information 3 UL 1
(0029,xx34) | SIEMENS MEDCOM HEADER PMTF Information 4 S 1
(0029,xx35) | SIEMENS MEDCOM HEADER PMTF Information 5 UL 1
(0029,xx40) | SIEMENS MEDCOM HEADER Application Header Sequence SQ 1
(0029,xx41) | SIEMENS MEDCOM HEADER Application Header Type cs 1
(0029,xx42) | SIEMENS MEDCOM HEADER Application Header ID LO 1
(0029,xx43) | SIEMENS MEDCOM HEADER Application Header Version LO 1
(0029,xx44) | SIEMENS MEDCOM HEADER Application Header Info OB 1
(0029,xx50) | SIEMENS MEDCOM HEADER Workflow Control Flags LO 8
(0029,xx51) | SIEMENS MEDCOM HEADER Arch. Management Flag Keep Online (&) 1
(0029,xx52) | SIEMENS MEDCOM HEADER Arch. Mgmnt Flag Do Not Archive CsS 1
(0029,xx53) | SIEMENS MEDCOM HEADER Image Location Status cs 1
(0029,xx54) | SIEMENS MEDCOM HEADER Estimated Retrieve Time DS 1
(0029,xx55) | SIEMENS MEDCOM HEADER Data Size of Retrieved Images DS 1
(0029,xx08) | SIEMENS MEDCOM 0OO0G MedCom OOG Type Cs 1
(0029,xx09) | SIEMENS MEDCOM OOG MedCom OOG Version LO 1
(0029,xx10) | SIEMENS MEDCOM 0OO0G MedCom OOG Info OB 1
(0029,xx00) | CARDIO-D.R. 1.0 Standard Edge Enhancement Sequence SQ 1
(0029,xx01) | CARDIO-D.R. 1.0 Convolution Kernel Size us 2
(0029,xx02) | CARDIO-D.R. 1.0 Convolution Kernel Coefficients us 1-n
(0029,xx03) | CARDIO-D.R. 1.0 Edge Enhancement Gain FL 1
(2121,xx01) | PMI Private Calibration Module Calibration Method ST 1

Version 2.0
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Tag Private Owner Code Name VR VM

(2121,xx02) | PMI Private Calibration Module Calibration Method Info ST 1
Version 2.0

(2121,xx03) | PMI Private Calibration Module Calibration Object Size FL 1
Version 2.0

(2121,xx04) | PMI Private Calibration Module Calibration Object S Dev FL 1
Version 2.0

(2121,xx05) | PMI Private Calibration Module Calibration Horizontal Pixel Spacing FL 1
Version 2.0

(2121,xx06) | PMI Private Calibration Module Calibration Vertical Pixel Spacing FL 1
Version 2.0

(2121,xx08) | PMI Private Calibration Module Calibration File Name ST 1
Version 2.0

(2121,xx09) | PMI Private Calibration Module Calibration Frame Number IS 1
Version 2.0

(2121,xx0A) | PMI Private Calibration Module Calibration Object Unit SH 1
Version 2.0

(2121,xx0B) | PMI Private Calibration Module Averaged Calibrations Performed SS 1
Version 2.0

(2121,xx0C) | PMI Private Calibration Module Auto Magnify Factor FL 1
Version 2.0

(2121,xx0D) | PMI Private Calibration Module Horizontal Pixel S Dev FL 1
Version 2.0

(2121,xx0E) | PMI Private Calibration Module Vertical Pixel S Dev FL 1
Version 2.0

(2121,xx01) | PMI Private 3D Reconstruction At- | Binary 3D Vessel Data OB 1
tributes Version 1.0

(2121,xx02) | PMI Private 3D Reconstruction At- | 3D Control Displayed Area Sequence SQ 1
tributes Version 1.0

(2121,xx03) | PMI Private 3D Reconstruction At- | 3D Control Displayed Area Top Left Cor- SL 2
tributes Version 1.0 ner

(2121,xx04) | PMI Private 3D Reconstruction At- | 3D Control Displayed Area Bottom SL 2
tributes Version 1.0 Right Corner

Note: Please be informed that some of the Private Owner Codes contain double-spaces in the name definitions. The following term (only
double-spaces marked) are defined:

SIEMENS SMS-AX<spc><spc>VIEW 1.0

SIEMENS SMS-AX<spc><spc>ACQ 1.0

SIEMENS SMS-AX<spc><spc>QUANT 1.0

SIEMENS SMS-AX<spc><spc>ORIGINAL IMAGE INFO 1.0

(All spaces not specially marked, are single spaces.)

8.2.1 Usage of Attributes from received 10Ds

N/A

8.2.2 Attribute mapping

The ARTIS one implements an actor Acquisition Modality according to the IHE Scheduled Workflow (SWF) profile.
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8.2.3 Coerced / Modified fields

8.3 Coded Terminology and Templates
NIA
8.3.1 Context Groups
NIA
8.3.2 Template Specifications
NIA
8.3.3 Private Code definitions
NIA
8.4  Grayscale Image Consistency

The high resolution TFT display monitor option of ARTIS one comes with a DICOM Grayscale Standard Display Function
(GSDF) compliant factory pre-setting. A typical working environment setup is assumed for ambient light.

8.5 Standard Extended / Specialized / Private SOP Classes

8.5.1 Standard Extended XA

The XA SOP Instances created by ARTIS one are standard extended by adding the following private module attributes.

Table 67 - Private Modules for Standard Extended XA

IE Module GBI Usage Note
ence

Image Edge Enhancement 8.5.1.1 u private Filter Information
Angio Viewing 8.5.1.2 |U private Viewing information
Angio Acquisition 8.5.1.3 |U addlthnal private [nfgrmatlon

about image Acquisition

Angio Quantification 8.5.1.4 |U if image is calibrated for Quant
Original Image Info 8.5.1.5 |U if derived image

U = User Option
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8.5.1.1

The table in this section contains private IOD attributes that describe Edge Enhancement extensions due to the Dynamic

Cardio Review definition.

Edge Enhancement Module

Table 68 - (Private) Edge Enhancement Module

Gain

Attribute Name Tag Owner Type Notes
Standard formula according to
Dyna view Extensions.
standard Edge Enhance- | 459 . 00) | CARDIO-D.R. 1.0 3 | For DSA images two items are
ment Sequence : . .
provided, one item for native
and a second for DSA viewing
x-ly-size value pair.
>Convolution Kernel Size | (0029,xx01) | CARDIO-D.R. 1.0 1c | Each value shall be greater or
equal to 3.
Required if sequence is present
C lution K Yo Row-by-row list of the kernel
>-onvolution Kernel €0~ 1 (9929,xx02) | CARDIO-D.R. 1.0 1C | Coefficients.
efficients S .
Required if sequence is present
Applied Filter gain Factor.
>Edge Enhancement (0029,xx03) | CARDIO-D.R. 1.0 1c |°PP J

Required if sequence is present

8.5.1.2 Angio Viewing Module

The table in this section contains private IOD attributes that describe extensions for storing angio viewing information.

Table 69 - (Private) Angio Viewing Module Attributes

VIEW 1.0

Attribute Name Tag Owner Type Notes
Special Modes for Angio Re-
view.
Defined Terms are
Review Mode (0019,xx00) \S/'I'é'\v’\'/E1Ng SMS-AX 3 | 7=REV_MAXFILL,
' 2 =REV_LOOP,
3 =REV_SCROLL,
4 =REV_STEREO_LOOP
Percentage of Mix between
Anatomical Background (0019,xx01) SIEMENS SMS-AX 3 Subtracted Image Result and
Percent ! VIEW 1.0 Native Mask. Range is from
0to 100.
Number of Phases (0019,xx02) \S/Illél\V/\I/E1Ng SMS-AX 3 :{::efla(?c; zhoi;‘se\srlable Frame
Apply Anatomical Back- SIEMENS SMS-AX
ground (0019,xx03) ey 7.0 3
- *
Pixel Shift Array (0019,xx04) | SEMENS SMSAX 3 ?Oog‘;gqggg)"f Frames
Brightness (0019,xx05) | 2IEMENS SMS-AX 3 | SUB windowing
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Attribute Name

Tag

Owner

Type

Notes

Contrast

(0019,xx06)

SIEMENS SMS-AX
VIEW 1.0

SUB windowing

SIEMENS SMS-AX

Enabled Shutter (0019,xx07) VIEW 1.0 3 Visualize shutter
Native Edge Enhance- SIEMENS SMS-AX Percent gain for native display
ment Percent Gain (0019,xx08) VIEW 1.0 3 of images.
Native Edge Enhance- SIEMENS SMS-AX
ment LUT Index (0019, x09) | vy 1.0 3
Native Edge Enhance- SIEMENS SMS-AX
ment Kernel Size (0079,xx0A) VIEW 1.0 3
Subtracted Edge En- (0019,xx0B) SIEMENS SMS-AX 3 Percent gain for subtracted dis-
hancement Percent Gain ! VIEW 1.0 play of images.
Subtracted Edge En- SIEMENS SMS-AX
hancement LUT Index | (©019°%00) | yjew 1.0 3
Subtracted Edge En- SIEMENS SMS-AX
hancement Kernel Size (0019,xx0D) VIEW 1.0 3
Fade Percent (0019,xx0E) \S/Illél\V/\I/E1Ng SM5-AX 3
Flipped before Laterality SIEMENS SMS-AX
Applied (0019, xx0F) | 1w 1.0 3
Apply Fade (0019,xx10) \S/'llé"v’\'ﬂ\% SMS-AX 3
SIEMENS SMS-AX
Zoom (0019,xx12) VIEW 1.0 3
SIEMENS SMS-AX
Pan X (0019,xx13) VIEW 1.0 3
SIEMENS SMS-AX
PanY (0019,xx14) VIEW 1.0 3
Native Edge Enhance-
ment Adverse Percent (0019,xx15) \S/lllél\\//lvE;\lg L 3
Gain ’
Subtracted Edge En-
hancement Adverse Per- | (0019,xx16) 3||?\V/\IIE1’\% SM5-AX 3
cent Gain ’
Invert Flag (0019,xx17) \S/'llé"v’\'/E1Ng SMS-AX 3
Quant 1K Overlay (0019,xx1A) | SIEMENS SMS-AX 3 Only Store Monitor and Store
VIEW 1.0 Reference Images in Quant
(128 kbyte)
Acquisition Size (0019,xx1B) \S/Illél\V/\I/E1Ng SM5-AX 3
Auto Window Center (0019,xx1C) \S/Illél\\//lvE1Ng . 3
Auto Window Width (0019,xx1D) | JIEMENS SMS-AX 3

VIEW 1.0
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Attribute Name Tag Owner Type Notes
C:ltl:)eWindow Correct (0019, xx1E) \S/Illél\V/\I/E1r\% SMS-AX 3
2itge:'noid Window Param- (0019,xx1F) \S/||IE,\\/AVE1N§) SMS-AX 3
Frc;izfmap Catheter Con- (0019,xx20) \S/Illél\V/\I/E1r\% SMS-AX 3
Roadmap Vessel Contrast | (0019,xx21) \Sllllé,\\/AVE1N§) SMS-AX 3
CLEARstent ROI Origin (0019,xx23) \S/E\v/\l/a’\% SMS-AX 3
CLEARstent ROI Size (0019,xx24) \Sllllél\\//lvar\% SMS-AX 3
Frmsnee o2 | ors o | USSR
_F(/aenswsee{\lhtjlr:pber Roadmap (0019,xx31) \S/||IE,\\/AVE1N§) SMS-AX 3

8.5.1.3 Angio Acquisition Data Module

The table in this section contains private IOD attributes that describe extensions for storing specific Angio Acquisition
data.

Table 70 - (Private) Angio Acquisition Data Attributes

Attribute Name Tag Owner Type Notes

Technical Type of Acquisition
performed to get image result.
Defined Terms are
1 = fixed frame rate,
2 =variable frame rate (manu-
ally triggered),

) 3 = variable frame rate (time

Acquisition Type (0021,xx00) ?EMENS SMS-AX ACQ 3 [triggered),

4 = peri manual to head,

10 = dynavision manual inject.,
11 = dynavision automatic,

13 = continuous fluoro,

14 = pulsed fluoro,

15 = ECG triggered fluoro
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Attribute Name Tag Owner Type Notes

Technical Mode of Acquisition
performed

to get image result.
Defined Terms are:

0 = no mode specified,
1 = Digital Radiography,

2 =DSA,
3 = Peri-DSA,
3 4 = DR stepping,

Acquisition Mode (0021,xx01) ?E)MENS SMS-AX ACQ 3 5 — DR Dynavision (nat)

6 = Dynavision (sub),

7 = Card,

8 = Service mode (internal),

9 = 3D Mode

10 = Service mode (internal),

19 = Bypass Fluoro,

20 = Roadmap Fluoro,

21 =Normal Fluoro
Foot Switch Index (0021,xx02) ?IEMENS SMS-AX ACQ 3

_ 0 = Exam Room,
Acquisition Room (0021,xx03) ?”E)MENS SMS-AX ACQ 3 1 — Control R
. = Control Room

Current Time Product (0021,xx04) ?”E)MENS SMS-AX ACQ 3 (pAs)
Dose (0021,xx05) ?EMENS SMS-AX ACQ 3 [ (nGylpulse)
Skin Dose Percent (0021,xx06) ?”E)MENS SMS-AX ACQ 3
Skin Dose Accumulation | (0021,xx07) SIEMENS SMS-AX ACQ 3 (0.01 mGy)

1.0

Referenced Air Kerma SIEMENS SMS-AX ACQ

(0021,xx08) 3 (0.01 mGy / min)

Rate 1.0
Copper Filter (0021,xx0A) ?'EMENS SMSAXACQ | 3 (0.1 mm)
Measuring Field (0021,xx0B) ?”E)MENS SMS-AX ACQ 3

Number of multi-frame images
Total Steps (0021,xx0E) ?”E)MENS SMS-AX ACQ 3 which make up a Peri or DR-

’ Step acquisition
Per frame info (4 * number of
frames).
SIEMENS SMS-AX ACQ

Dyna X-Ray Info (0021,xx0F) 10 3 (V, pA value, ps, pAs)

Only with rotational images
Gamma Input (0021,xx10) SIEMENS SM5-AX ACQ 3

1.0

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11 98 of 154



Attribute Name

Tag

Owner

Type

Notes

Gamma Output

(0021,xx11)

SIEMENS SMS-AX
1.0

ACQ

SIEMENS SMS-AX

ACQ

Technical data-structure with

SH_STPAR (0021,xx12) 1.0 3 Gantry information.
Acquisition Zoom (0021,xx13) ?%MENS SMS-AX ACQ 3

Dyna Angulation Step (0021,xx14) ?EMENS SMS-AX ACQ 3 iOnn?)./ovlithgrégLi!Zial images
DDO Value (0021,xx15) ?IEMENS SMS-AXACQ 3

owsrerss | @021 e |JEISMSA A DRSGT denge
Source to Isocenter (0021,xx17) ?%MENS SMS-AX ACQ 3 (mm)

ECG Index Array (0021,xx19) ?I.IE)MENS SMS-AX ACQ 3 FP)Z':'nftrzrn:Z ECG data, one value
SH_ZOOM (0021,xx1B) ?%MENS SMS-AX ACQ 3 Technical data-structure
0021 1) | SEMENSSMSAXACQ |5 [Tt stctre wi
K-Factor (0021,xx1D) ?IEMENS SMS-AXACQ 3

EVE (0021,xx1E) ?'EMENS SMSAXACQ | 5

Total Scene Time (0021,xx1F) ?%MENS SMS-AX ACQ 3 In sec. (rounded)

Restore Flag (0021,xx20) ?{EMENS SMS-AX ACQ 3

Stand Movement Flag (0021,xx21) ?I.IE)MENS SMS-AX ACQ 3 :i:nmovements during acquisi-
FD Rows (0021,xx22) ?EMENS SMS-AXACQ 3 Acquisition matrix, rows

FD Columns (0021,xx23) ?%MENS SMS-AX ACQ 3 Acquisition matrix, columns
Table Movement Flag (0021,xx24) ?EMENS SMS-AXACQ 3 ;lz)fg{]:qnc;vggi?stistig:]and orta-
Gamma LUT Sequence (0021,xx28) ?%MENS SMS-AX ACQ 3 g;)tr;—l(i;\ggirtl__LJ>T1a2p)§[ci)ed toraw
>Gamma LUT Descriptor | (0021,xx40) ?EMENS SMS-AX ACQ 3

>Gamma LUT Type (0021,xx41) ?%MENS SMS-AX ACQ 3

>Gamma LUT Data (0021,xx42) | IEMENS SMS-AXTACQ 1+ 5

1.0
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1.0

Attribute Name Tag Owner Type Notes
Scene Timeins (0021,xx29) ?{EMENS SMS-AX ACQ 3 In sec.
3D Cardiac Phase Center | (0021,xx2A) ?{EMENS SMS-AX ACQ 3
3D Cardiac Phase Width (0021,xx2B) SIEMENS SM5-AX ACQ 3

SIEMENS SMS-AX ACQ

Technical data-structure with

Start Angle

1.0

Organ Program Info (0021,xx30) 1.0 3 organ program information
SIEMENS SMS-AX AC per frame values for rotational
Source Image Distance (0021,xx31) | 0 i Q| 3 [imagesin0.1 mm
' in mm otherwise
Pixel Spacing at acquisition time
i before any resizing/processing
Original Pixel Spacing (0021,xx32) ?EMENS SMS-AXACQ 3 was applied.
’ Value cannot be used for meas-
urement.
mAs Modulation (0021,xx3B) SIEMENS SMS-AX ACQ 3 on!y.f.or cardiac triggered 3D ac-
1.0 quisition
3.D R-Peak Reference (0021,%xx3C) SIEMENS SMS-AX ACQ 3 one yalug per frame, only.f(.)r
Time 1.0 cardiac triggered 3D acquisition
. SIEMENS SMS-AX ACQ one value per frame, only for
ECG Frame Time Vector (0021,xx3D) 1.0 3 ECG gated fluoro / acquisition
i absolute time in sec (UTC), only
ECG Start Time of Run (0021,xx3E) ?EMENS SMS-AX ACQ 3 for ECG gated fluoro / acquisi-
’ tion
Global Gain (0021,xx43) ?EMENS SMS-AX ACQ 3
Global Offset (0021,xx44) ?IEMENS SMS-AX ACQ 3
Dipp Mode (0021,xx45) ?EMENS SMS-AX ACQ 3
Artis System Type (0021,xx46) ?IEMENS SMS-AXACQ 3
Artis Table Type (0021,xx47) ?EMENS SMS-AX ACQ 3
Artis Table Top Type (0021,xx48) ?IEMENS SMS-AXACQ 3
Water Value (0021,xx49) SIEMENS SMS-AX ACQ 3 qu,!lvalent.wat‘ervalue of the
1.0 patient/object in 0.1 mm
X-Ray Tube Type (0021,xx50) ?IEMENS SMS-AXACQ 3
3D Positioner Primary SIEMENS SMS-AX ACQ (deg)
Start Angle (0021,xx51) 1.0 3 Only with rotational images
3D Positioner Secondary (0021,3x52) SIEMENS SMS-AX ACQ 3 (deg)

Only with rotational images
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Attribute Name

Tag

Owner

Type

Notes

Stand Position

(0021,xx53)

SIEMENS SMS-AX
1.0

ACQ

in0.1Tmm; x,y, z
Only with rotational images

SIEMENS SMS-AX

ACQ

in 0.1 deg

Rotation Angle (0021,xx54) 1.0 3 Only with rotational images
Rotation in relation to default
patient position
0 = not rotated,

. SIEMENS SMS-AX ACQ 1 = rotated in clockwise direc-

Image Rotation (0021,xx55) 10 3 tion
2 = rotated in counterclockwise
direction,

Only with rotational images

Table Coordinates (0021,xx56) ?{EMENS SMS-AX ACQ 3 (On:llr;)\;v?(tlhy’rcftational images

Isocenter Table Position (0021,xx57) ?EMENS SMS-AX ACQ 3 in 0.1 mm; long, lat, height

Table Object Distance (0021,xx58) ?EMENS SMS-AX ACQ 3 iggér;stla(:ggia:t:;i:ed) table ob-

C-Arm Coordinate Sys- (0021,xx59) SIEMENS SMS-AX ACQ 3

tem 1.0

Table Coordinate System | (0021,xx5B) ?EMENS SMS-AX ACQ 3

Patient Coordinate Sys- (0021,xx5C) SIEMENS SMS-AX ACQ 3

tem 1.0

Angulation (0021,xx5D) ?EMENS SMS-AX ACQ 3

Orbital (0021,xx5E) ?IEMENS SMS-AX ACQ 3

3D Reconstruction Preset | (0021,xx62) ?EMENS SMS-AX ACQ 3 Only with rotational images

SIEMENS SMS-AX ACQ in 0.01 deg
3D Start Angle (0021,xx63) 1.0 3 Only with rotational images
SIEMENS SMS-AX ACQ in 0.01 deg

3D Planned Angle (0021,xx64) 1.0 3 Only with rotational images

3D Rotation Plane Alpha | (0021,xx65) ?EMENS SMS-AX ACQ 3 gncl)yovli?ﬁ?otational images

3D Rotation Plane Beta | (0021,xx66) ?'EMENS SMSAXACQ | 3 gn?ﬁli?ﬁ?ota tional images
. SIEMENS SMS-AX AC in0.01 de

3D Firstimage Angle (0021,xx67) 1.0 ? 3 Only with 9rJotationaI images
. SIEMENS SMS-AX ACQ in 0.01 deg

3D Trigger Angle (0021,xx68) 1.0 3 Only with rotational images
In deg

Detector Rotation (0021,xx71) ?IIE)MENS SMS-AX ACQ 3 iCr):aeg\gilue [ frame for rotational

one single value otherwise
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Attribute Name Tag Owner Type Notes
In 0.01 deg
EhyS|caI Detector Rota- (0021,xx72) SIEMENS SMS-AX ACQ 3 Qne value / frame for rotational
tion 1.0 images

one single value otherwise

SIEMENS SMS-AX ACQ

In 0.1 deg

Table Head Tilt (0021,xx81) 10 3 + means: head end up
In 0.1 deg
Table Rotation (0021,xx82) ?EMENS SMS-AX ACQ 3 + means: counterclockwise ro-
’ tation
In 0.1 deg
Table Cradle Tilt (0021,xx83) ?”E)MENS SMS-AXACQ 3 + means: right patient side up
’ (position HFS)
Artis System Family (0021,xx84) SIEMENS SM5-AX ACQ 3 “Artis-One”

1.0

8.5.1.4 Angio Quantification Module

The table in this section contains private 0D attributes that describe extensions for calibration results features.

Table 71 - (Private) Angio Quantification Module Attributes

Attribute Name Tag Owner Type Notes
. . SIEMENS SMS-AX . . .

Calibration TOD Value (0023,xx08) QUANT 1.0 3 | Table Object Distance in cm

Calibration Method (2121,xx01) | PMI Private Calibration 3 Only for images calibrated for
Module Version 2.0 Quant

Calibration Method Info | (2121,xx02) | PMI Private Calibration 3 | Only for images calibrated for
Module Version 2.0 Quant

Calibration Object Size (2121,xx03) | PMI Private Calibration 3 | Only for images calibrated for
Module Version 2.0 Quant

Calibration Object S Dev | (2121,xx04) | PMI Private Calibration 3 | Only for images calibrated for
Module Version 2.0 Quant

Calibration Horizontal (2121,xx05) | PMI Private Calibration 3 Only for images calibrated for

Pixel Spacing Module Version 2.0 Quant

Calibration Vertical Pixel | (2121,xx06) | PMI Private Calibration 3 | Only for images calibrated for

Spacing Module Version 2.0 Quant

Calibration File Name (2121,xx08) | PMI Private Calibration 3 Only for images calibrated for
Module Version 2.0 Quant

Calibration Frame Num- | (2121,xx09) | PMI Private Calibration 3 Only for images calibrated for

ber Module Version 2.0 Quant

Calibration Object Unit (2121,xx0A) | PMI Private Calibration 3 | Only for images calibrated for
Module Version 2.0 Quant

Averaged Calibrations (2121,xx0B) | PMI Private Calibration 3 | Only for images calibrated for

Performed Module Version 2.0 Quant

Auto Magnify Factor (2121,xx0C) | PMI Private Calibration 3 | Only for images calibrated for
Module Version 2.0 Quant
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Attribute Name Tag Owner Type Notes
Horizontal Pixel S Dev (2121,xx0D) | PMI Private Calibration 3 | Only for images calibrated for
Module Version 2.0 Quant
Vertical Pixel S Dev (2121,xx0E) | PMI Private Calibration 3 Only for images calibrated for
Module Version 2.0 Quant
Binary 3D Vessel Data (2121,xx01) | PMI Private 3D Recon- 3 Only for Quant 3D models
struction Attributes Ver-
sion 1.0
3D Control Displayed (2121,xx02) | PMI Private 3D Recon- 3 | Only for Quant 3D models
Area Sequence struction Attributes Ver-
sion 1.0
>3D Control Displayed (2121,xx03) | PMI Private 3D Recon- 3 Only for Quant 3D models
Area Top Left Corner struction Attributes Ver-
sion 1.0
>3D Control Displayed (2121,xx04) | PMI Private 3D Recon- 3 | Only for Quant 3D models
Area Bottom Right Cor- struction Attributes Ver-
ner sion 1.0

8.5.1.5 Original Image Info Module

The table in this section contains private |OD attributes that describe extensions for additional original image data for
derived images (e.g. Store Monitor Image).

Table 72 - (Private) Original Image Info Module Attributes

Attribute Name Tag Owner Type Notes
SIEMENS SMS-AX
View Native (0025,xx00) | ORIGINAL IMAGE INFO 3
1.0

SIEMENS SMS-AX
Original Series Number (0025,xx01) | ORIGINAL IMAGE INFO 3
1.0

SIEMENS SMS-AX
Original Image Number (0025,xx02) | ORIGINAL IMAGE INFO 3
1.0

SIEMENS SMS-AX
Win Center (0025,xx03) | ORIGINAL IMAGE INFO 3
1.0

SIEMENS SMS-AX
Win Width (0025,xx04) | ORIGINAL IMAGE INFO 3
1.0

SIEMENS SMS-AX
Win Brightness (0025,xx05) | ORIGINAL IMAGE INFO 3
1.0

SIEMENS SMS-AX
Win Contrast (0025,xx06) | ORIGINAL IMAGE INFO 3
1.0

SIEMENS SMS-AX
Original Frame Number (0025,xx07) | ORIGINAL IMAGE INFO 3
1.0
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1.0

Attribute Name Tag Owner Type Notes
Original Mask Frame SIEMENS SMS-AX
9 (0025,xx08) | ORIGINAL IMAGE INFO 3
Number 10
SIEMENS SMS-AX
Opac (0025,xx09) | ORIGINAL IMAGE INFO 3
1.0
Original Number of SIEMENS SMS-AX
9 (0025,xx0A) | ORIGINAL IMAGE INFO 3
Frames 10
SIEMENS SMS-AX
Original Scene Duration (0025,xx0B) | ORIGINAL IMAGE INFO 3
1.0
Set to
SIEMENS SMS-AX N "
Image Object ID (0025,xx0C) | ORIGINAL IMAGE INFO 3 AXIM_READY_PROCESSED

when Ready Processing was ap-
plied

Original Scene VFR Info

(0025,xx0D)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Number of phases, then fol-
lowed by n pairs (Last Frame
Number,

then Frame Rate)

tion

Original Frame ECG Posi-

(0025,xx0E)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Zoom Flag

(0025,xx10)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Flexible Pixel Shift

(0025,xx11)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Number of Mask Frames

(0025,xx12)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Number of Fill Frames

(0025,xx13)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Series Number

(0025,xx14)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Image Number

(0025,xx15)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

Ready Processing Status

(0025,xx16)

SIEMENS SMS-AX
ORIGINAL IMAGE INFO
1.0

1 =ready processed,
2 =resized,
3 =both

4 =resize 14 to 16 bit (rota-
tional images)

5 = acquired with 16 bit (rota-
tional images)
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8.5.1.6 SOP Common Module - Image Type Extensions

Additional values for the image type attribute are used to designate the purpose of the SOP instance created by the AR-
TIS one system. Please see the following table for details.

Table 73 - Image Type Extensions

Type of Scene/lmage Image Type
Scene and Single Image ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A
Scene and Single Image ac-
quired with alternate ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\ALT ACQ
footswitch
Reference Image DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\REFIMAGE

CLEARstent Reference Im-

age DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\REFIMAGE\ICSTENT REF

Dynamic CLEARstent Image | DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\ICSTENT DYNAMIC

CLEARstent Live Image DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\CLEARESTENT_LIVE

Store Monitor DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\STORE MONITOR

ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\PERI\MASK\n'

Perivision ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\PERI\FILL\n'

Dynavision ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\DYNAI2

3D Acquisition DR ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A13D ACQIDR?2

3D Acquisition DSA ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\3D ACQ\DSA2
Heartsweep ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE Al3D ACQ\ COROSCANIFILL
Store Fluoro Loop DERIVED\PRIMARY\SINGLE PLANEISINGLE A\STORE FLUORO

Store Roadmap DERIVED\PRIMARY\SINGLE PLANE\SINGLE AIROADMAP

DERIVED\SECONDARY\<3rd to nth value from Original>\QUANT

Quant Result Image DERIVED\SECONDARY\SINGLE PLANE\SINGLE A(B)\
STORE MONITOR\QUANT3DMODEL

Exam Protocol (converted to

ORIGINAL\PRIMARY\SINGLE PLANEW\EXAM PROTOCOL
XA Image)

T the term "n" is replaced by the related Step Number where the Image was acquired. Step Numbers start with "1".
2 Additional values with phase info are set

8.6  Private Transfer Syntaxes

No private Transfer Syntaxes are defined for or requested by ARTIS one DICOM application.

8.7  Sorting Order ARTIS one

This section discusses the sorting algorithms for Artis within the patient browser and directory overview.

8.7.1 Identification of Images

Original acquired images are identified by the following attribute contents:
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Table 74 - Attributes for Identification of Original Images

Attribute Name

Tag

Value

Image Type

(0008,0008)

ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A
ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A \PERI\\n
ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A \DYNA\MASK
ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A \DYNA\INJECTION
ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A \DYNAIFILL
ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A \DYNA\WASHOUT
ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\3D ACQ\DR
ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\3D ACQ\DSA
DERIVED\PRIMARY\SINGLE PLANE\SINGLE A\STORE FLUORO
DERIVED\PRIMARY\SINGLE PLANE\SINGLE A\AROADMAP

Series Time

(0008,0031)

Same as Acquisition Time

Acquisition Time

(0008,0032)

Time the acquisition of this image was performed

Content Time

(0008,0033)

Same as Acquisition Time (rule for acquired images)

Series Number

(0020,0011)

Same as Acquisition Number

Acquisition Number

(0020,0012)

Counts number of acquisitions. All images created during perfor-
mance of this acquisition have the same number.

Instance Number

(0020,0013)

“1-based” counter for images. Indicates the creation order within the
acquisition.

Store Monitor images, derived from original images or Fluoro LIH, are identified by the following attribute contents:

Table 75 - Attributes for Identification of Store Monitor Images

Attribute Name

Tag

Value

Image Type

(0008,0008)

DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\STORE MONITOR

Series Time

(0008,0031)

Same as Acquisition Time. Store Monitor is in same series.

Acquisition Time

(0008,0032)

Time the acquisition of the original image was performed

Content Time

(0008,0033)

Time this image was created (Store Monitor was performed)

Series Number

(0020,0011)

Same Number as Acquisition Number. (Reference to original Image)

Acquisition Number

(0020,0012)

Counts number of acquisitions. Refers to the acquisition number of
the original image where this image was derived from.

Instance Number

(0020,0013)

"300-based" counter for images. Indicates the creation order of Store
Monitor Reference images within this series

Store Reference images, derived from original images or Fluoro LIH, are identified by the following attribute contents:

Table 76 - Attributes for Identification of Store Ref Images

Attribute Name Tag Value
Image Type (0008,0008) | DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\REFIMAGE
Series Time (0008,0031) | Same as Acquisition Time. Store Reference image is in same series.

Acquisition Time

(0008,0032)

Time the acquisition of the original image was performed
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8.7.2

Attribute Name

Tag

Value

Content Time

(0008,0033)

Time this image was created (Store Reference image was performed)

Series Number

(0020,0011)

Same Number as Acquisition Number. (Reference to original Image)

Acquisition Number

(0020,0012)

Counts number of acquisitions. Refers to the acquisition number of
the original image where this image was derived from.

Instance Number

(0020,0013)

"100-based" counter for images. Indicates the creation order of Store
Reference images within this series

Quant Report images, derived from original images or Fluoro LIH, are identified by the following attribute contents:

Table 77 - Attributes for Identification of Quant Report Images

Attribute Name

Tag

Value

Image Type

(0008,0008)

DERIVED\SECONDARY\SINGLE PLANE\SINGLE A\QUANT

Series Time

(0008,0031)

Time this Quant image was created (Quant was performed)

Acquisition Time

(0008,0032)

Time the acquisition of the original image was performed

Content Time

(0008,0033)

Time this Quant image was created (Quant was performed)

Series Number

(0020,0011)

Same Number as Acquisition Number. (Reference to original Image)

Acquisition Number

(0020,0012)

Counts number of acquisitions. Refers to the acquisition number of
the original image where this image was derived from.

Instance Number

(0020,0013)

"1-based" counter for images. Quant Reports are stored in new series.

EXAM PROTOCOL as XA image, created during transfer of X-Ray Radiation Dose SR, is identified by the following attrib-

ute contents:

Table 78 - Attributes for Identification of EXAM Protocol XA Image

Attribute Name Tag Value
Image Type (0008,0008) | ORIGINAL\PRIMARY\SINGLE PLANE\SINGLE A\EXAM PROTOCOL
SOP Class UID (0008,0016) [ 1.2.840.10008.5.1.4.1.1.12.1
Series Time (0008,0031) | Exam Protocol is allocated with Patient Registration.

Acquisition Time

(0008,0032)

Time this protocol was created (i.e. transferred)

Content Time

(0008,0033)

Time this protocol was created (i.e. transferred)

Series Number

(0020,0011)

Fixed value of "999"

Acquisition Number

(0020,0012)

Fixed value of "999"

Instance Number

(0020,0013)

Fixed value of "999"

ARTIS one has implemented sorting algorithms to display DICOM objects in the directory overview in a specific order.

The Sorting Algorithms of the Artis Viewer

Sorting/Grouping in the Viewer Directory Overview occurs according the following rules:

1. Sort by Series Number

2. If Series Number matches: Group on Series Number, Sort by Instance Number
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3. If Series Number and Instance Number each match: Group on Series Number, Sort by Content Time

In the case, that the user has selected "Scenes + Ref Images" or "Scenes + Store Monitor", the reference images or the
store monitor images follow directly the image they had been derived from.

Example 1:

Patient "Test 1" with one Study, three Series with one acquired image, three Store Monitor Images and one Reference
Image in each Series. "Scenes" is selected under the "Dir Overview" button => only the acquired images are displayed.

Patient “Test 1"

Table 79 - Viewer image ordering - simple case

Study 1 Study 1 Study 1
Series 1 Series 2 Series 3
Image 1 Image 1 Image 1

Acquired Image

Store Monitor Image

Store Reference Image
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Example 2:

Patient "Test 2" with one Study, three Series with one acquired image, three Store Monitor Images and one Reference
Image in each Series. "Scenes + Ref Images" is selected under the "Dir Overview" button => the acquired images and the
corresponding reference images are displayed.

Patient “Test 2"

Table 80 - Viewer image ordering - with Reference images

Study 1 Study 1

Series 1 Series 2

Image 1 Image 1

Study 1

Series 3

Image 1

Acquired Image

Store Monitor Image
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Example 3:

Patient "Test 3" with one Study, three Series with one acquired image, three Store Monitor Images and one Reference
Image in each Series. "Scenes + Store Monitor" is selected under the "Dir Overview" button => the acquired images and
the corresponding store monitor images are displayed.

Patient “Test 3"

Table 81 - Viewer image ordering - with Store Monitor images

Study 1 Study 1 Study 1 Study 1
Series 1 Series 1 Series 1 Series 1
Image 1 Image 300 Image 301 Image 302
Study 1 Study 1 Study 1 Study 1
Series 2 Series 2 Series 2 Series 2
Image 1 Image 300 Image 301 Image 302
Study 1 Study 1 Study 1 Study 1
Series 3 Series 3 Series 3 Series 3
Image 1 Image 300 Image 301 Image 302

Acquired Image

Store Monitor Image

Store Reference Image
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Example 4:

For Scene #2 of Patient "Test 3" now a Quant Report is performed. According to Example 3, the Overview now sorts as

follows:

Patient “Test 3"

Table 82 - Viewer image ordering - Store Monitor and Quant images

Study 1 Study 1 Study 1 Study 1
Series 1 Series 1 Series 1 Series 1
Image 1 Image 300 Image 301 Image 302
Study 1 Study 1 Study 1 Study 1
Series 2 Series Series 2 Series 2
Image 1 2(Quant) Image 300 Image 301
Image

Study 1 Study 1 Study 1 Study 1
Series 2 Series 3 Series 3 Series 3
Image 302 Image 300 Image 301 Image 302
Study 1

Series 3

Image 1

Acquired Image

Store Monitor Image

Store Reference Image

Quant Report Image

8.7.3 The Sorting Algorithms of the Artis Browser

Besides the default sorting criteria, Artis supports the following sorting algorithms for the patient browser.

The default syngo sorting settings are as follows

= Artis displays images - within a Series - with the order they had been acquired
= Artis displays Series - within a Study - with the order they had been acquired

= Artis displays Studies - within a Patient - with the order they had been acquired

Therefore, the Quant Report Series will not necessarily be displayed adjacent to the original scene, if created later at the

end of all scenes.
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8.8  Supported Matrix Sizes of ARTIS one

Depending on detector mode the ARTIS one supports different matrix sizes. These matrix sizes are also used by the Stor-
age AE when sending the images to a remote SCP. Additionally, it is possible to send images resized/processed to
512x512 and 1024x1024 and 1200x1200.

Table 83 - ARTIS one uses following original Matrix Sizes

Detector Size Rows Columns
(0028,0010) (0028,0011)

FD 26x30 1560 1424
1424 1560

1216 1216

960 960

776 776

776 712

712 776

608 608

520 472

472 520

480 480

424 424

384 352

352 384

8.9 DICOM Print SCU - detailed status displays

The following tables document the behavior of the ARTIS one DICOM Print AE in response to messages received for the
Printer SOP Class and the Print Job SOP Class.

Definition of camera symbols:

= |dle: Camera is installed and ready; idle icon is displayed.

= |Interact: The user has to react in near future, but not immediately.
Example: A camera was low in 8x10 clear sheets: LOW 8x10 CLR was sent by N-EVENT-REPORT.

=  Queue Stopped: The user has to react immediately. Either the camera needs immediate interaction, or a job has been
aborted.
Example: A camera is out of 8x10 clear sheets, or camera is down, or a film job is aborted

Note: different camera symbols are displayed according to the Printer Status Info.
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8.9.1

Common Status Information

Table 84 - Print SCU Common Status Information

Printer Status Info/

Execution Status
Info

Description

Message string visi-
ble in ‘Status Bar’

Other action for UI/
‘camera symbol’

NORMAL

Camera is ready

Camera is ready

<None>/idle

BAD RECEIVE MGZ

There is a problem with the film re-
ceive magazine. Films from the
printer cannot be transported into
the magazine.

Problem with receive
magazine.

<None>/interact

There is a problem with the film
supply magazine. Films from this

Problem with supply

for normal operation shortly.

wait.

BAD SUPPLY MGZ . . <None>/interact
magazine cannot be transported magazine.
into the printer.
Printer is performing self-calibra- _—

CALIBRATING tion; it is expected to be available Self-calibration. Please <None>/idle

CALIBRATION ERR

An error in the printer calibration
has been detected, quality of pro-
cessed films may not be optimal.

Problem in calibration.
Film quality may not
be optimal.

<None>/interact

CHECK CHEMISTRY

A problem with the processor
chemicals has been detected, qual-
ity of processed films may not be
optimal.

Problem with chemis-
try.

Film quality may not
be

optimal.

<None>/interact

CHECK SORTER

There is an error in the film sorter

Error in film sorter.

<None>/interact

CHEMICALS EMPTY

There are no processing chemicals
in the processor, films will not be
printed and processed until the pro-
cessor is back to normal.

Camera chemistry
empty. Please check.

<None>/interact

CHEMICALS LOW

The chemical level in the processor
is low, if not corrected, it will prob-
ably shut down soon.

Camera chemistry low.
Please check.

<None>/interact

COVER OPEN

One or more printer or processor
covers, drawers, doors are open.

Camera cover, drawer
or door open.

<None>/interact

ELEC CONFIG ERR

Printer configured improperly for
this job.

Camera configured im-
properly for this job.
Queue stopped.

Queue for this cam-
era will be
STOPPED/

Queue stopped

ELEC DOWN

Printer is not operating due to
some unspecified electrical hard-
ware problem.

Camera electrical hard-
ware Problem.

<None>/interact

ELEC SW ERROR

Printer not operating for some un-
specified software error.

Camera software prob-
lem.
Queue stopped.

Queue for this cam-
era will be
STOPPED/

Queue stopped

EMPTY 8x10

The 8x10 inch film supply maga-
zine is empty.

8x10 film supply
empty.

<None>/interact
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Printer Status Info/

Execution Status
Info

Description

Message string visi-
ble in ‘Status Bar’

Other action for Ul/
‘camera symbol’

EMPTY 8x10 BLUE

The 8x10 inch blue film supply
magazine is empty.

8x10 blue film supply
empty.

<None>/interact

EMPTY 8x10 CLR

The 8x10 inch clear film supply
magazine is empty.

8x10 clear film supply
empty.

<None>/interact

EMPTY 8x10 PAPR

The 8x10 inch paper supply maga-
zine is empty.

8x10 paper supply
empty.

<None>/interact

EMPTY 10x12

The 10x12 inch film supply maga-
zine is empty.

10x12 film supply
empty.

<None>/interact

EMPTY 10x12 BLUE

The 10x12 inch blue film supply
magazine is empty.

10x12 blue film supply
empty.

<None>/interact

EMPTY 10x12 CLR

The 10x12 inch clear film supply
magazine is empty.

10x12 clear film supply
empty.

<None>/interact

EMPTY 10x12 PAPR

The 10x12 inch paper supply maga-
zine is empty.

10x12 paper supply
empty.

<None>/interact

EMPTY 10x14

The 10x14 inch film supply maga-
zine is empty.

10x14 film supply
empty.

<None>/interact

EMPTY 10x14 BLUE

The 10x14 inch blue film supply
magazine is empty.

10x14 blue film supply
empty.

<None>/interact

EMPTY 10x14 CLR

The 10x14 inch clear film supply
magazine is empty.

10x14 clear film supply
empty.

<None>/interact

EMPTY 10x14 PAPR

The 10x14 inch paper supply maga-
zine is empty.

10x14 paper supply
empty.

<None>/interact

EMPTY 11x14

The 11x14 inch film supply maga-
zine is empty.

11x14 film supply
empty.

<None>/interact

EMPTY 11x14 BLUE

The 11x14 inch blue film supply
magazine is empty.

11x14 blue film supply
empty.

<None>/interact

EMPTY 11x14 CLR

The 11x14 inch clear film supply
magazine is empty.

11x14 clear film supply
empty.

<None>/interact

EMPTY 11x14 PAPR

The 11x14 inch paper supply maga-
zine is empty.

11x14 paper supply
empty.

<None>/interact

EMPTY 14x14

The 14x14 inch film supply maga-
zine is empty.

14x14 film supply
empty.

<None>/interact

EMPTY 14x14 BLUE

The 14x14 inch blue film supply
magazine is empty.

14x14 blue film supply
empty.

<None>/interact

EMPTY 14x14 CLR

The 14x14 inch clear film supply
magazine is empty.

14x14 clear film supply
empty.

<None>/interact

EMPTY 14x14 PAPR

The 14x14 inch paper supply maga-
zine is empty.

14x14 paper supply
empty.

<None>/interact

EMPTY 14x17

The 14x17 inch film supply maga-
zine is empty.

14x17 film supply
empty.

<None>/interact

EMPTY 14x17 BLUE

The 14x17 inch blue film supply
magazine is empty.

14x17 blue film supply
empty.

<None>/interact
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Printer Status Info/

Execution Status
Info

Description

Message string visi-
ble in ‘Status Bar’

Other action for Ul/
‘camera symbol’

EMPTY 14x17 CLR

The 14x17 inch clear film supply
magazine is empty.

14x17 clear film supply
empty.

<None>/interact

EMPTY 14x17 PAPR

The 14x17 inch paper supply maga-
zine is empty.

14x17 paper supply
empty.

<None>/interact

EMPTY 24x24

The 24x24 inch film supply maga-
zine is empty.

24x24 film supply
empty.

<None>/interact

EMPTY 24x24 BLUE

The 24x24 inch blue film supply
magazine is empty.

24x24 blue film supply
empty.

<None>/interact

EMPTY 24x24 CLR

The 24x24 inch clear film supply
magazine is empty.

24x24 clear film supply
empty.

<None>/interact

EMPTY 24x24 PAPR

The 24x24 inch paper supply maga-
zine is empty.

24x24 paper supply
empty

<None>/interact

EMPTY 24x30

The 24x30 inch film supply maga-
zine is empty.

24x30 film supply
empty.

<None>/interact

EMPTY 24x30 BLUE

The 24x30 inch blue film supply
magazine is empty.

24x30 blue film supply
empty.

<None>/interact

EMPTY 24x30 CLR

The 24x30 inch clear film supply
magazine is empty.

24x30 clear film supply
empty.

<None>/interact

EMPTY 24x30 PAPR

The 24x30 inch paper supply maga-
zine is empty.

24x30 paper supply
empty.

<None>/interact

EMPTY A4 PAPR

The A4 paper supply magazine is
empty.

A4 paper supply empty

<None>/interact

EMPTY A4 TRANS

The A4 transparency supply maga-
zine is empty.

A4 transparency sup-
ply empty.

<None>/interact

EXPOSURE FAILURE

The exposure device has failed due
to some unspecified reason.

Exposure device has
failed.

<None>/interact

FILM JAM

A film transport error has occurred
and a film is jammed in the printer
Or processor.

Film jam.

<None>/interact

FILM TRANSP ERR

There is a malfunction with the film
transport, there may or may not be
a film jam.

Film transport prob-
lem.

<None>/interact

FINISHER EMPTY

The finisher is empty.

Finisher is empty.

<None>/interact

FINISHER ERROR

The finisher is not operating due to
some unspecified reason

Finisher problem.

<None>/interact

FINISHER LOW

The finisher is low on supplies.

Finisher low.

<None>/interact

LOW 8x10

The 8x10 inch film supply maga-
zine is low.

8x10 film supply low.

<None>/interact

LOW 8x10 BLUE

The 8x10 inch blue film supply
magazine is low.

8x10 blue film supply
low.

<None>/interact

LOW 8x10 CLR

The 8x10 inch clear film supply
magazine is low.

8x10 clear film supply
low.

<None>/interact
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Printer Status Info/

Execution Status
Info

Description

Message string visi-
ble in ‘Status Bar’

Other action for Ul/
‘camera symbol’

LOW 8x10 PAPR

The 8x10 inch paper supply maga-
zine is low.

8x10 paper supply
low.

<None>/interact

LOW 10x12

The 10x12 inch film supply maga-
zine is low.

10x12 film supply low.

<None>/interact

LOW 10x12 BLUE

The 10x12 inch blue film supply
magazine is low.

10x12 blue film supply
low.

<None>/interact

LOW 10x12 CLR

The 10x12 inch clear film supply
magazine is low.

10x12 clear film supply
low.

<None>/interact

LOW 10x12 PAPR

The 10x12 inch paper supply maga-
zine is low.

10x12 paper supply
low.

<None>/interact

LOW 10x14

The 10x14 inch film supply maga-
zine is low.

10x14 film supply low.

<None>/interact

LOW 10x14 BLUE

The 10x14 inch blue film supply
magazine is low.

10x14 blue film supply
low.

<None>/interact

LOW 10x14 CLR

The 10x14 inch clear film supply
magazine is low.

10x14 clear film supply
low.

<None>/interact

LOW 10x14 PAPR

The 10x14 inch paper supply maga-
zine is low.

10x14 paper supply
low.

<None>/interact

LOW 11x14

The 11x14 inch film supply maga-
zine is low.

11x14 film supply low.

<None>/interact

LOW 11x14 BLUE

The 11x14 inch blue film supply
magazine is low.

11x14 blue film supply
low.

<None>/interact

LOW 11x14 CLR

The 11x14 inch clear film supply
magazine is low.

11x14 clear film supply
low.

<None>/interact

LOW 11x14 PAPR

The 11x14 inch paper supply maga-
zine is low.

11x14 paper supply
low.

<None>/interact

LOW 14x14

The 14x14 inch film supply maga-
zine is low.

14x14 film supply low.

<None>/interact

LOW 14x14 BLUE

The 14x14 inch blue film supply
magazine is low.

14x14 blue film supply
low.

<None>/interact

LOW 14x14 CLR

The 14x14 inch clear film supply
magazine is low.

14x14 clear film supply
low.

<None>/interact

LOW 14x14 PAPR

The 14x14 inch paper supply maga-
zine is low.

14x14 paper supply
low.

<None>/interact

LOW 14x17

The 14x17 inch film supply maga-
zine is low.

14x17 film supply low.

<None>/interact

LOW 14x17 BLUE

The 14x17 inch blue film supply
magazine is low.

14x17 blue film supply
low.

<None>/interact

LOW 14x17 CLR

The 14x17 inch clear film supply
magazine is low.

14x17 clear film supply
low.

<None>/interact

LOW 14x17 PAPR

The 14x17 inch paper supply maga-
zine is low.

14x17 paper supply
low.

<None>/interact
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Printer Status Info/

Message string visi-

Other action for Ul/

zine is low.

Execution Status Description ble in ‘Status Bar’ ) )
camera symbol

Info
LOW 24x24 The 24x24 inch film supply maga- 24x24 film supply low. <None>/interact

LOW 24x24 BLUE

The 24x24 inch blue film supply
magazine is low.

24x24 blue film supply
low.

<None>/interact

LOW 24x24 CLR

The 24x24 inch clear film supply
magazine is low.

24x24 clear film supply
low.

<None>/interact

LOW 24x24 PAPR

The 24x24 inch paper supply maga-
zine is low.

24x24 paper supply
low.

<None>/interact

LOW 24x30

The 24x30 inch film supply maga-
zine is low.

24x30 film supply low.

<None>/interact

LOW 24x30 BLUE

The 24x30 inch blue film supply
magazine is low.

24x30 blue film supply
low.

<None>/interact

LOW 24x30 CLR

The 24x30 inch clear film supply
magazine is low.

24x30 clear film supply
low.

<None>/interact

LOW 24x30 PAPR

The 24x30 inch paper supply maga-
zine is low.

24x30 paper supply
low.

<None>/interact

LOW A4 PAPR

The A4 paper supply magazine is
low.

A4 paper supply low.

<None>/interact

LOW A4 TRANS

The A4 transparency supply maga-
zine is low..

A4 transparency sup-
ply low.

<None>/interact

NO RECEIVE MGZ

The film receive magazine is not
available.

Film receiver not avail-
able.

<None>/interact

NO RIBBON

The ribbon cartridge needs to be re-
placed.

Replace ribbon car-
tridge.

<None>/interact

NO SUPPLY MGZ

The film supply magazine is not
available.

Film supply not availa-
ble.

<None>/interact

CHECK PRINTER

The printer is not ready at this time,
operator intervention is required to
make the printer available.

Check camera.

<None>/interact

CHECK PROC

The processor is not ready at this
time, operator intervention is re-
quired to make the printer availa-
ble.

Check processor.

<None>/interact

PRINTER DOWN

The printer is not operating due to
some unspecified reason.

Camera down.

<None>/interact

PRINTER INIT

The printer is not ready at this time,
it is expected to become available
without intervention. For example,
it may be in a normal warm-up
state.

Camera initializing.

<None>/ldle

PRINTER OFFLINE

The printer has been disabled by an
operator or service person.

Camera off-line.

<None>/interact

PROC DOWN

The processor is not operating due
to some unspecified reason.

Processor down.

<None>/interact
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8.9.2

Printer Status Info/

Message string visi-

Other action for Ul/

example, it may be in a normal
warm-up state.

Execution Status Description ble in "Status Bar’ , ,
Info camera symbol
The processor is not ready at this
time, it is expected to become
PROC INIT available without intervention. For | Processor initializing. <None>/ldle

PROC OVERFLOW FL

Processor chemicals are approach-
ing the overflow full mark.

Processor chemicals
near overflow.

<None>/interact

PROC OVERFLOW HI

Processor chemicals have reached
the overflow full mark.

Processor chemicals
overflow.

<None>/interact

QUEUED

Print job in Queue

<None>/ldle

RECEIVER FULL

The film receive magazine is full.

Receiver full.

<None>/interact

REQ MED NOT INST

media supply magazine is not in-
stalled in the printer but may be
available with operator interven-
tion.

The requested film, paper, or other

Install media supply.

<None>/interact

REQ MED NOT AVAI

The requested film, paper, or
other media requested is not
available on this printer.

able on this camera.
Queue stopped.
Change camera.

Media supply not avail-

Queue for this cam-
era will be
STOPPED/

Queue stopped

RIBBON ERROR

There is an unspecified problem
with the print ribbon.

Error with print ribbon.

<None>/interact

with camera.

SUPPLY EMPTY The printer is out of film. Camera out of film. <None>/interact

SUPPLY LOW The film supply is low. Film supply low. <None>/interact
. o Unspecified problem .

UNKNOWN There is an unspecified problem. <None>/interact

Additional DICOM Execution Status Information

Table 85 - Print SCU additional DICOM Execution Status Info evaluation

Printer Status Info/

Execution Status
Info

Description

Message string visi-
ble in ‘Status Bar’

Other action for Ul/
‘camera symbol’

INVALID PAGE DES

The specified page layout cannot
be printed, or other page descrip-
tion errors have been detected.

Film Job cannot be
printed on this camera.
Queue stopped. Please
redirect film job.

Queue for this cam-
era will be
STOPPED/

Queue stopped

INSUFFICIENT
MEMORY

There is not enough memory avail-
able to complete this job.

Not enough memory
available in camera.
Queue stopped. Please
continue queue or
change camera.

Queue for this cam-
era will be
STOPPED/

Queue stopped
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Printer Status Infof _ Mess.ag’e string visi- Other action for Ul/
Execution Status Description ble in ‘Status Bar’

Info

‘camera symbol’

General printer warning, no specific
NONE information is available. Spooling -- <None>/ldle
of print jobs to disk is still possible.

8.9.3 Unknown DICOM Execution Status Information

Printer Status Info and Execution Status Info are defined terms and can therefore be extended or reduced by camera
manufacturers. Therefore ARTIS one Print AE shall be flexible.

If any other printer status info or execution status info is received, ARTIS one will react as shown in the following table:

Table 86 - Print SCU Unknown DICOM Execution Status Information

Printer Sta- . . Message string | Other action for
tus/ Prln;irtl EXIECfUtlon Description visible in the ul/
atus Info .
Execution HCD Status Bar' | «;mera symbol’
WARNING <any other> <not defined status info> Camera ‘Info: <nonelinteract>
<status info>
Camera Info: Sauri:‘fafgvl}ltlhlalz
FAILURE <any other> <not defined status info> | <status info>
Queue stopped STOPPED/
PP Queue stopped
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9 Annex Software Applications

9.1 Created SOP Instances

9.1.1 Common Modules

9.1.1.1 Supported attributes on Patient Level

The ARTIS one copies the listed attributes — if provided — from original images.

Table 87: Patient level attributes

Attribute Name Tag

Referenced Patient Sequence | (0008,1120)

>Referenced SOP Class UID (0008,1150)

>Referenced SOP Instance UID | (0008,1155)

Patient’s Name (0010,0010)
Patient ID (0010,0020)
Patient’s Birth Date (0010,0030)
Patient’s Sex (0010,0040)
Other Patient IDs (0010,1000)
Other Patient Names (0010,1001)

Other Patient IDs Sequence (0010,1002)

>Patient ID (0010,0020)
>Issuer of Patient ID (0010,0021)
>Type of Patient ID (0010,0022)
Ethnic Group (0010,2160)
Patient Comments (0010,4000)

9.1.1.2 Supported attributes on Study level

The ARTIS one copies the listed attributes — if provided — from original images.

Table 88: Study level attributes

Attribute Name Tag
Study Date (0008,0020)
Study Time (0008,0030)

Accession Number

(0008,0050)

Referring Physician’s Name

(0008,0090)

Study Description

(0008,1030)
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Attribute Name Tag

Procedure Code Sequence (0008,1032)

>Code Value (0008,0100)

>Coding Scheme Designator (0008,0102)

>Code Meaning (0008,0104)

Physician(s) of Record (0008,1048)

Admitting Diagnoses Description | (0008,1080)

Referenced Study Sequence (0008,1110)

>Referenced SOP Class UID (0008,1150)

>Referenced SOP Instance UID (0008,1155)

Patient's Age (0010,1010)
Patient’s Size (0010,1020)
Patient's Weight (0010,1030)
Occupation (0010,2180)
Additional Patient History (0010,21B0)
Study Instance UID (0020,000D)
Study ID (0020,0010)

9.1.2 SC Standard Extended SOP Class

The ARTIS one will create functional images from special applications. Those will be encoded as SC Standard extended
SOP Class. Please see the following tables for a complete overview of supplied Type 1/2/3 Standard and Private attrib-
utes.

9.1.2.1 Captured Projection Image

Table 89: SC Derived Image (RGB) from 3D Projections

Attribute Name Tag Value

Attributes according to 9.1.1.1 Supported attributes on Patient level

Attributes according to 9.1.1.2 Supported attributes on Study level

Specific Character Set (0008,0005) | from Original

DERIVED\SECONDARY\OTHER\IAE_PRJ\
<Filter_Type>

<Filter_Type> values:
MPR

MIP

MINIP

VRT

OVERVIEW

Image Type (0008,0008)

Instance Creation Date (0008,0012) | <yyyymmdd>

Instance Creation Time (0008,0013) | <hhmmss.ffffff>
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Attribute Name

Tag

Value

Instance Creator UID

(0008,0014)

<implementation_class_uid>.<individual_id>

SOP Class UID

(0008,0016)

1.2.840.10008.5.1.4.1.1.7

SOP Instance UID

(0008,0018)

Series Date (0008,0021) | <yyyymmdd>
Acquisition Date (0008,0022) | from Original
Content Date (0008,0023) | <yyyymmdd>
Acquisition DateTime (0008,002A) | from Original

Series Time

(0008,0031)

<hhmmess.ffffff>

Acquisition Time

(0008,0032)

from Original

Content Time

(0008,0033)

<hhmmss.ffffff>

Modality (0008,0060) | OT or XA or CT (default = OT, can be configured)
Conversion Type (0008,0064) | WSD
Manufacturer (0008,0070) | from Original

Institution Name

(0008,0080)

from WS Configuration

Institution Address

(0008,0081)

from WS Configuration

Station Name

(0008,1010)

from WS Configuration

Series Description

(0008,103E)

Institutional Department Name

(0008,1040)

from WS Configuration

Performing Physician’s Name

(0008,1050)

from Original / input via "Correct” possible

Operator's Name (0008,1070) | from Original
Manufacturer’'s Model Name (0008,1090) | from Original
Related Series Sequence (0008,1250) | from Original
>Study Instance UID (0020,000D) | from Original
>Series Instance UID (0020,000E) | from Original

>Purpose of Reference Code Se-
quence

(0040,A170)

<zero length>

Derivation Description

(0008,2111)

from Original

Source Image Sequence

(0008,2112)

if derived from single image

Body Part Examined

(0018,0015)

from Original

Device Serial Number

(0018,1000)

from Original

Secondary Capture Device ID

(0018,1010)

from WS Configuration

Date of Secondary Capture

(0018,1012)

<yyyymmdd>

Time of Secondary Capture

(0018,1014)

<hhmmss.ffffff>

Body Part Examined

(0018,0015)

from Original
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Attribute Name

Tag

Value

Secondary Capture Device Manu-
facturer

(0018,1016)

“Siemens”

Secondary Capture Device Manu-
facturer's Model Name

(0018,1018)

from WS Configuration

Secondary Capture Device Soft-
ware Version

(0018,1019)

from WS Configuration

Software Versions (0018,1020) | from Original
Protocol Name (0018,1030) | from Original
Patient Position (0018,5100) | from Original
Series Instance UID (0020,000E)

Series Number (0020,0011) | 970
Acquisition Number (0020,0012) | from Original

Instance Number

(0020,0013)

n-m (n, m >0)
0 for reference image

Patient Orientation

(0020,0020)

from original (derived from single image) or calculated or <zero
length> (derived from multiple images).

Images in Acquisition

(0020,1002)

from Original

Image Comments

(0020,4000)

from Original if derived from single image

Samples per Pixel (0028,0002) | 3
Photometric Interpretation (0028,0004) | RGB
Planar Configuration (0028,0006) | O

Rows (0028,0010)

Columns (0028,0011)

Pixel Spacing (0028,0030) | If image has been calibrated
Bits Allocated (0028,0100) | 8

Bits Stored (0028,0101) | 8

High Bit (0028,0102) | 7

Pixel Representation (0028,0103) |0

Burned In Annotation

(0028,0301)

YES, if set to YES in Original or if any text flag is set to “On”. Not set
otherwise.

Pixel Spacing Calibration Type

(0028,0A02)

from Original

Pixel Spacing Calibration Descrip-
tion

(0028,0A04)

from Original

Lossy Image Compression

(0028,2110)

from Original

Performed Procedure Step Start
Date

(0040,0244)

from Original

Performed Procedure Step Start
Time

(0040,0245)

from Original
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Attribute Name Tag Value
Performed Procedure Step ID (0040,0253) | from Original
tPizrr:‘ormed Procedure Step Descrip- (0040,0254) | from Original
Performed Protocol Code Se- (0040,0260) | from Original
guence
Request Attributes Sequence (0040,0275) | from Original
>S§h§duled Procedure Step De- (0040,0007) | from Original
scription
>Scheduled Procedure Step ID (0040,0009) | from Original
>Requested Procedure ID (0040,1001) | from Original
>Reason For The Requested Proce- (0040,1002) | from Original
dure
Comments on the Performed Pro- (0040,0280) | from Original
cedure Step
Pixel Data (7FE0,0010)

9.1.2.2 Bookmarks

Table 90: SC Derived Image (RGB) for 4D Viewer Bookmarks

Attribute Name Tag Value

Attributes according to 9.1.1.1 Supported attributes on Patient level

Attributes according to 9.1.1.2 Supported attributes on Study level

Specific Character Set (0008,0005) | from Original

Image Type (0008,0008) | DERIVED\SECONDARY\OTHER\IAE_BOOKMARK

Instance Creation Date (0008,0012) | <yyyymmdd>

Instance Creation Time (0008,0013) | <hhmmess.ffffff>

Instance Creator UID (0008,0014) | <implementation_class_uid>.<individual_id>

SOP Class UID (0008,0016) | 1.2.840.10008.5.1.4.1.1.7

SOP Instance UID (0008,0018)

Series Date (0008,0021) | <yyyymmdd>
Acquisition Date (0008,0022) | from Original
Content Date (0008,0023) | <yyyymmdd>
Acquisition DateTime (0008,002A) | from Original

Series Time

(0008,0031)

<hhmmess.ffffff>

Acquisition Time

(0008,0032)

from Original

Content Time

(0008,0033)

<hhmmess.ffffff>

Modality

(0008,0060)

XA

Conversion Type

(0008,0064)

WSD
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Attribute Name

Tag

Value

Manufacturer

(0008,0070)

from Original

Institution Name

(0008,0080)

from WS Configuration

Institution Address

(0008,0081)

from WS Configuration

Station Name

(0008,1010)

from WS Configuration

Series Description

(0008,103E)

Institutional Department Name

(0008,1040)

from WS Configuration

Performing Physician’s Name

(0008,1050)

from Original / Input via "Correct” possible

Operator's Name (0008,1070) | from Original
Manufacturer’'s Model Name (0008,1090) | from Original
Related Series Sequence (0008,1250) | from Original
>Study Instance UID (0020,000D) | from Original
>Series Instance UID (0020,000E) | from Original

>Purpose of Reference Code Se-
quence

(0040,A170)

<zero length>

Derivation Description

(0008,2111)

from Original

Source Image Sequence

(0008,2112)

If derived from single image

Device Serial Number

(0018,1000)

from Original

Secondary Capture Device ID

(0018,1010)

from WS Configuration

Date of Secondary Capture

(0018,1012)

<yyyymmdd>

Time of Secondary Capture

(0018,1014)

<hhmmess.ffffff>

Body Part Examined

(0018,0015)

from Original

Secondary Capture Device Manu-
facturer

(0018,1016)

“Siemens”

Secondary Capture Device Manu-
facturer's Model Name

(0018,1018)

from WS Configuration

Secondary Capture Device Soft-
ware Version

(0018,1019)

from WS Configuration

Software Versions (0018,1020) | from Original
Protocol Name (0018,1030)
Patient Position (0018,5100) | from Original

Private Creator

(0019,00xx)

“SIEMENS SMS-AX IAE”

Attributes according to 9.2 Data Dic

tionary of Private Attributes

Series Instance UID

(0020,000E)

Series Number (0020,0011) | 980
Acquisition Number (0020,0012) | from Original
Instance Number (0020,0013) [1-n
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Attribute Name

Tag

Value

Patient Orientation

(0020,0020)

From original (derived from single image) or calculated or <zero
length> (derived from multiple images).

Images in Acquisition

(0020,1002)

from Original

Image Comments

(0020,4000)

from Original if derived from single image

Samples per Pixel (0028,0002) | 3
Photometric Interpretation (0028,0004) | RGB

Planar Configuration (0028,0006) |0

Rows (0028,0010)

Columns (0028,0011)

Bits Allocated (0028,0100) | 8

Bits Stored (0028,0101) | 8

High Bit (0028,0102) | 7

Pixel Representation (0028,0103) |0

Pixel Spacing Calibration Type (0028,0A02) | from Original
tPiic),(ﬁl Spacing Calibration Descrip- (0028,0A04) | from Original
Lossy Image Compression (0028,2110) | from Original

Private Creator

(0029,00xx)

“SIEMENS MEDCOM HEADER"

Attributes according to 9.2 Data Dic

tionary of Private Attributes

Performed Procedure Step Start

(0040,0244)

from Original

cedure Step

Date

_I;;en:fé)rmed Procedure Step Start (0040,0245) | from Original
Performed Procedure Step ID (0040,0253) | from Original
Performed Procedure Step Descrip- (0040,0254) | from Original
tion ! 9
Performed Protocol Code Se- ..
quence (0040,0260) | from Original
Request Attributes Sequence (0040,0275) | from Original
>Scheduled Procedure Step De- -
scription (0040,0007) | from Original
>Scheduled Procedure Step ID (0040,0009) | from Original
>Requested Procedure ID (0040,1001) | from Original
>Reason For The Requested Proce- (0040,1002) | from Original
dure ' 9
Comments on the Performed Pro- (0040,0280) | from Original

Pixel Data

(7FE0,0010)

Representative image icon.
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9.1.3 CT Standard Extended SOP Class

9.1.3.1 DynaCT Reconstructed Volume Data

The ARTIS one will create 3D volume data-sets from 3D reconstruction application package. Those will be encoded as CT
Standard etendd SOP Class. Please see the following table for a complete overview of supplied Type 1/2/3 Standard and

Private attributes:

Table 91: CT Derived Image (Monochrome) from Reconstruction

Attribute Name

Tag

Value

Attributes according to 9.1.1.1 Supported attributes on Patient level

Attributes according to 9.1.1.2 Supported attributes on Study level

Specific Character Set

(0008,0005)

from Original

Image Type

(0008,0008)

DERIVED\SECONDARY\AXIAL\3DANGIO\<Data_Type>
<Data_Type> values:

NAT_MASK Images acquired w/o contrast media
NAT_FILL Images acquired with contrast media
SUB Subtracted acquisition

PBV "Parenchymal Blood Volume" acq.

Instance Creation Date

(0008,0012)

<yyyymmdd>

Instance Creation Time

(0008,0013)

<hhmmess.ffffff>

SOP Class UID

(0008,0016)

1.2.840.10008.5.1.4.1.1.2 (CT Image Storage)

SOP Instance UID

(0008,0018)

Series Date

(0008,0021)

<yyyymmdd> (date of creation)

Acquisition Date

(0008,0022)

derived from original Acquisition/Content Date

Content Date

(0008,0023)

<yyyymmdd> (date of creation)

Acquisition DateTime

(0008,002A)

from Original or calculated

Series Time

(0008,0031)

<hhmmess.ffffff> (time of creation)

Acquisition Time

(0008,0032)

derived from original Acquisition/Content Time

Content Time

(0008,0033)

<hhmmess.ffffff> (time of creation)

Modality (0008,0060) from Original
Manufacturer (0008,0070) "Siemens"
Institution Name (0008,0080) from Original

Institution Address

(0008,0081)

from Original

Station Name

(0008,1010)

from WS Configuration

Series Description

(0008,103E)

contains information about used reconstruction parame-
ters

Institutional Department Name

(0008,1040)

from WS Configuration

Performing Physician’s Name

(0008,1050)

from Original

Operator's Name

(0008,1070)

from Original
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Attribute Name

Tag

Value

Manufacturer's Model Name

(0008,1090)

"AXIOM-Artis"

Derivation Description

(0008,2111)

applied correction algorithms

Contrast/Bolus Agent

(0018,0010)

from Original

Body Part Examined

(0018,0015)

from Original

Scan Options

(0018,0022)

for images created by “Gated Cardiac 3D Acquisition”

Slice Thickness

(0018,0050)

calculated

KVP

(0018,0060)

from Original

Device Serial Number

(0018,1000)

from WS Configuration

Gantry ID

(0018,1008)

from WS Configuration

Software Versions

(0018,1020)

from Original\<WS version>\<WS version IAE>

Protocol Name

(0018,1030)

from Original <zoom size(nnn)> <step width(n.nn)>
<dose(nn.nn)> <correction(aaa)>

Reconstruction Diameter

(0018,1100)

set for reconstructed slice

Distance Source to Detector

(0018,1110)

from Original

Contrast/Bolus Ingredient

(0018,1048)

from Original

Date of Last Calibration

(0018,1200)

<yyyymmdd> (date of last 3D calibration)

Time of Last Calibration

(0018,1201)

<hhmmess.ffffff> (time of last 3D calibration)

Convolution Kernel

(0018,1210)

<kernel type>\<lmage characteristics>
Values for kernel type:

"EE" (Default for high contrast)

"HU" (Default for DynaCT)

Values for image characteristics:

"Auto”, "Sharp”, "Normal”, "Smooth", "Very Smooth

Patient Position

(0018,5100)

from Original

Private Creator

(0019,00xx)

“SIEMENS AX DYNACT”

Attributes according to 9.2 Data D

ictionary of Private Attributes

Series Instance UID

(0020,000E)

<new UID>

Series Number

(0020,0011)

from Original

Acquisition Number

(0020,0012)

from Original

Instance Number

(0020,0013)

1 (feet) continuous to number of slices (head)

Patient Orientation

(0020,0020)

<removed>

Image Position (Patient)

(0020,0032)

calculated during reconstruction

Image Orientation (Patient)

(0020,0037)

calculated during reconstruction

Frame of Reference UID

(0020,0052)

<new UID> (per reconstructed image-set)

Laterality

(0020,0060)

from Original

Position Reference Indicator

(0020,1040)

from Original

Private Creator

(0021,00xx)

“SIEMENS SMS-AX ACQ 1.0”
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Attribute Name

Tag

Value

Attributes according to 9.2 Data D

ictionary of Private Attributes

Samples per Pixel

(0028,0002)

1

Photometric Interpretation

(0028,0004)

MONOCHROME2

Rows (0028,0010) 256,512, 768 or 1024.
Columns (0028,0011) 256,512, 768 or 1024.
Pixel Spacing (0028,0030) calculated during reconstruction
Bits Allocated (0028,0100) 16

Bits Stored (0028,0101) 16

High Bit (0028,0102) 15

Pixel Representation (0028,0103) 0

Smallest Image Pixel Value (0028,0106)

Largest Image Pixel Value (0028,0107)

Pixel Padding Value (0028,0120)

Burned In Annotation (0028,0301) NO

Window Center

(0028,1050)

Value from the "Visualization Preset" configuration

Window Width

(0028,1051)

Value from the "Visualization Preset" configuration

Rescale Intercept

(0028,1052)

0.0 or -1024 (only for HU values)

Rescale Slope

(0028,1053)

1

Rescale Type

(0028,1054)

"HU" for Hounsfield Units, only expected with CT
"US" for unspecified

VOI LUT Function

(0028,1056)

Lossy Image Compression (0028,2110) 00

VOI LUT Sequence (0028,3010) from Original
Requested Procedure Description | (0032,1060) from Original
Performed Procedure Step Start (0040,0244) from Original
Date

Pgrformed Procedure Step Start (0040,0245) from Original
Time

Performed Procedure Step ID (0040,0253) from Original
Performed Procedure Step De- (0040,0254) from Original
scription

Performed Protocol Code Se- (0040,0260) from Original
quence

Request Attributes Sequence (0040,0275) from Original
>S§hgduled Procedure Step De- (0040,0007) from Original
scription

>Scheduled Procedure Step ID (0040,0009) from Original
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Attribute Name Tag Value

>Requested Procedure ID (0040,1001) from Original
>Reason For The Requested Pro- (0040,1002) from Original
cedure

Comments on the Performed ..
Procedure Step (0040,0280) from Original
Pixel Data (7FE0,0010)

9.1.3.2 Savelmage as Derived Volume Data

The ARTIS one will store “Save image” functionality based on CT, XR3D or Enhanced CT Images as CT Standard extended
SOP Class.

Please see the following table for complete overview of supplied Type 1/2/3 Standard and Private attributes:

Table 92: Save Image as CT Derived Image (Monochrome)

Attribute Name Tag Value
Attributes according to 9.1.1.1 Supported attributes on Patient level
Attributes according to 9.1.1.2 Supported attributes on Study level
Specific Character Set (0008,0005) From Original or conf. Character Set
DERIVED\SECONDARY\<image type>\<filter type>\\\
<image type> values:
AXIAL
LOCALIZER
Image Type (0008,0008) <filter type> values:
MPR
MIP
MINIP
Instance Creation Date (0008,0012) <yyyymmdd>
Instance Creation Time (0008,0013) <hhmmess.ffffff>
Instance Creator UID (0008,0014) <implementation_class_uid>.<individual_id>
SOP Class UID (0008,0016) 1.2.840.10008.5.1.4.1.1.2 (CT Image Storage)
SOP Instance UID (0008,0018)
Series Date (0008,0021) <yyyymmdd> (date of creation)
Acquisition Date (0008,0022) derived from original Acquisition/Content Date
Content Date (0008,0023) <yyyymmdd> (date of creation)
Acquisition DateTime (0008,002A) derived from original Acquisition Date/Time
Series Time (0008,0031) <hhmmess.ffffff> (time of creation)
Acquisition Time (0008,0032) derived from original Acquisition/Content Time
Content Time (0008,0033) <hhmmess.ffffff> (time of creation)
Modality (0008,0060) from Original
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Attribute Name Tag Value
Manufacturer (0008,0070) from Original
Institution Name (0008,0080) from WS Configuration
Institution Address (0008,0081) from WS Configuration
Station Name (0008,1010) from WS Configuration
Series Description (0008,103E)
Institutional Department Name (0008,1040) from WS Configuration
Performing Physician’s Name (0008,1050) from Original
Manufacturer's Model Name (0008,1090) from Original
Derivation Description (0008,2111) Description of how this image was derived.
0180022
Slice Thickness (0018,0050) calculated
KVP (0018,0060) from Original
Device Serial Number (0018,1000) from Original
Software Versions (0018,1020) from Original
Protocol Name (0018,1030) from Original
Reconstruction Diameter (0018,1100) from Original
Distance Source to Detector (0018,1110) from Original
Date of last Calibration (0018,1200) from Original
Time of last Calibration (0018,1201) from Original
Convolution Kernel (0018,1210) from Original
Patient Position (0018,5100) from Original
Series Instance UID (0020,000E) <new UID>
Series Number (0020,0011) from Original
Acquisition Number (0020,0012) from Original
Instance Number (0020,0013) n-m (n, m >0) )

0 for reference image

Patient Orientation (0020,0020) <removed>
Image Position (Patient) (0020,0032) calculated during reconstruction
Image Orientation (Patient) (0020,0037) calculated during reconstruction
Frame of Reference UID (0020,0052) <new UID>
Laterality (0020,0060) from Original
Position Reference Indicator (0020,1040)
Image Comments (0020,4000)
Samples per Pixel (0028,0002) 1
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Attribute Name Tag Value
Photometric Interpretation (0028,0004) MONOCHROME?2
Rows (0028,0010) 256 0or512
Columns (0028,0011) 256 0r512
Pixel Spacing (0028,0030) calculated during reconstruction
Bits Allocated (0028,0100) from Original
Bits Stored (0028,0101) from Original
High Bit (0028,0102) from Original
Pixel Representation (0028,0103) from Original
Burned In Annotation (0028,0301) from Original
Window Center (0028,1050) as set
Window Width (0028,1051) as set
Rescale Intercept (0028,1052) from Original

Rescale Slope

(0028,1053)

Rescale Type

(0028,1054)

Window Center & Width Explana-
tion

(0028,1055)

VOI LUT Function

(0028,1056)

from Original or may be set by application

Lossy Image Compression (0028,2110) from Original
VOI LUT Sequence (0028,3010) from Original
Requested Procedure Description | (0032,1060) from Original
Study Comments (0032,4000) from Original
Special Needs (0038,0050) from Original
Patient State (0038,0500) from Original
Performed Procedure Step Start (0040,0244) from Original
Date

Pgrformed Procedure Step Start (0040,0245) from Original
Time

Performed Procedure Step ID (0040,0253) from Original
Performed Procedure Step De- | (1544 0754) from Original
scription

Performed Protocol Code Se- (0040,0260) from Original
quence

Request Attributes Sequence (0040,0275) from Original
>S;he_du|ed Procedure Step De- (0040,0007) from Original
scription

>Scheduled Procedure Step ID (0040,0009) from Original
>Requested Procedure ID (0040,1001) from Original

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11

132 of 154




Attribute Name Tag Value
>Reason For The Requested Pro- (0040,1002) from Original
cedure
Comments on the Performed _
Procedure Step (0040,0280) from Original
Confidentiality Constraint on Pa- -
tient Data Description (0040,3001) from Original
Pixel Data (7FE0,0010)

Confidentiality Constraint on Pa- -
tient Data Description (0040,3001) from Original
Pixel Data (7FE0,0010)

9.1.4 MR Standard Extended SOP Class

9.1.4.1 Savelmage as Derived Volume Data

The ARTIS one will store “Save image” functionality based on MR or MR Enhanced Images as MR Standard extended SOP

Class.

Please see the following table for complete overview of supplied Type 1/2/3 Standard and Private attributes:

Table 93: Save Image as MR Derived Image (Monochrome)

Attribute Name

Tag

Value

Attributes according to 9.1.1.1 Supported attributes on Patient level

Attributes according to 9.1.1.2 Supported attributes on Study level

Specific Character Set

(0008,0005)

from Original or conf. Character Set

Image Type

(0008,0008)

DERIVED\SECONDARY\<image type copied from original>\<filter
type>\<copied from original>\<copied from original>\

<image type> values:
Replaced for Localizer image:
OTHER

<filter type> values:

MPR

MIP

MINIP

SOP Class UID

(0008,0016)

1.2.840.10008.5.1.4.1.1.4 (MR Image Storage)

SOP Instance UID

(0008,0018)

Series Date

(0008,0021)

<yyyymmdd> (date of creation)

Acquisition Date

(0008,0022)

derived from original Acquisition/Content Date

Content Date

(0008,0023)

<yyyymmdd> (date of creation)

Acquisition DateTime

(0008,002A)

derived from original Acquisition Date/Time

Series Time

(0008,0031)

<hhmmess.ffffff> (time of creation)

Acquisition Time

(0008,0032)

derived from original Acquisition/Content Time
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Attribute Name

Tag

Value

Content Time

(0008,0033)

<hhmmess. ffffff> (time of creation)

Modality

(0008,0060)

from Original

Manufacturer

(0008,0070)

from Original

Institution Name

(0008,0080)

from WS Configuration

Institution Address

(0008,0081)

from WS Configuration

Station Name

(0008,1010)

from WS Configuration

Series Description

(0008,103E)

Institutional Department
Name

(0008,1040)

from WS Configuration

Performing Physician’s
Name

(0008,1050)

from Original

Manufacturer's Model Name

(0008,1090)

from Original

Derivation Description

(0008,2111)

Description of how this image was derived.

Body Part Examined

(0018,0015)

from Original

Scanning Sequence

(0018,0020)

from Original if original is an MR image, “SE”, “GR”; “SE\GR”, “IR"
or "EP” in case original is an Enhanced MR image

Sequence Variant

(0018,0021)

from Original if original is an MR image; “SP”, “MTC", “SS”, “OSP”
or “SK” in case original is an Enhanced MR image

Scan Options

(0018,0022)

from Original if original is an MR image; “FC", “SP”, “PFP”,
“PFP\PFF”, “CG", "RG" or “FS” in case original is an Enhanced MR
image

MR Acquisition Type (0018,0023) from Original
Slice Thickness (0018,0050) calculated
Repetition Time (0018,0080) from Original
Echo Time (0018,0081) from Original
Inversion Time (0018,0082) from Original
Echo Train Length (0018,0091) from Original
Device Serial Number (0018,1000) from Original
Software Versions (0018,1020) from Original
Protocol Name (0018,1030) from Original
Trigger Time (0018,1060) from Original
Date of last Calibration (0018,1200) from Original
Time of last Calibration (0018,1201) from Original
Patient Position (0018,5100) from Original
Series Instance UID (0020,000E) <new UID>

Series Number

(0020,0011)

Instance Number

(0020,0013)

n-m (n, m >0)
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Attribute Name

Tag

Value

0 for reference image

Patient Orientation

(0020,0020)

<removed>

Image Position (Patient)

(0020,0032)

calculated during reconstruction

Image Orientation (Patient)

(0020,0037)

calculated during reconstruction

Frame of Reference UID (0020,0052) <new UID>
Laterality (0020,0060) from Original
Position Reference Indicator | (0020,1040)

Image Comments (0020,4000)

Samples per Pixel (0028,0002) from Original
Photometric Interpretation (0028,0004) from Original
Rows (0028,0010) 256 or 512
Columns (0028,0011) 256 0r512
Pixel Spacing (0028,0030) calculated during reconstruction
Bits Allocated (0028,0100) from Original
Bits Stored (0028,0101) from Original
High Bit (0028,0102) from Original
Pixel Representation (0028,0103) from Original
Burned In Annotation (0028,0301) from Original
Window Center (0028,1050) as set
Window Width (0028,1051) as set

VOI LUT Function (0028,1056) from Original or may be set by application
Lossy Image Compression (0028,2110) from Original
VOI LUT Sequence (0028,3010) from Original
Efj:jgtne‘j Procedure De- 1 0032,1060) from Original
Study Comments (0032,4000) from Original
Special Needs (0038,0050) from Original
Patient State (0038,0500) from Original
zf:::’g'a‘te: Procedure Step | 5440 0244) from Original
Ete;:?rTTnfg Procedure Step (0040,0245) from Original
rsrformEd Procedure Step | 5441 0253) from Original
Performed Procedure Step (0040,0254) from Original

Description
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Attribute Name

Tag

Value

Performed Protocol Code Se-

on Patient Data Description

(0040,0260) from Original
quence
Request Attributes Se- (0040,0275) from Original
quence
>Scheduled Procedure Step (0040,0007) from Original
Description !
>Scheduled Procedure Step (0040,0009) from Original
ID !
>Requested Procedure ID (0040,1001) from Original
>Reason For The Requested (0040,1002) from Original
Procedure !
Comments on the Per- .
formed Procedure Step (0040,0280) from Original
Confidentiality Constraint -
on Patient Data Description (0040,3001) from Original
Pixel Data (7FE0,0010)
>Requested Procedure ID (0040,1001) from Original
>Reason For The Requested (0040,1002) from Original
Procedure !
Comments on the Per- -
formed Procedure Step (0040,0280) from Original
Confidentiality Constraint (0040,3001) from Original

Pixel Data

(7FEO,0010)

9.15

9.1.5.1 Segmentation Results

Segmentation Standard Extended SOP Class

Table 94: Segmentation Results from 3D Application

Attribute Name

Tag

Value

Attributes according to 9.1.1.1 Supported attributes on Patient level

Attributes according to 9.1.1.2 Supported attributes on Study level

Specific Character Set

(0008,0005)

from WS Configuration

Image Type

(0008,0008)

DERIVED\PRIMARY

Instance Creation Date

(0008,0012)

<yyyymmdd>

Instance Creation Time

(0008,0013)

<hhmmess.ffffff>

SOP Class UID

(0008,0016)

1.2.840.10008.5.1.4.1.1.66.4

SOP Instance UID

(0008,0018)

Series Date

(0008,0021)

<yyyymmdd>

Acquisition Date

(0008,0022)

from Original (0008,0021), if available
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Attribute Name

Tag

Value

Content Date

(0008,0023)

<yyyymmdd>

Series Time

(0008,0031)

<hhmmess.ffffff>

Acquisition Time

(0008,0032)

from Original (0008,0031), if available

Content Time

(0008,0033)

<hhmmess.ffffff>

Modality

(0008,0060)

SEG

Manufacturer

(0008,0070)

“Siemens”

Institution Name

(0008,0080)

from WS Configuration

Institution Address

(0008,0081)

from WS Configuration

Station Name

(0008,1010)

from WS Configuration

Series Description

(0008,103E)

same as Protocol Name

Performing Physician’s Name

(0008,1050)

not set, unless input via “Correct”

Operators’ name

(0008,1070)

from Original, unless set via “Correct”

Manufacturer's Model Name

(0008,1090)

from WS Configuration

Referenced Series Sequence

(0008,1115)

used, if this instance references instances in
this study.

>Referenced Instance Sequence

(0008,114A)

>Series Instance UID

(0020,000E)

Studies Containing Other Referenced In-

stances Sequence

(0008,1200)

used, if this instance references instances in
other studies.

>Referenced Series Sequence

(0008,1115)

>>Referenced Instance Sequence

(0008,114A)

>>Series Instance UID

(0020,000E)

>Study Instance UID

(0020,000D)

Source Image Sequence

(0008,2112)

Reference to the volume/slice object(s) used
to generate this segmentation result

Derivation Code Sequence

(0008,9215)

refers to “Segmentation”

Device Serial Number

(0018,1000)

from WS Configuration

Software Versions

(0018,1020)

from WS Configuration

Protocol Name

(0018,1030)

Information on Segmentation

Series Instance UID (0020,000E) | <new UID>
Series Number (0020,0011) | from Original
Instance Number (0020,0013)

Patient Orientation (0020,0020) | from Original
Image Comments (0020,4000)

Samples per Pixel (0028,0002) |1

Photometric Interpretation (0028,0004) | MONOCHROME2

Number of Frames

(0028,0008)

Rows

(0028,0010)
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Attribute Name

Tag

Value

Columns

(0028,0011)

Bits Allocated

(0028,0100)

Bits Stored (0028,0101) |1

High Bit (0028,0102) |0

Pixel Representation (0028,0103) |0

Burned In Annotation (0028,0301) | NO

Lossy Image Compression (0028,2110) |00
Representative Frame Number (0028,6010)

Request Attributes Sequence (0040,0275) | from Original

>item contents as provided

from Original

Segmentation Type (0062,0001) | BINARY
Segment Sequence (0062,0002)

>Anatomic Region Sequence (0008,2218)
>Segmented Property Category Code Se- (0062,0003)

quence

>Segment Number (0062,0004)

>Segment Label (0062,0005)

>Segment Description (0062,0005) | (optional)

>Segment Algorithm Type

(0062,0008)

>Segment Algorithm Name

(0062,0009)

One of 'Stroke Segmentation’, * Left Atrium
Segmentation’, ‘Model Based Left Atrium Seg-
mentation’, ‘Hybrid Model Based Left Atrium
Segmentation’, ‘Aortic Root Segmentation’ if
Segment Algorithm Type is not MANUAL.

>Recommended Display Grayscale Value

(0062,0000)

>Recommended Display CIELab Value

(0062,000D)

>Segmented Property Type Code Sequence

(0062,000F)

Private Creator

(0063,00xx)

“SIEMENS SMS-AX Segmentation Extensions”

Attributes according to 9.2 Data Dictionary of Private Attributes

Content Label

(0070,0080)

Content Description

(0070,0081)

Contains identifier to identify a related seg-
mentation mesh result stored in a Surface
Segmentation Object with same identifier

Content Creator's Name

(0070,0084)

<zero length>

Icon Image Sequence (0088,0200) | optional
Shared Functional Groups Sequence (5200,9229)
>Segmentation Identification Sequence (0062,000A) | 1item

>>Referenced Segment Number

(0062,0008)

Per-frame Functional Groups Sequence

(5200,9230)

1 item for each frame

>Derivation Image Sequence

(0008,9124)
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Attribute Name

Tag

Value

>>Source Image Sequence

(0008,2112)

>>>Referenced SOP Class UID

(0008,1150)

>>>Referenced SOP Instance UID

(0008,1155)

>>>Purpose of Reference Code Sequence

(0040,A170)

(121322, DCM, “Source Image for Image Pro-
cessing Operation”)

>>Derivation Code Sequence

(0008,9215)

(113076, DCM, “Segmentation”)

>Frame Content Sequence (0020,9111) |1 item
>>Stack ID (0020,9056)
>>In-Stack Position Number (0020,9057)
>>Dimension Index Values (0020,9157) [ 1\2

Pixel Data

(7FE0,0010)

9.1.6

Surface Segmentation Standard Extended SOP Class

9.1.6.1 General 3D Graphic Result Storage

Table 95: General 3D Graphic Results Storage

Attribute Name

Tag

Value

Attributes according to 9.1.1.1 Supported attributes on Patient level

Attributes according to 9.1.1.2 Supported attributes on Study level

Specific Character Set

(0008,0005)

from WS Configuration

Instance Creation Date

(0008,0012)

<yyyymmdd>

Instance Creation Time

(0008,0013)

<hhmmess. ffffff>

SOP Class UID

(0008,0016)

1.2.840.10008.5.1.4.1.1.66.5

SOP Instance UID

(0008,0018)

Series Date (0008,0021) | <yyyymmdd>
Content Date (0008,0023) | <yyyymmdd>
Series Time (0008,0031) | <hhmmess.ffffff>
Content Time (0008,0033) | <hhmmss>
Modality (0008,0060) | SEG
Manufacturer (0008,0070) | "“Siemens”

Institution Name

(0008,0080)

from WS Configuration

Institution Address

(0008,0081)

from WS Configuration

Station Name

(0008,1010)

from WS Configuration

Series Description

(0008,103E)

same as Protocol Name

Performing Physician’s Name

(0008,1050)

not set, unless input via “Correct”

Operators’ name

(0008,1070)

from Original, unless set via “Correct”

Manufacturer's Model Name

(0008,1090)
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Attribute Name

Tag

Value

Referenced Series Sequence

(0008,1115)

used, if this instance references instances in
this study.

>Referenced Instance Sequence

(0008,114A)

>Series Instance UID

(0020,000E)

Studies Containing Other Referenced In-
stances Sequence

(0008,1200)

used, if this instance references instances in
other studies.

>Referenced Series Sequence

(0008,1115)

>>Referenced Instance Sequence

(0008,114A)

>>Series Instance UID

(0020,000E)

>Study Instance UID

(0020,000D)

Device Serial Number

(0018,1000)

from WS Configuration

Software Versions

(0018,1020)

from WS Configuration

Protocol Name

(0018,1030)

Information on Surface Segmentation

Series Instance UID

(0020,000E)

<new UID>

Series Number

(0020,0011)

950

Instance Number

(0020,0013)

Frame of Reference UID

(0020,0052)

Copied from object to which the Surface Seg-
mentation result applies or new UID.

Note: In case of 2 volumes with 2 different
FoR UIDs stored in same Series the related
SSOs are also stored together in same series
with FoR of the volume the first SSO is related
to.

Laterality

(0020,0060)

n.a. or <zero length>

Position Reference Indicator

(0020,1040)

if applicable, copied from object to which the
Surface Segmentation result applies.

Request Attributes Sequence

(0040,0275)

from Original

>item contents as provided

from Original

Segment Sequence

(0062,0002)

>Anatomic Region Sequence

(0008,2218)

>Segmented Property Category Code Se-
quence

(0062,0003)

One of

(T-D0O050, SRT, “Tissue”),

(T-DOOOA, SRT, “Anatomical Structure”),
(A-00004, SRT, “Physical Object”),
(M-01000, SRT, “Morphologically Altered
Structure”),

(R-42019, SRT, “Function”) or

private coded term.

>Segment Number

(0062,0004)

>Segment Label

(0062,0005)

>Segment Description

(0062,0006)

(optional)

>Segment Algorithm Type

(0062,0008)
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Attribute Name

Tag

Value

>Recommended Display Grayscale Value

(0062,0000)

>Recommended Display CIELab Value

(0062,000D)

>Segmented Property Type Code Sequence

(0062,000F)

>Surface Count

(0066,002A)

number of Surfaces comprising this segment.

>Referenced Surface Sequence

(0066,002B)

>>Referenced Surface Number

(0062,0020C)

>>Segment Surface Generation Algorithm
Identification Sequence

(0062,002D)

>>>Algorithm Family Code Sequence

(0062,002F)

>>>Algorithm Version

(0066,0031)

>>>Algorithm Name

(0066,0036)

>>Segment Surface Generation Algorithm
Identification Sequence

(0066,002D)

>>>Algorithm Family Code Sequence

(0066,002F)

>>>Algorithm Name

(0066,0036)

Identifies workflow/application

>>>Algorithm Version

(0066,0031)

>>Segmented Surface Source Instance Se-
quence

(0066,002E)

reference to volume that was viewed while
generating this surface segment.

>>>Referenced SOP Class UID

(0008,1150)

>>>Referenced SOP Instance UID

(0008,1155)

Number of Surfaces

(0066,0001)

Surface Sequence

(0066,0002)

>Recommended Display Grayscale Value

(0062,0000)

>Recommended Display CIELab Value

(0062,000D)

>Surface Number

(0066,0003)

>Surface Comments

(0066,0004)

>Surface Processing

(0066,0009)

typically set to NO

>Recommended Presentation Opacity

(0066,0000)

0.0 specifies 100% transparency and 1.0 a
100% opaqueness.

>Recommended Presentation Type

(0066,000D)

DICOM defined values:

SURFACE

WIREFRAME

POINTS

Private terms:

CONTOUR (only contour of a wireframe)
NONE

>Finite Volume

(0066,000E)

>Manifold

(0066,0010)

>Surface Points Sequence

(0066,0011)

>>Number of Surface Points

(0066,0015)
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Attribute Name

Tag

Value

>>Point Coordinates Data

(0066,0016)

>Surface Points Normals Sequence

(0066,0012) | <zero length>

>Surface Mesh Primitives Sequence

(0066,0013)

>>Triangle Point Index List

(0066,0023)

>>Edge Point Index List

(0066,0024) | typically not used

>>Vertex Points Index List

(0066,0025)

>>Triangle Strip Sequence

(0066,0026) | typically not used

>>Triangle Fan Sequence

(0066,0027) | typically not used

>>Line Sequence

(0066,0028)

>>>Primitive Point Index List

(0066,0029)

>>Facet Sequence

(0066,0034) | typically not used

>Recommended Point Radius

(0066,0037)

>Recommended Line Thickness

(0066,0038)

Private Creator

(0067,00xx) tensions”

“SIEMENS SMS-AX Surface Segmentation Ex-

Attributes according to 9.2 Data Dictionary of Private Attributes

Content Label

(0070,0080)

Content Description

(0070,0081)

Content Creator's Name

(0070,0084) | <zero length>

9.2  Data Dictionary of Private Attributes

The following Table 96: Private Data Element Dictionary lists all private attributes created by ARTIS one which may be
included in the generated instances.

Table 96: Private Data Element Dictionary

Tag Private Owner Code Name VR VM
(0019,xx00) | SIEMENS SMS-AX IAE Bookmark XML Structure OB 1
(0019,xx02) | SIEMENS AX DYNACT private transformation matrix DS 16
(0019,xx03) | SIEMENS AX DYNACT calibration coordinate system ID us 1-n
(0019,xx10) | SIEMENS AX DYNACT reconstruction joblist ut 1
(0021,xx54) | SIEMENS SMS-AX ACQ 1.0 Rotation Angle SS 1
(0021,xx56) | SIEMENS SMS-AX ACQ 1.0 Table Coordinates SS 3
(0021,xx57) | SIEMENS SMS-AX ACQ 1.0 Iso Center Table Position SS 1
(0021,xx5B) | SIEMENS SMS-AX ACQ 1.0 Table Coordinates System FL 12
(0021,xx81) | SIEMENS SMS-AX ACQ 1.0 Table Tilt SS 1
(0021,xx82) | SIEMENS SMS-AX ACQ 1.0 Table Rotation SS 1
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Tag Private Owner Code Name VR VM
(0021,xx83) | SIEMENS SMS-AX ACQ 1.0 Table Cradle Tilt SS 1
(0029,xx40) | SIEMENS MEDCOM HEADER Application Header Sequence SQ 1
(0029,xx41) | SIEMENS MEDCOM HEADER Application Header Type CS 1
(0029,xx42) | SIEMENS MEDCOM HEADER Application Header ID LO 1
(0029,xx43) | SIEMENS MEDCOM HEADER Application Header Version LO 1
(0029,xx44) | SIEMENS MEDCOM HEADER Application Header Info OB 1
(0063,xx42) SIEMENS SMS-AX Segmentation Object GUID LO 1
Extensions

(0063,xx48) SlEMENS SMS-AX Segmentation Private Segmentation Sequence SQ 1
Extensions

(0067,xx01) | 2IEMENS SMS-AX Surface Seg- | (5 .0+ |aE Display cs 1
mentation Extensions

(0067,xx02) | /EMENS SMS-AX Surface Seg- | vt |ive Display cs 1
mentation Extensions

(0067,xx03) | >/EMENS SMS-AX Surface Seg- | 0 1 | apeling cs 1
mentation Extensions

(0067,xx04) | >/EMENS SMS-AX Surface Seg- | o5 yarsion Number us 1
mentation Extensions

(0067,xx05) | >/EMENS SMS-AX Surface Seg- | o bt Apjated cs 1
mentation Extensions

(0067,xx09) | /EMENS SMS-AX Surface Seg- | ¢\ | angth cs 1
mentation Extensions

(0067,xx10) | >/EMENS SMS-AX Surface Seg- | 5\ ine Shape cs 1
mentation Extensions

(0067,xx11) | JIEMENS SMS-AX Surface Seg- | 5\ i sty le cs 1
mentation Extensions
SIEMENS SMS-AX Surface Seg- .

(0067,xx13) mentation Extensions Clipping s !

(0067,xx14) SIEMENS SMS-AX .Surface seg- Show Volume cs 1
mentation Extensions

(0067,xx27) SIEMENS SMS-AX .Surface Seg- Object Volume Assignment cs 1
mentation Extensions

(0067,xx35) SIEMEN.S SMS-AX .Surface Seg- Group Show s 1
mentation Extensions
SIEMENS SMS-AX Surface Seg- .

(0067,xx36) mentation Extensions Group IAE Display CS 1
SIEMENS SMS-AX Surface Seg- . .

(0067,xx37) mentation Extensions Group Live Display Cs 1

(0067,xx38) SIEMENS SMS-AX .Surface Seg- Group Volume Assignment cs 1
mentation Extensions

(0067,xx39) SlEMEN.S . .Surface seg- Object Version Number us 1
mentation Extensions
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mentation Extensions

Tag Private Owner Code Name VR VM

(0067, xx40) SIEMEN.S SMS-AX .Surface Seg- SSO Owner Lo 1
mentation Extensions

(0067,xx42) | /EMENS SMS-AX Surface Seg- | 0 ¢ guip L0 1
mentation Extensions

(0067,xx43) SIEMEN.S SMS-AX .Surface Seg- Group GUID Lo 1
mentation Extensions

(0067, xx44) SIEMEN.S SMS-AX .Surface Seg- SSO GUID LO 1
mentation Extensions
SIEMENS SMS-AX Surface Seg-

(0067,xx47) mentation Extensions Group Sequence SQ 1

(0067,xx48) SIEMENS SMS-AX .Surface seg- Private Surface Segmentation Sequence SQ 1
mentation Extensions

(0067, xx49) SIEMEN.S SMS-AX .Surface Seg- Group Name Lo 1
mentation Extensions

(0067,xx51) SIEMENS SMS-AX .Surface Seg- Referenced Group GUID LO 1
mentation Extensions

(0067,xx53) SIEMENS SMS-AX .Surface Seg- Private Surface Mesh Sequence SQ 1
mentation Extensions

(0067 xx54) | SIEMENS SMS-AX Surface Seg- | ¢\ ¢ o show cs 1
mentation Extensions

(0067,xx56) SIEMENS SMS-AX .Surface Seg- Surface Mean Diameter List OF 1
mentation Extensions

(0067,xx57) SIEMENS SMS-AX Surface Seg- Primary Angle DS 1
mentation Extensions

(0067,xx58) SIEMENS SMS-AX .Surface Seg- Secondary Angle DS 1
mentation Extensions

(0067,xx59) | S'EMENS SMS-AX Surface Seg- | - iine ID List LT 1
mentation Extensions

(0067,xx60) | 2'EMENS SMS-AX Surface Seg- | a4 1D List LT 1
mentation Extensions

(0067,xx61) SIEMENS SMS-AX Surface Seg- Surface Text Label LO 1
mentation Extensions

(0067,xx62) SIEMENS SMS-AX .Surface Seg- Centerline Visualization Type cs 1
mentation Extensions

(0067,xx64) | SIEMENS SMS-AX Surface Seg- | \iop viaws ut 1
mentation Extensions

(0067,xx65) SIEMENS SMS-AX Surface Seg- Fixed Line Thickness cs 1

Note: The following Private Owner Code contains double-spaces in the name definitions : SIEMENS SMS-AX<spc><spc>ACQ 1.0
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9.3  Standard Extended/Specialized/Private SOP Classes

9.3.1 Standard Extended Segmentation

Any Segmentation SOP Instances created by ARTIS one can be standard extended by adding the following syngo private
module attributes.

Table 97 - Private Modules for other created SOP Class

IE Module Reference | Usage Note

Image | Private Surface Segmentation | 9.3.1.1 u Private Segmentation information

U = User Option
9.3.1.1 Private Segmentation

The table in this section contains private |OD Attributes that describe the Private Segmentation information:

Table 98 - Private Segmentation Attributes

Attribute Name Tag Owner Type Notes
S5O GUID (0063,xx42) SIEMENS SMS-AX Segmentation 3 Global ID fqr the '
Extensions Segmentation object.

9.3.2 Standard Extended Surface Segmentation

Any Surface Segmentation SOP Instances created by ARTIS one can be standard extended by adding the following syngo
private module attributes.

Table 99 - Private Modules for other created SOP Class

IE Module Reference | Usage Note

Private Surface Segmentation infor-
mation

Surface Private Surface Segmentation | 9.3.2.1 u

U = User Option
9.3.2.1 Private Surface Segmentation

The table in this section contains private IOD Attributes that describe the Private Surface Segmentation information:

Table 100 - Private Segmentation Attributes

Attribute

Name Tag Owner Type Notes
S0 Version SIEMENS SMS-AX
Number (0067,xx04) | Surface Segmen- 3 | The version is an increasing number.

tation Extensions

SIEMENS SMS-AX
SSO Owner (0067,xx40) | Surface Segmen- 3 Defines component that created the SSO.
tation Extensions

SIEMENS SMS-AX
SSO GUID (0067,xx44) | Surface Segmen- 3 | Global ID for the SSO.
tation Extensions

SIEMENS SMS-AX Shall contain Group related information.
(0067,xx47) | Surface Segmen- 3

tation Extensions

Group Se-

quence Contains at least 1 item
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Attribute

Name Tag Owner Type Notes
>Recom- Triplet value to define how this Group shall be rendered
mended Display | (0062,000D) | n.a. 3 | ona colordisplay. The units are in PCSValues and the
CIELab Value value encoding is CIELab.
>Recom- Defines the opacity of the Group in percent. Float value
mended Presen- | (0066,000C) | n.a. 3 | between 0.0 ("0% opaqueness”) and 1.0 ("100% opaque-
tation Opacity ness").

Defines if the Group is hidden or not.
SIEMENS SMS-AX
>Group Show (0067,xx35) | Surface Segmen- 3

Defined Terms:

tation Extensions ON
OFF
Defines if the Group is shown on the IAE image area.
SIEMENS SMS-AX Defined Terms:
>Group |AE Dis-
I (0067,xx36) | Surface Segmen- 3 | NONE
play tation Extensions
ON
OFF
Defines if the Group is shown on the Live image area.
) SIEMENS SMS-AX Defined Terms:
>Group Live (0067,xx37) | Surface Segmen- | 3 | NONE
Display . .
tation Extensions
ON
OFF

Defines if the Group is shown on the registered vol-

SIEMENS SMS-AX ume(s).

(0067,xx38) | Surface Segmen- 3 | Defined Terms:
tation Extensions REGISTERED

PLANNING

>Group Volume
Assignment

SIEMENS SMS-AX
>Group GUID (0067,xx43) | Surface Segmen- 3 | Global ID for the Group
tation Extensions

SIEMENS SMS-AX
>Group Name (0067,xx49) | Surface Segmen- 3 | Name of the group.
tation Extensions

Private Surface SIEMENS SMS-AX Sequence which contains private extensions for the Sur-
Segmentation | (0067,xx48) | Surface Segmen- 3 | face Segmentation Module.
Sequence tation Extensions One Item for each item in the Segment Sequence.

Defines the type of the Object.
Defined Terms:
POLYLINE

MARKER

SIEMENS SMS-AX NEEDLE

>Object Type (0067,xx00) | Surface Segmen- 3 | EP ABLATION PT
tation Extensions SEGMENTATION
VESSEL

VESSEL LANDMARK
VERTEBRA CENTER
EMPTY_OBJ
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Attribute
Name

Tag

Owner

Type

Notes

Note: "EMPTY_OBJ" is used in a (dummy) object version
in case all the containing (graphical) objects of this SSO
have been deleted by the user.

>Object IAE Dis-

SIEMENS SMS-AX

Defines if the Object is shown on the IAE image area.

Defined Terms:

tation Extensions

la (0067,xx01) | Surface Segmen- 3 | NONE
play tation Extensions
ON
OFF
Defines if the Object is shown on the Live image area.
Obiect Live SIEMENS SMS-AX Defined Terms:
Dis Jla (0067,xx02) | Surface Segmen- 3 | NONE
play tation Extensions ON
OFF
Defines whether the Object labels are shown.
; - SIEMENS SMS-AX Defined Terms:
;Object Label (0067,xx03) | Surface Segmen- 3
9 tation Extensions ON
OFF
Defines whether the EP Point is ablated or not.
. SIEMENS SMS-AX : .
- Defined Terms:
;EzdPomt Ab (0067,xx05) | Surface Segmen- 3
tation Extensions ABLATED
NOT ABLATED
Defines whether the display of the length value is
SIEMENS SMS-AX shown.
>Show Length | (0067,xx09) | Surface Segmen- 3 | Defined Terms:
tation Extensions ON
OFF
Defines the shape of a polyline.
) SIEMENS SMS-AX Defined Terms:
>Polyline Shape | (0067,xx10) | Surface Segmen- 3
tation Extensions LINEAR
CURVED".
Defines the style of a polyline.
) SIEMENS SMS-AX Defined Terms :
>Polyline Style | (0067,xx11) | Surface Segmen- 3
tation Extensions OPEN
CLOSED
Defines whether clipping affects the Object or not.
L SIEMENS SMS-AX Defined Terms:
>Clipping (0067,xx13) | Surface Segmen- 3
tation Extensions ON
OFF
Defines whether the display of the volume value is
SIEMENS SMS-AX shown.
>Show Volume | (0067,xx14) | Surface Segmen- 3 | Defined Terms:

ON
OFF
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Attribute
Name

Tag

Owner

Type

Notes

>Object Volume

SIEMENS SMS-AX

Defines if the Object is shown on the registered vol-
ume(s).

Defined Terms:

Assignment (0067,xx27) | Surface Segmen- | 3| g icrepep
tation Extensions
PLANNING
NONE
>Object Version SIEMENS SM5-AX
Nuniber (0067,xx39) | Surface Segmen- 3 | The Object version is an increasing number.
tation Extensions
SIEMENS SMS-AX
>Object GUID (0067,xx42) | Surface Segmen- 3 | Global ID for the Object
tation Extensions
>Referenced (0067 xx51) ztEr’;/a{Ec’:SSSMr:eﬁ)-( 3 Value copied from GUID in the Group GUID (0067,xx43)
Group GUID ! . gm attribute in the Group Sequence (0067,0047).
tation Extensions
SIEMENS SMS-AX
>Primary Angle | (0067,xx57) | Surface Segmen- 3 | Primary C-arm angle
tation Extensions
>Secondary An- SIEMENS SMS-AX
e y (0067,xx58) | Surface Segmen- 3 | Secondary C-arm angle
g tation Extensions
Name of the algorithm that was used to generate the
Surface.
Defined Terms:
Stroke Segmentation
Left Atrium Segmentation
SSegment SIEMENS SMS-AX Model Based Left Atrium Segmentation
Algorithm (0062,0009) | Surface Segmen- 3 | Hybrid Model Based Left Atrium Segmentation
Name tation Extensions Aortic Root Segmentation
Coronary Vessel
Aorta Vessel
Vessel Tree Definition
Vessel Tree Detection
Vessel Feeder Detection
>Recom- . . .
mended Display | (0062,000D) | n.a. 3 L’gfgztgr?l:igloogzlf;ncleahow this segment shall be ren-
CIELab Value play-
>Recom- Single unsigned value to define how the maximum pixel
mended Presen- | (0066,000C) | n.a. 3 | value of this segment shall be rendered on a grayscale
tation Opacity display.
>Recom- Specifies the radius of the vertex points defined in the
mended Point (0066,0037) | n.a. 3 | Vertex Point Index List (0066,0025) with which it is rec-
Radius ommended that the point be rendered.
~Recom- Specifies the thickness of each edge or line defined in
. the Edge Point Index List (0066,0024) or Line Sequence
?’?ﬁ?l?r?:sls_me (0066,0038) | n.a. 3 (0066,0028) with which it is recommended that the line
be rendered.
ri surf SIEMENS SMS-AX Sequence which contains private extensions for the Sur-
rivate Surface (0067,xx53) | Surface Segmen- 3 |face

Mesh Sequence

tation Extensions

Mesh Module.

© Siemens Healthcare GmbH. 2022. All rights reserved.

DICOM Conformance Statement ARTIS one VA11

148 of 154




Attribute
Name

Tag

Owner

Type

Notes

One Item for each item in the Surface Sequence.

SIEMENS SMS-AX

Defines if the Surface is shown or not.

Defined Terms:

>Surface Show | (0067,xx54) | Surface Segmen- 3 | NONE
tation Extensions
ON
OFF
>Surface Mean SIEMENS SMS-AX
N . (0067,xx56) | Surface Segmen- 3 List of mean diameters in mm.
Diameter List . .
tation Extensions
>Centerline ID SIEMENS SM5-AX
List (0067,xx59) | Surface Segmen- 3 | Vessel object : 2 values (CenterlineSeglID\ParentID)
tation Extensions
>Landmark ID SIEMENS SMS-AX Vessel Landmarks object: 2 values (LandmarkID\Ves-
. (0067,xx60) | Surface Segmen- 3
List . . selSegmentID)
tation Extensions
SSurface Text SIEMENS SMS-AX
(0067,xx61) | Surface Segmen- 3 | Text label
Label . .
tation Extensions
Defines how a Centerline is visualized.
Defined Terms:
>Centerline SIEMENS SMS-AX NONE
Visualization (0067,xx62) | Surface Segmen- 3
Type tation Extensions NORMAL
COLOR CODED
RULER
SIEMENS SMS-AX
>MPR Views (0067,xx64) | Surface Segmen- 3 | XML structure
tation Extensions
Defines a fixed line thickness.
SIEMENS SMS-AX Defined Terms:
>Fixed Line
. (0067,xx65) | Surface Segmen- 3 | SMALL
Thickness ion E .
tation Extensions MEDIUM
LARGE
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